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● Basic Features
● Maintenance
● Machine Settings
● Specifications

Basic Guide

● Advanced Features
● System Monitor
● Reports and Lists Advanced Guide

● Printing Features
● Scanning Features
● PC Faxing Features

Software Guide
(This Document)

 Indicates the manual is supplied in PDF format in the accompanying CD-ROM.

● To view the manuals in PDF format, Adobe Reader/Adobe Acrobat Reader is required. If Adobe Reader/ 
Adobe Acrobat Reader is not installed on your system, please download it from the Adobe Systems 
Incorporated website.

● Considerable effort has been made to make sure that the manuals for the machine are free of 
inaccuracies and omissions. However, as we are constantly improving our products, if you need an exact 
specification, please contact Canon.

● The machine illustration on the cover may differ slightly from your machine.
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Returns to the last page opened.

Returns to the top page.

Displays the “How to Use This Guide” page.

Quick links to the list of things you can do, topics 
for each chapter, table of contents, and the index.
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Displays the previous or next page.
Returns to the top page.

Table of contents for the chapter.

Quick links to the list of things you can do, topics 
for each chapter, table of contents, and the index.
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e LCD:

ckets: [Preferences].
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The following symbols are used throughout the manuals for the machine and indi
keep in mind when using the machine.

WARNING

Indicates a warning that may lead to death or serious injury if not observed.

CAUTION

Explains how to avoid actions that could injure you or damage your machine.

NOTE

Explains operating restrictions and how to avoid minor difficulties.

In addition, this guide uses a distinctive notation to identify buttons and information in th

– Menu items you select and the buttons you press on the screen appear in square bra
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rks of their respective owners.

produced, transmitted, transcribed, stored in a retrieval 
ns, electronic, mechanical, magnetic, optical, chemical, 

RIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS 
S TO MARKETABILITY, MERCHANTABILITY, 
 ANY PATENT. CANON INC. SHALL NOT BE LIABLE 
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Legal Notices

Trademarks
Canon and the Canon logo are trademarks of Canon Inc.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
All other product and brand names are registered trademarks, trademarks or service ma

Copyright
Copyright © 2006 by Canon Inc. All rights reserved. No part of this publication may be re
system, or translated into any language or computer language in any form or by any mea
manual, or otherwise, without the prior written permission of Canon Inc.

Disclaimer
The information in this document is subject to change without notice.
CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATE
PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES A
FITNESS FOR A PARTICULAR PURPOSE OF USE OR AGAINST INFRINGEMENT OF
FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY NATURE
THE USE OF THIS MATERIAL.
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xt Sensitive Help

 displays the explanation of each item in the current 
x. Use one of the following procedures to activate a 
ensitive help.

 (Help) in the title bar of the dialog box → click the 
 item.

lick the desired item → select [What’s this?].

 the desired item → press [F1].
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Where to Find Help
When you encounter a problem during installation of the 
driver software or while operating your machine, consult 
the following:

In This Manual

See Chapter 5, “Troubleshooting.”

In the Basic Guide

See Chapter 11, “Troubleshooting,” in the Basic Guide.

README. TXT File

The hints, limitations, and restrictions you need to be aware of 
when installing and using the drivers are included in the 
README.TXT file provided with the drivers. 

Online Help

You can locate additional help in the online help file provided 
with the driver software. In the [Properties] dialog box, you can 
click [Help] to display information about every feature and option 
in the drivers.

Conte

This Help
dialog bo
context s

– Click 
desired

– Right c

– Select
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ft Windows XP
el® Pentium® 300 MHz or higher (USB 1.1),
ntium® II/Celeron® 300 MHz or higher (USB 2.0)
 64 MB of RAM, 128 MB or more is recommended 
), 128 MB of RAM (USB 2.0)
 Hard Disk Space: 1.5 GB or more is recommended

B 2.0 Hi Speed connection requires a PC equipped with a 
ter than 300 MHz and more than 64 MB of RAM and with 
s XP SP1 or later installed, or with a CPU faster than 
z and more than 64 MB of RAM and with Windows 2000 SP4 
. If your PC meets all of these requirements and is 
lled with USB 2.0 Host Controller, the USB 2.0 connection 
uaranteed.
canning a document, the necessary memory size may differ 
ing on the scanning size and the memory usage of the 
ion.
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System Requirements
General

– IBM or IBM-compatible PC

– CD-ROM drive or network environment with the access to 
CD-ROM

– PC equipped with a USB port and the USB class driver 
installed

Microsoft Windows 98, 98SE
CPU: Intel® Pentium® 90 MHz or higher
Memory: 64 MB of RAM, 128 MB or more is recommended
Available Hard Disk Space: 330 MB or more is recommended

Microsoft Windows Me
CPU: Intel® Pentium® 150 MHz or higher
Memory: 64 MB of RAM, 128 MB or more is recommended
Available Hard Disk Space: 295 MB or more is recommended

Microsoft Windows 2000 Professional
CPU: Intel® Pentium® 133 MHz or higher (USB 1.1),
Intel® Pentium® II or higher (USB 2.0)
Memory: 64 MB of RAM, 128 MB or more is recommended 
(USB 1.1), 128 MB of RAM (USB 2.0)
Available Hard Disk Space: 650 MB or more is recommended

Microso
CPU: Int
Intel® Pe
Memory:
(USB 1.1
Available

NOTE
 

– The US
CPU fas
Window
133 MH
installed
preinsta
will be g

– When s
depend
applicat
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en the [Scanners and Cameras] folder 
indows 98/2000: the [Scanners and 
meras Properties] dialog box).
k [start] on the Windows task bar → select [Control Panel] → 
nters and Other Hardware] → [Scanners and Cameras] 
ndows 98/Me/2000: [Start] → [Settings] → [Control Panel] → 
ble-click [Scanners and Cameras]).
e sure the corresponding scanner driver icon is displayed.

ke sure that the corresponding scanner 
ver is displayed.

he [Canon MF Toolbox 4.9] icon is 
played on the Windows desktop, 
tallation of the MF Toolbox 4.9 has been 

ccessful.
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Checking Installation
Check if the drivers are installed successfully and the 
machine is selected as the default printer.

NOTE

If your machine is selected in the printer box when you open the [Print] 
dialog box in an application, which means your machine is set as the 
default printer.

1. Open the [Printers and Faxes] (Windows 98/
Me/2000: [Printers]) folder.
Click [start] on the Windows task bar → select [Printers and 
Faxes] (Windows 98/Me/2000: [Start] → [Settings] → [Printers]).
Make sure the driver icon is displayed.

2. Select the default printer.
Click the corresponding printer driver icon.
From the [File] menu, click [Set as Default Printer] (Windows 98/
Me: [Set as Default]).

3. Op
(W
Ca
Clic
[Pri
(Wi
dou
Mak

4. Ma
dri

5. If t
dis
ins
su
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e Software
oving the MF Drivers

ck [start] on the Windows task bar → [(All) 
grams] → [Canon] → [MF3200 Series] → 
install Drivers].

 [MF Drivers Uninstaller] dialog box appears.

ck [Delete].

ndows 98/Me/2000: Click [OK], and then go to step 4.)

ck [Yes].

nstallation proceeds automatically and next dialog box 
ears.
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Uninstalling and Reinstalling th
If you want to reinstall the software, you must remove the 
currently installed software. Before you remove the driver, 
make sure the following:

● You have the installation software available for 
installation.

● No application is running on your computer.

NOTE

– To uninstall the software in Windows 2000/XP, you must be the user 
with administrative privileges.

– When removing the software, first remove the MF Toolbox, and then 
the MF drivers.

■ Removing the MF Toolbox

1. Click [start] on the Windows task bar → [(All) 
Programs] → [Canon] → [MF Toolbox 4.9] → 
[Toolbox Uninstall].

2. Follow the on-screen instructions. 
When the Repair or Remove program selection screen is 
displayed, check [Remove] → click [Next >].
If asked to confirm removal of an application etc., click [OK].
Restart your computer if asked to do so.

3. Click [Exit].

■ Rem

1. Cli
Pro
[Un
The

2. Cli

(Wi

3. Cli

Uni
app
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nstalling the Software
the Windows desktop, click [start] → [My Computer] 
ndows 98/Me/2000: double-click [My Computer]). Open the 
ROM icon → double-click [MInst] ([MInst.exe]). The MF 

up screen appears. For instructions on reinstalling the 
ware, see “Installing Software,” in the Starter Guide.

u install the software using a copy on network or hard disk, 
n the MF Setup screen by double-clicking the [MInst] 
nst.exe]) icon.
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4. Click [Exit].

NOTE

Restart your computer if asked to do so.

■ Rei
On 
(Wi
CD-
Set
soft

If yo
ope
([MI
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................................................. 2-2

................................................. 2-2

................................................. 2-3

plication .................................. 2-3

nd Faxes] 
00: [Printers]) Folder ............... 2-4

................................................. 2-5
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 as a Shared Printer.............. 2-52
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2 Printing

Printing a Document ..............................

Canceling Printing .

Changing Print Settings.........................

From a Windows Ap

From the [Printers a
(Windows 98/Me/20

Windows 98/Me Properties ....................

Windows 2000/XP Properties and Printin

Properties ..............

Printing Preferences

Using the Machine on Your Network ......

Setting the Machine

Using the Shared P
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celing Printing

en the [Printers and Faxes] (Windows 98/
/2000: [Printers]) folder.
k [start] on the Windows task bar → select [Printers and 
es] (Windows 98/Me/2000: [Start] → [Settings] → 
nters]).

uble-click the corresponding printer driver 
n.

ht click the print job → click [Cancel] or 
ncel Printing] → [Yes].

NOTE

or Windows 98/Me/2000, the job will be canceled when you 
ick [Cancel] or [Cancel Printing].
u can also cancel a print job using [System Monitor] on the 

peration panel of the machine. For details, see Chapter 3, 
ystem Monitor,” in the Advanced Guide.
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Printing a Document

1. Open the document in an application.

2. Select the command to print.
In most cases, click [Print] from the [File] menu.
The [Print] dialog box appears.

3. From the [Select Printer] list box or the 
[Name] drop-down list in the [Print] dialog 
box, select the printer to be used.

4. Click [Preferences] or [Properties].

NOTE

Depending on the application you are using, select the printer to 
be used in the [General] tab sheet in the [Print] dialog box, then 
specify the print settings in the corresponding tab sheet. (Only for 
Windows 2000.)

5. Specify the required settings → click [OK].

NOTE

For details, see “Changing Print Settings,” on p. 2-3.

6. Click [Print] or [OK].
Printing starts.

NOTE

To cancel printing, click [Cancel].

■ Can

1. Op
Me
Clic
Fax
[Pri

2. Do
ico

3. Rig
[Ca

– F
cl

– Yo
o
“S
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m a Windows Application

ng the Printing Preferences or Properties 
 Box

lect the command to print.
ost cases, click [Print] from the [File] menu.
 [Print] dialog box appears.

m the [Select Printer] list box or the 
me] drop-down list in the [Print] dialog 

x, select the printer to be used.

ck [Preferences] or [Properties].
 [Printing Preferences] or [Canon MF3200 Series Properties] 
og box appears.

NOTE

ending on the application you are using, select the printer to 
sed in the [General] tab sheet in the [Print] dialog box, then 

cify the print settings in the corresponding tab sheet. (Only for 
dows 2000.)
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Changing Print Settings
To view or change the print settings, access the properties 
or printing preferences dialog box of the printer driver.
You can access the properties dialog box either from the 
application’s [Print] dialog box or the [Printers and Faxes] 
(Windows 98/Me/2000: [Printers]) folder, and the printing 
preferences dialog box from the [Printers and Faxes] 
(Windows 2000: [Printers]) folder.
To access the dialog box, follow this procedure.

NOTE

– The properties dialog box enables you to set up the printer 
configuration and configure the print settings for all Windows 
applications. The printing preferences dialog box enables you to 
specify the default settings for the printing options available when you 
print with the machine. (Only for Windows 2000/XP.)

– The number of tabs displayed in the properties dialog box will vary, 
depending on the type of operating system you are using and the 
method you use to access the dialog box.

– The method you use to access the dialog boxes determines how long 
the printing options remain in effect:
If you access the dialog box from an application’s [Print] dialog box, 
your selected printing options apply only to the current print job. They 
will not be stored when you close the application.
If you access the dialog box from the [Printers and Faxes] (Windows 
98/Me/2000: [Printers]) folder, selected printing options apply to all 
Windows applications and remain in effect until you change those 
settings.

■ Fro

Openi
Dialog

1. Se
In m
The

2. Fro
[Na
bo

3. Cli
The
dial

Dep
be u
spe
Win
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ng the Printing Preferences Dialog Box 
ows 2000/XP)

en the [Printers and Faxes] (Windows 
0: [Printers]) folder.

k [start] on the Windows task bar → select [Printers and 
es] (Windows 2000: [Start] → [Settings] → [Printers]).

ck the corresponding printer driver icon.

m the [File] menu, click [Printing 
ferences].

 can also open the printing preferences dialog box by right 
ing the corresponding printer driver icon and selecting 

nting Preferences] from the pop-up menu.
 [Canon MF3200 Series Printing Preferences] dialog box 
ears.
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■ From the [Printers and Faxes]
(Windows 98/Me/2000: [Printers]) Folder

Opening the Properties Dialog Box

1. Open the [Printers and Faxes] (Windows 98/
Me/2000: [Printers]) folder.
Click [start] on the Windows task bar → select [Printers and 
Faxes] (Windows 98/Me/2000: [Start] → [Settings] → [Printers]).

2. Click the corresponding printer driver icon.

3. From the [File] menu, click [Properties].
You can also open the properties dialog box by right clicking the 
corresponding printer driver icon and selecting [Properties] from 
the pop-up menu.
The [Canon MF3200 Series Properties] dialog box appears.

Openi
(Wind

1. Op
200
Clic
Fax

2. Cli

3. Fro
Pre
You
click
[Pri
The
app
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s Tab

 the printer port and timeout settings. Refer to your 
 operating system documentation for more information.
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Windows 98/Me Properties

NOTE

– The screens shown below are displayed when you open [Canon 
MF3200 Series Properties] from the [Printers] folder.

– The number of tabs displayed in the properties dialog box depends 
on how you have your system set up.

General Tab

Lets you print a test page or define separator pages. Refer to 
your Windows operating system documentation for more 
information.

Detail

Specifies
Windows
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Management Tab

e color profiles with your color printer. Refer to your 
 operating system documentation for more information.
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Spool Settings

The installer sets the following defaults.

Color 

Associat
Windows
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etup Tab

 the page settings including the paper size, scaling, 
f copies, orientation, number of pages per sheet, etc.
ation on [Profile] and [Output Method], see “Profiles,” 

0.
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Sharing Tab

Specifies the printer sharing settings. This tab sheet is available 
only when the printer sharing is enabled. (See “Using the 
Machine on Your Network,” on p. 2-52.) Refer to your Windows 
operating system documentation for more information.

Page S

Specifies
number o
For inform
on p. 2-2
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 Specifies the number of copies to be printed 
(1 to 99).

ion] Selects the direction of printing relative to 
the paper ([Portrait] or [Landscape]).

yout] Selects the number (1, 2, 4, 6, 8, 9, or 16) of 
original pages per sheet or [Poster] (2 x 2, 3 
x 3, or 4 x 4 pages to comprise one sheet). 
When this option is set to anything other 
than [1 Page per Sheet] and [Poster], the 
original page size is reduced to fit the 
selected page layout when printed.

NOTE

hen [1 Page per Sheet] is selected, [Manual Scaling] 
pears. When this option is set to anything other than [1 Page 
r Sheet] or [Poster], [Page Order] appears instead of [Manual 

caling] in its place.
hen [Poster] is selected, [Manual Scaling], [Watermark] and 
age Options] are disabled.

Scaling] Reduces or enlarges the original page size. 
Selecting this check box enables the edit box 
on the right side to specify the magnification 
factor (25 to 200%).

NOTE

u select enlarge/reduce ratio on the [Print] screen of an 
lication software, select 100% in [Manual Scaling].
1
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[Page Size] Selects the original page size to work with in 
an application. Available options are; 
[Letter], [11 x 17], [Legal], [Executive], [A5], 
[B5], [A4], [B4], [A3], [Envelope Monarch], 
[Envelope COM10], [Envelope DL], 
[Envelope C5] and [Custom [Name Fixed]]. 
However, when [11 x 17], [B4], or [A3] is 
selected in the [Page size], the original page 
size is reduced to fit [A4] automatically.

[Output Size] Selects the output paper size to print on. 
When this option is set to anything other 
than [Match Page Size], the original page 
size is automatically reduced or enlarged to 
fit the selected output paper size when 
printed.

NOTE

Up to 50 sizes can be defined for [Custom Paper Size] with the 
[Custom Paper Size Settings] option. (See “Custom Paper Size 
Settings,” on p. 2-12.)

[Copies]

[Orientat

[Page La

– W
ap
pe
S

– W
[P

[Manual 

If yo
app
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ark] Inserts the selected watermark to be printed 
on each page. Eight types of pre-defined 
watermark are available:
– CONFIDENTIAL
– COPY
– DRAFT
– FILE COPY
– FINAL
– PRELIMINARY
– PROOF
– TOP SECRET
Selecting this check box enables [Edit 
Watermark] to add a watermark.

NOTE

 option is disabled when [Page Layout] is set to [Poster].

termark] Opens the [Edit Watermark] dialog box. (See 
“Edit Watermark,” on p. 2-10.)

 Paper Opens the [Custom Paper Size Settings] 
dialog box. (See “Custom Paper Size 
Settings,” on p. 2-12.)

tions] Opens the [Page Options] dialog box. (See 
“Page Options,” on p. 2-13.)

NOTE

 option is disabled when [Page Layout] is set to [Poster].
1
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[Page Order] Selects the order in which original pages are 
placed on each sheet of the output paper 
when more than one page is printed per 
sheet.

[Paper Type] Selects the paper type to print. Available 
paper types are as follows:
– Plain Paper (64 to 90 g/m2)
– Plain Paper L (64 to 90 g/m2)
– Heavy Paper (105 to 128 g/m2)
– Heavy Paper H (105 to 128 g/m2)
– Transparency

NOTE

– If paper curls excessively when printed with [Plain Paper] 
selected, select [Plain Paper L].

– If print fixing is not sufficient when printed with [Heavy Paper] 
selected, select [Heavy Paper H].

– When you select [Envelope Monarch], [Envelope COM10], 
[Envelope DL], or [Envelope C5] as [Page Size], and [Match 
Page Size] as [Output Size], [Paper Type] is automatically set to 
[Envelope].
If you select [Envelope Monarch], [Envelope COM10], 
[Envelope DL], or [Envelope C5] as [Output Size], [Paper Type] 
is automatically set to [Envelope] regardless of the setting of 
[Page Size].

[Waterm

This

[Edit Wa

[Custom
Size]

[Page Op

This
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atermark

[Edit Watermark] in the [Page Setup] tab sheet opens 
Watermark] dialog box. This dialog box enables you to 
ext string as a watermark onto pages. This option is 
only when the [Watermark] check box is selected in the 
tup] tab sheet. (See “Page Setup Tab,” on p. 2-7.)

ark List] Displays the names of registered 
watermarks. The preview image in the upper 
left part of the dialog box displays the 
selected watermark with the specified 
settings reflected.
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Edit W

Clicking 
the [Edit 
insert a t
enabled 
[Page Se

[Restore Defaults] Resets all the current settings to their default 
values.

[View Settings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-23.)

[Waterm
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Displays and allows you to change the name 
of the currently selected watermark.

Displays and allows you to change the text 
string of the currently selected watermark.

Selects the font type of the watermark. 

Selects the font style of the watermark. 
Available styles are [Regular], [Italic], [Bold] 
and [Bold Italic].

Specifies the font size of the watermark (1 to 
500).

Selects the font color of the watermark. 

Adds the frame to the watermark. You can 
select the frame type ([Circle], [Rectangle], 
or [None]).

le] Selects the type of watermark ([Transparent] 
or [Overlap]).

 First 
ly]

Prints the selected watermark only on the 
first page of the document.

NOTE

 cannot edit pre-defined watermarks. 
1
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[Add] Registers a new watermark. Clicking this 
button adds a blank name field in 
[Watermark List] in which you enter the 
name of watermark to be registered. Up to 
50 watermarks can be registered.

[Delete] Removes the selected watermark from 
[Watermark List].

NOTE

You cannot delete a pre-defined watermark or a watermark 
currently selected in the [Page Setup] tab.

[Position] Specifies the position where the watermark 
is printed on each page. You can enter the 
values in the [X] and [Y] edit boxes (in a 
range from –50 to 50), or use the X and Y 
slide bars to move the position.

[Move to Center] Relocates the watermark to the center of the 
page.

[Angle] Specifies the angle of watermark ([Upward 
Left to Right], [Downward Left to Right], or 
[Set Angle]). You can select the 
corresponding radio button, or use the slide 
bar to move the angle. 

[Name]

[Text]

[Font]

[Style]

[Size]

[Color]

[Border]

[Print Sty

[Print on
Page On

You
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ist] Displays the paper sizes actually available. 
Selects a paper size from which you can 
create a custom paper size.

NOTE

 can share the custom paper sizes with all printers connected 
our computer. Up to 50 sizes can be defined for [Custom 
er Size].

f Custom 
ze]

Specifies the name of custom paper.

Selects the unit of measurement of paper 
size ([Millimeter] or [Inch]).

ize] Specifies the width and height of the custom 
paper.

NOTE

ure that [Width] does not exceed [Height] when specifying 
values.

r] Registers the custom paper size and adds 
its name to [Paper List].

Removes the selected custom paper size 
from [Paper List].

NOTE

 cannot delete a pre-defined paper size or a paper size 
ently selected in the [Page Setup] tab.
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Custom Paper Size Settings

Clicking [Custom Paper Size] in the [Page Setup] tab sheet 
opens the [Custom Paper Size Settings] dialog box. This dialog 
box enables you to define custom paper sizes for quick selection 
and register new custom paper sizes to the [Paper List]. You can 
specify the name, width, and height of each size. Up to 50 
custom paper sizes can be defined.

NOTE

This setting is not available when the [Canon MF3200 Series 
Properties] dialog box is opened from a Windows application.

[Paper L

You
to y
Pap

[Name o
Paper Si

[Unit]

[Paper S
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[Delete]
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te] Selects if the date is printed on each page or 
not. Six positions to print the date are 
available.

er Name] Selects if the user name is printed on each 
page or not. Six positions to print the user 
name are available.

e Number] Selects if the page number is printed on 
each page or not. Six positions to print the 
page number are available.

Settings] Click this button to display the [Format 
Settings] dialog box. This dialog box allows 
you to set the default font type, style, size, 
and color, or reset to the factory default font 
settings.

 Defaults] Resets all the current settings to their default 
values.
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Page Options

Clicking [Page Options] in the [Page Setup] tab sheet opens the 
[Page Options] dialog box. This dialog box enables you to print 
pages with a page frame, header, and footer. This option is 
disabled when [Page Layout] in the [Page Setup] tab sheet is set 
to [Poster]. (See “Page Setup Tab,” on p. 2-7.)

[Edging] Adds a page frame to be printed on each 
page. 11 options are available.

[Print Da

[Print Us

[Print Pag

[Format 

[Restore
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Click this button to set the gutter width for 
binding a printed document. (See “Gutter 
Settings,” on p. 2-15.)

g] Selects the Collate option to print a 
document in correct binding order. For 
example, when printing multiple copies of a 
3-page document, the print order is 1, 2, 3, 
1, 2, 3, and so on. ([Off] or [Collate]).

NOTE

u select [Collate] in [Finishing], the image on the left bottom 
e preview image will change.

d Click this button to display [Advanced 
Settings] dialog box for specifying the 
finishing details. (See “Advanced Settings,” 
on p. 2-15.)

 Defaults] Resets all the current settings to their default 
values.

ttings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-23.)
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Finishing Tab

Specifies the finishing settings for the printed pages including 
the collating and binding.
For information on [Profile] and [Output Method], see “Profiles,” 
on p. 2-20.

[Binding Location] Selects a binding location for the printed 
pages.

[Gutter]

[Finishin

If yo
of th

[Advance
Settings]

[Restore

[View Se
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y Tab

 the settings for print quality including the resolution 
rast.
 information on [Profile] and [Output Method], see 
” on p. 2-20.

e] Selects the best setting for the print job 
according to document content.
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Gutter Settings

Clicking [Gutter] in the [Finishing] tab sheet opens the [Gutter 
Settings] dialog box.

Advanced Settings

Clicking [Advanced Settings] in the [Finishing] tab sheet opens 
the [Advanced Settings] dialog box.

Qualit

Specifies
and cont
For more
“Profiles,

[Gutter] Specifies the gutter width in a range from 0 
to 30 mm.

[Image 
Refinement]

Sets the Super Smoothing function of the 
printer.

NOTE

If the [Resolution] in the [Detailed Settings] dialog box is set to 
[300 dpi], a document is always printed with Super Smooting 
function. 

[Restore Defaults] Resets all the current settings to their default 
values.

[Objectiv
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ed Settings

[Details] in the [Quality] tab sheet opens the [Detailed 
 dialog box. This dialog box enables you to specify the 
settings for print quality.

ion] Selects the printer’s resolution in dot per 
inch (600 dpi or 300 dpi).
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Detail

Clicking 
Settings]
detailed 

[Details] Click this button to open the [Detailed 
Settings] dialog box and make print quality 
settings. (See “Detailed Settings,” on 
p. 2-16.)

[Manual Grayscale 
Settings]

Enables the manual grayscale. Selecting this 
check box enables [Grayscale Settings] to 
access the dialog box which enables you to 
set the grayscale for images. (See 
“Grayscale Settings,” on p. 2-17.) 

[Grayscale 
Settings]

Click this button after selecting the [Manual 
Grayscale Settings] check box to manually 
adjust the grayscale settings. The 
[Grayscale Settings] dialog box allows you to 
specify Brightness, Contrast, and Matching 
Mode. (See “Grayscale Settings,” on 
p. 2-17.)

NOTE

This option is enabled only when [Manual Grayscale Settings] is 
selected.

[View Settings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-23.)

[About] Displays the version information on the 
driver. 

[Restore Defaults] Resets all the current settings to their default 
values.

[Resolut
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cale Settings

Grayscale Settings] in the [Quality] tab sheet opens the 
le Settings] dialog box. This dialog box enables you to 
e brightness and contrast of images. This function is 

only when [Manual Grayscale Setting] is selected in the 
tab sheet. (See “Quality Tab,” on p. 2-15.) Two tab 
re provided in this dialog box.
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Grays

Clicking [
[Graysca
control th
enabled 
[Quality] 
sheets a

[B & W Halftones] Specifies the use of dithering for printing 
halftone data.

Pattern1:
Applies dither pattern of high-quality 
gradient for printing graphics and graphs 
with gradation.

Pattern2:
Applies dither pattern of high-quality tone 
with sharpness  and stability for printing 
image data such as pictures.

Pattern3:
Applies dither pattern of sensitive and clear-
cut for printing documents including with 
lines and figures.

None [Solid]:
Prints all colors in black except for white.

[Enable Image 
Correction]

Select [Enable Image Correction] to smooth 
out the streaking and coarse features that 
tend to occur when printing enlarged image 
files and photographs using a software 
application.

[Toner Save] Modifies print data to print lighter and 
conserve toner.

Printer Default:
Prints using the settings in the operation 
panel of the printer.
Off:
Prints using normal density.
On:
Prints text lighter in printouts for 
proofreading and choking.
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ing Tab

g Mode] You can specify the procedure for Color 
correction.

Driver Matching Mode:
Processes color in the printer driver. The 
settings specified in [Matching Method] and 
[Monitor Profile] will be enabled.
Gamma Adjustment:
Performs gamma adjustment with the 
gamma correction value specified in the 
[Gamma] box.
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Grayscale Adjustment Tab Match

[Preview] Displays the image with the currently 
selected brightness and contrast reflected.

[Original] Displays the original image.

[Brightness] Adjusts the brightness of the preview image 
in the range from –5 to 5.

[Contrast] Adjusts the contrast of the preview image in 
the range from –5 to 5.

[Restore Defaults] Resets all the current settings to their default 
values.

[Matchin
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] Specifies the gamma correction value when 
the [Gamma Adjustment] is selected in the 
[Matching Mode] box.
The brightness of the document printout can 
be adjusted without losing the brightest and 
darkest portion of the document.
This option is useful when the printout result 
is brighter than the original image (for 
example, a photograph before scanning or 
graphics displayed on the monitor), or when 
you want to intentionally change the 
brightness of the output.
Four gamma correction values are provided. 
The larger the value, the darker the printout 
is.
1.0
1.4
1.8
2.2 

NOTE

 option can be selected only when [Gamma Adjustment] is 
cted for [Matching Mode].

 Defaults] Resets all the current settings to their default 
values.
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[Matching Method] Specifies the matching method by assigning 
highest priority when the [Driver Matching 
Mode] is selected in the [Matching Mode] 
box.

Perceptual [Monitor Color Matched]:
Gives priority to matching the hue of the 
color on the monitor with the color of the 
printed output.
Colorimetric:
Gives priority to reducing the color difference 
between the original document on the 
screen (a logo, for example) and the printed 
output.
Saturation:
Gives priority to vividness in matching.

NOTE

This option can be selected only when [Driver Matching Mode] is 
selected for [Matching Mode].

[Monitor Profile] Specifies the setting suitable for your 
monitor when the [Driver Matching Mode] is 
selected in the [Matching Mode] box.

NOTE

– This option can be selected only when [Driver Matching Mode] 
is selected for [Matching Mode].

– In the case where several gamma values are provided for one 
option, select the higher gamma value to obtain better results if 
the printed image is lighter than that of the monitor.

– If the monitor is set to a custom setting, it is difficult to produce 
printed output similar to the color of the monitor when 
performing matching.

[Gamma

This
sele

[Restore
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Stores various printer driver settings, each 
suitable for certain print jobs, as user-
defined Profiles. Selecting Profiles from the 
drop-down list enables the printer to perform 
a variety of print jobs. A frequently 
performed print job can also be saved as a 
Profile.

image Displays the image with the currently 
selected settings reflected.
Changes the setting for [Page Layout] every 
time you click anywhere inside the image of 
the page. The setting changes in the 
following order; [1 Page per Sheet] → 
[2 Pages per Sheet] → [4 Pages per Sheet] 
→ [1 Page per Sheet].
Right clicking the mouse button on the 
preview image displays the pop-up menu, 
from which you can also change the setting 
for [Page Layout].
Clicking the edges of the preview image of 
the page changes the binding location.

NOTE

ings made on the [Quality] tab are not reflected in the preview 
ge.
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Profiles

A registered combination of settings for the [Page Setup], 
[Finishing] and [Quality] tab sheets is referred to as a profile. 
The profile function commonly provided in each of these tab 
sheets enables you to add, edit, and select a profile, which 
facilitates your print jobs.

[Profile]

Preview 

Sett
ima
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rofile

 (Add Profile) opens the [Add Profile] dialog box. 
g box enables you to register a new profile with the 

ettings. You can add up to 50 new profiles.

Specifies the name of the profile to be 
registered.

Selects an icon to represent the profile to be 
registered.

nt] Adds comments on the profile to be 
registered.

ttings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-23.)
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Add P

Clicking 
This dialo
current s

[Output Method] Switches the job mode between [Print] and 
[Edit and Preview].

Print:
Executes a normal print job. 

Edit and Preview:
Saves the data in the [Canon 
PageComposer] dialog box. If you open 
[Canon MF3200 Series Properties] from the 
[Printers] folder and select the [Edit and 
Preview] mode,  (Lock) button appears on 
the right side. When you click this button, the 
[Edit and Preview] mode is locked.

 (Add Profile) Click this button to display the [Add Profile] 
dialog box to add a new Profile to the list. 
(See “Add Profile,” on p. 2-21.)

 (Edit Profile) Click this button to display the [Edit Profile] 
dialog box to edit the name, icon, or 
comment of a stored Profile. (See “Edit 
Profile,” on p. 2-22.)

[View Settings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-23.)

[Name]

[Icon] 

[Comme

[View Se
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e Up) Moves the profile selected in the [Profile List] 
one position up.

e Down) Moves the profile selected in the [Profile List] 
one position down.

Removes the selected profile from [Profile 
List].

NOTE

 cannot delete the pre-defined profiles and the profile that is 
ently selected in [Profile].

Displays and allows you to change the name 
of the currently selected profile.

NOTE

 cannot change the names for the pre-defined profiles.

Displays and allows you to change the icon 
representing the currently selected profile.

NOTE

 cannot change the icons for the pre-defined profiles.
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Edit Profile

Clicking  (Edit Profile) opens the [Edit Profile] dialog box. 
This dialog box enables you to edit the profile selected in [Profile 
List].

[Profile List] Executes a normal print job. 

[View Settings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-23.)

 (Mov

 (Mov

[Delete] 

You
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[Name]
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ettings

[View Settings] opens the [View Settings] dialog box. 
g box displays the current settings in the [Page Setup], 
], and [Quality] tab sheets.

Copies the contents of the current settings to 
the clipboard.
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View S

Clicking 
This dialo
[Finishing

[Comment] Displays and allows you to change the 
comment on the currently selected profile. 

NOTE

You cannot change the comments for the pre-defined profiles.

[Import] Enables you to import profile information 
from a file.

[Export] Enables you to export the selected profile 
information to a file.

NOTE

When one of the pre-defined profiles is selected, this button is 
disabled.

[Apply Settings 
from Application]

Applies the selected profile only to the 
settings other than [Page Size], 
[Orientation], and [Copies].

[Copy] 



TOP

Back Previous Next

2-24

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

d Printing 

rinting Preferences Dialog Box

g box enables you to specify the default settings for 
ng options available when you print on the Canon 
Series printer.
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Windows 2000/XP Properties an
Preferences

The printer driver for Windows 2000/XP has the following 
two main dialog boxes:

The Properties Dialog Box

This dialog box enables you to set up the printer configuration 
and configure the print settings for all Windows applications.

The P

This dialo
the printi
MF3200 
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al Tab

print a test page and define printing preferences. Refer 
indows operating system documentation for more 

on.
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■ Properties
The [Canon MF3200 Series Properties] dialog box contains 
several tab sheets that enable you to set up the printer 
configuration and configure the print settings.

NOTE

– The number of tabs displayed in the properties dialog box depends 
on how you have your system set up.

– For more information about the following features, see the online 
help. (See “Online Help,” on p. 1-2.)

– The screen shots shown are from Windows XP.

Gener

Lets you 
to your W
informati
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Tab

 the port to which the printer is attached. Refer to your 
 operating system documentation for more information.
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Sharing Tab

Specifies the printer sharing settings. (See “Using the Machine 
on Your Network,” on p. 2-52.) Refer to your Windows operating 
system documentation for more information.

Ports 

Specifies
Windows
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Management Tab

es color profiles with your color printer. Refer to your 
 operating system documentation for more information.
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Advanced Tab

Specifies the settings for print spooling. Refer to your Windows 
operating system documentation for more information.

NOTE

[Spool print documents so program finishes printing faster] and [Start 
printing immediately] are set automatically when you install the printer 
driver.

Color 

Associat
Windows
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 Tab

you to add, edit, and select a profile to be applied to 
.

ist] Displays the list of registered profiles. 

Displays the name of the profile currently 
selected in [Profile List]. 

nt] Describes the currently selected profile.

ttings] Displays the settings of the currently 
selected profile. (See “View Settings,” on 
p. 2-51.)
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Security Tab

Specifies security settings. Refer to your operating system 
documentation for more information.

Profile

Enables 
print jobs

[Profile L

[Name]

[Comme

[View Se
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dit Profile

[Add] or [Edit] opens the [Add/Edit Profile] dialog box 
ables you to register new profiles and edit existing 
This dialog box has four tab sheets.

nt 
]

Controls the profile settings.
[Allow Profile Selection]:
Enables selection of profiles in the document 
properties dialog box, or the printing 
preferences dialog box.

[Allow Setting Edition]:
Enables addition and edition of profiles as 
well as selection. 

NOTE

n [Allow Profile Selection] is cleared, [Allow Setting Edition] is 
bled.

Displays the version information on the 
driver.
1
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Add/E

Clicking 
which en
profiles. 

[Add] Opens the [Add/Edit Profile] dialog box 
which enables you to register a new profile. 
(See “Add/Edit Profile,” on p. 2-29.)

[Edit] Opens the [Add/Edit Profile] dialog box 
which enables you to edit the registered 
profiles. (See “Add/Edit Profile,” on p. 2-29.)

NOTE

When one of the pre-defined profiles ([Default Settings], [2 on 1], 
or [Confidential]) is selected in [Profile List], this button is 
disabled.

[Delete] Removes the selected profile from [Profile 
List]. 

NOTE

When one of the pre-defined profiles is selected, this button is 
disabled.

[Import] Enables you to import profile information 
from a file.

[Export] Enables you to export the selected profile 
information to a file.

NOTE

When one of the pre-defined profiles is selected, this button is 
disabled.

[Define 
Docume
Property

Whe
disa

[About]
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etup Tab

 the page settings including the paper size, scaling, 
f copies, orientation, and number of pages per sheet.

Selects an icon to represent the new profile, 
or allows you to change the icon of the 
profile selected in the [Profile] tab sheet.

nt] Adds comments on the new profile, or allows 
you to change the comments on the profile 
selected in the [Profile] tab sheet.

 Defaults] Resets all the current settings to the values 
that were displayed when opening the [Add/
Edit Profile] dialog box.
1
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4
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oting

Attribution Tab

The [Attribution] tab sheet enables you to specify attributions of 
the profile.

Page S

Specifies
number o

[Name] Specifies the name of the new profile, or 
allows you to change the name of the profile 
selected in the [Profile] tab sheet. 

[Icon]

[Comme

[Restore
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y Tab

 the print quality including resolution, brightness and 
1

2

3

4
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Finishing Tab

Specifies the finishing settings for the printed pages including 
the collating and binding.

Qualit

Specifies
contrast.
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etup Tab

 the page settings including the paper size, scaling, 
f copies, orientation, number of pages per sheet, etc.
ation on [Profile] and [Output Method], see “Profiles,” 

6.

image Displays the image with the currently 
selected settings reflected. For details on 
preview image, see “Preview image,” on 
p. 2-47.
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■ Printing Preferences
The [Canon MF3200 Series Printing Preferences] dialog box 
contains three tab sheets that enable you to specify the default 
print settings for every print job.

NOTE

– If you access the equivalent dialog box from an application’s [Print] 
dialog box, your selected printing options apply to the print jobs that 
will be printed from the application. They will not be stored when you 
close the application.

– For more information about the following features, see the online help 
(See “Online Help,” on p. 1-2.)

– The screen shots shown are from Windows XP.

Page S

Specifies
number o
For inform
on p. 2-4

Preview 
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yout] Selects the number (1, 2, 4, 6, 8, 9, or 16) of 
original pages per sheet or [Poster] (2 x 2, 3 
x 3, or 4 x 4 pages to comprise one sheet). 
When this option is set to anything other 
than [1 Page per Sheet] and [Poster], the 
original page size is reduced to fit the 
selected page layout when printed.

NOTE

hen [1 Page per Sheet] is selected, [Manual Scaling] 
pears. When this option is set to anything other than [1 Page 
r Sheet] or [Poster], [Page Order] appears instead of [Manual 

caling] in its place.
hen [Poster] is selected, [Manual Scaling], [Watermark] and 
age Options] are disabled.

Scaling] Reduces or enlarges the original page size. 
Selecting this check box enables the edit box 
on the right side to specify the magnification 
factor (25 to 200%).

NOTE

u select enlarge/reduce ratio on the [Print] screen of an 
lication software, select 100% in [Manual Scaling].
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[Page Size] Selects the original page size to work with in 
an application. Available options are; 
[Letter], [11 x 17], [Legal], [Executive], [A5], 
[B5], [A4], [B4], [A3], [Envelope Monarch], 
[Envelope COM10], [Envelope DL], 
[Envelope C5], and [Custom [Name Fixed]]. 
However, when [11 x 17], [B4], or [A3] is 
selected in the [Page Size], the original page 
size is automatically reduced to fit [A4] size.

[Output Size] Selects the output paper size to print on. 
When this option is set to anything other 
than [Match Page Size], the original page 
size is automatically reduced or enlarged to 
fit the selected output paper size when 
printed.

[Copies] Specifies the number of copies to be printed 
(1 to 99).

[Orientation] Selects the direction of printing relative to 
the paper ([Portrait] or [Landscape]).

[Page La

– W
ap
pe
S

– W
[P

[Manual 

If yo
app
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ark] Inserts the selected watermark to be printed 
on each page. Eight types of pre-defined 
watermark are available:
– CONFIDENTIAL
– COPY
– DRAFT
– FILE COPY
– FINAL
– PRELIMINARY
– PROOF
– TOP SECRET
Selecting this check box enables [Edit 
Watermark] to add a watermark.

NOTE

 option is disabled when [Page Layout] is set to [Poster].

termark] Click this button to specify detailed 
watermark settings. (See “Edit Watermark,” 
on p. 2-35.)

 Paper Click this button to specify the dimensions 
for a paper size other than the provided 
standard paper sizes. (See “Custom Paper 
Size Settings,” on p. 2-37.)

NOTE

u can specify the dimensions for a paper size only in the 
rinter Properties] dialog box ([start] → [Printers and Faxes] 
indows 2000: [Printers])). You cannot specify the dimensions 

om the [Document Properties] dialog box (software 
plication).

epending on the application you are using, you can specify 
e dimentions for a paper size. (Only for Windows 2000)
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[Page Order] Selects the order in which original pages are 
placed on each sheet of the output paper 
when more than one page is printed per 
sheet.

[Paper Type] Selects the paper type to print. Available 
paper type are as follows:
– Plain Paper (64 to 90 g/m2)
– Plain Paper L (64 to 90 g/m2)
– Heavy Paper (105 to 128 g/m2)
– Heavy Paper H (105 to 128 g/m2)
– Transparency

NOTE

– If paper curls excessively when printed with [Plain Paper] 
selected, select [Plain Paper L].

– If print fixing is not sufficient when printed with [Heavy Paper] 
selected, select [Heavy Paper H].

– When you select [Envelope Monarch], [Envelope COM10], 
[Envelope DL], or [Envelope C5] as [Page Size], and [Match 
Page Size] as [Output Size], [Paper Type] is automatically set to 
[Envelope].
If you select [Envelope Monarch], [Envelope COM10], 
[Envelope DL], or [Envelope C5] as [Output Size], [Paper Type] 
is automatically set to [Envelope] regardless of the setting of 
[Page Size].

[Waterm

This

[Edit Wa

[Custom
Size]

– Yo
[P
(W
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– D
th
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atermark

[Edit Watermark] in the [Page Setup] tab sheet opens 
Watermark] dialog box. This dialog box enables you to 
ext string as a watermark onto pages. This option is 
only when the [Watermark] check box is selected in the 
tup] tab sheet.
1
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oting

Edit W

Clicking 
the [Edit 
insert a t
enabled 
[Page Se

[Page Options] Click this button to select options for printing 
dates, user name, page numbers, and 
borders, etc. (See “Page Options,” on 
p. 2-39.)

NOTE

This option is disabled when [Page Layout] is set to [Poster].

[Restore Defaults] Resets all the current settings to their default 
values.

[View Settings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-51.)
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Sets the angle of watermark ([Upward Left 
to Right], [Downward Left to Right], or [Set 
Angle]). You can select the corresponding 
radio button, or use the slide bar to move the 
angle, or enter a desired value in the [Set 
Angle] edit box (in a range from –180 to 
180). 

Displays and allows you to change the name 
of the currently selected watermark.

Displays and allows you to change the text 
string of the currently selected watermark.

Selects the font type of the watermark. 

Selects the font style of the watermark. 
Available styles are [Regular], [Italic], [Bold] 
and [Bold Italic].

Specifies the font size of the watermark (1 to 
500).

Selects the font color of the watermark. 
1

2

3

4

5

6

ntents

n

a 

oting

[Watermark List] Displays the names of registered 
watermarks. The preview image in the upper 
left part of the dialog box displays the 
selected watermark with the specified 
settings reflected.

[Add] Registers a new watermark. Clicking this 
button adds a blank name field in 
[Watermark List] in which you enter the 
name of watermark to be registered. Up to 
50 watermarks can be registered.

[Delete] Removes the selected watermark from 
[Watermark List].

NOTE

You cannot delete a pre-defined watermark or a watermark 
currently selected in the [Page Setup] tab.

[Position] Specifies the position where the watermark 
is printed on each page. You can enter the 
values in the [X] and [Y] edit boxes (in a 
range from –50 to 50), or use the X and Y 
slide bars to move the position. 

[Move to Center] Relocates the watermark to the center of the 
page. 

[Angle]

[Name]

[Text]

[Font]

[Style]

[Size]

[Color]
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m Paper Size Settings

[Custom Paper Size] in the [Page Setup] tab sheet 
e [Custom Paper Size Settings] dialog box. This dialog 
les you to define custom paper sizes for quick selection 
ter new custom paper sizes to the [Paper List] box. You 
ify the name, width, and height of each size.

tting is available only when you open the [Canon MF3200 
rinting Preferences] dialog box from the [Printers and Faxes] 
s 98/Me/2000: [Printers]) folder.

ing on the application you are using, this setting is also 
e from the [Document Properties] dialog box (software 
ion). (Only for Windows 2000)
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[Border] Adds the frame to the watermark. You can 
select the frame type ([Circle], [Rectangle], 
or [None]).

[Print Style] Selects the type of watermark ([Transparent] 
or [Overlap]).

[Print on First 
Page Only]

Prints the selected watermark only on the 
first page of the document.

NOTE

You cannot edit pre-defined watermarks.
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r] Registers the custom paper and adds its 
name to [Paper List].

NOTE

egister a new custom paper size, be sure to log on as a 
ber of Administrators (Windows 2000/XP) or Power User 
dows 2000 only). To change the paper size for the existing 

tom paper size, be sure to log on as a member of 
inistrators.

Removes the selected custom paper from 
[Paper List].

NOTE

u cannot delete a pre-defined paper size or a paper size 
rrently selected in the [Page Setup] tab.
 delete a registered custom paper size, be sure to log on as a 
ember of Administrators.
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[Paper List] Displays the paper sizes actually available. 
Selects a paper size from which you can 
create a custom paper size.

NOTE

You can share the custom paper sizes with all printers connected 
to your computer.

[Name of Custom 
Paper Size]

Specifies the name of custom paper.

[Unit] Selects the unit of measurement of paper 
size ([Millimeter] or [Inch]).

[Paper Size] Specifies the width and height of the custom 
paper.

NOTE

Be sure that [Width] does not exceed [Height] when specifying 
the values.

[Registe

To r
mem
(Win
cus
Adm

[Delete]
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Adds a page frame to be printed on each 
page. 11 options are available. Edging is not 
available to use with [Print Grayscale 
Sample] in the [Quality] tab sheet. (See 
“Quality Tab,” on p. 2-41.)

te] Selects if the date is printed on each page or 
not. Six positions to print the date are 
available. 

er Name] Selects if the user name is printed on each 
page or not. Six positions to print the user 
name are available.

ge Selects if the page number is printed on 
each page or not. Six positions to print the 
page number are available.

Settings] Click this button to display the [Format 
Settings] dialog box. This dialog box allows 
you to set the default font type, style, size, 
and color, or reset to the factory default font 
settings.

 Defaults] Resets all the current settings to their default 
values.
1

2

3

4

5

6

ntents

n

a 

oting

Page Options

Clicking [Page Options] in the [Page Setup] tab sheet opens the 
[Page Options] dialog box. This dialog box enables you to print 
pages with a page frame, header, and footer. This option is 
disabled when [Page Layout] in the [Page Setup] tab sheet is set 
to [Poster].

[Edging]

[Print Da

[Print Us

[Print Pa
Number]

[Format 

[Restore
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Location] Selects a binding location for the printed 
pages.

Click this button to set the gutter width for 
binding a printed document. (See “Gutter 
Settings,” on p. 2-41.)

g] Select the Collate option to print a document 
in correct binding order. For example, when 
printing multiple copies of a 3-page 
document, the print order is 1, 2, 3, 1, 2, 3, 
and so on ([Off] or [Collate]).

NOTE

u select [Collate] in [Finishing], the image on the left bottom 
e preview image will change.

d Click this button to display [Advanced 
Settings] dialog box for specifying the 
finishing details. (See “Advanced Settings,” 
on p. 2-41.)

 Defaults] Resets all the current settings to their default 
values.

ttings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-51.)
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Finishing Tab

Specifies the finishing settings for the printed pages including 
the collating and binding.
For information on [Profile] and [Output Method], see “Profiles,” 
on p. 2-46.

Preview image Displays the image with the currently 
selected settings reflected. For details on 
preview image, see “Preview image,” on 
p. 2-47.

[Binding 

[Gutter]

[Finishin

If yo
of th

[Advance
Settings]

[Restore

[View Se
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y Tab

 the settings for print quality including the resolution 
rast.

ation on [Profile] and [Output Method], see “Profiles,” 
6.
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Gutter Settings

Clicking [Gutter] in the [Finishing] tab sheets opens the [Gutter 
Settings] dialog box.

Advanced Settings

Clicking [Advanced Settings] in the [Finishing] tab sheet opens 
the [Advanced Settings] dialog box.

Qualit

Specifies
and cont
For inform
on p. 2-4

[Gutter] Specifies the gutter width in a range from 0 
to 30 mm.

[Image 
Refinement]

Sets the Super Smoothing function of the 
printer.

NOTE

If the [Resolution] in the [Detailed Settings] dialog box is set to 
[300 dpi], a document is always printed with Super Smooting 
function.

[Restore Defaults] Resets all the current settings to their default 
values.
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le Click this button after selecting the [Manual 
Grayscale Settings] check box to manually 
adjust the grayscale settings. The [Grayscale 
Settings] dialog box allows you to specify 
Brightness, Contrast, and Matching Mode. 
(See “Grayscale Settings,” on p. 2-44.)

NOTE

 option is enabled only when [Manual Grayscale Settings] is 
cted.

ttings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-51.)

Displays the version information on the 
driver. 

 Defaults] Resets all the current settings to their default 
values.
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[Objective] Selects the best setting for the print job 
according to document content.

[Details] Click this button to open the [Detailed 
Settings] dialog box and make print quality 
settings. (See “Detailed Settings,” on 
p. 2-43.)

[Manual Grayscale 
Settings]

Enables the manual grayscale. Selecting this 
check box enables [Grayscale Settings] to 
access the dialog box which allows you to 
set the grayscale for images. (See 
“Grayscale Settings,” on p. 2-44.)

[Print Grayscale 
Sample]

Prints nine thumbnails per sheet to provide 
the print samples with the current grayscale 
settings when printing the document. 

NOTE

– This option is enabled only when [Manual Grayscale Settings] 
is selected.

– When you are finished with the Print Grayscale Sample, make 
sure that you clear the Print Grayscale Sample check box on 
the Quality sheet.

– When using the Print Grayscale Sample, make sure that 1Page 
per Sheet is selected for Page Layout on the Page Setup sheet. 

[Graysca
Settings]

This
sele

[View Se

[About]

[Restore
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alftones] Specifies the use of dithering for printing 
halftone data.

Pattern1:
Applies dither pattern of high-quality 
gradient for printing graphics and graphs 
with gradation.

Pattern2:
Applies dither pattern of high-quality tone 
with sharpness  and stability for printing 
image data such as pictures.

Pattern3:
Applies dither pattern of sensitive and clear-
cut for printing documents including with 
lines and figures.

None [Solid]:
Prints all colors in black except for white.
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Detailed Settings

Clicking [Details] in the [Quality] tab sheet opens the [Detailed 
Settings] dialog box. This dialog box enables you to specify 
detailed settings for print quality.

[Resolution] Selects the printer’s resolution in dot per 
inch (600 dpi or 300 dpi).

[B & W H
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cale Adjustment Tab

] Displays the image with the currently 
selected brightness and contrast reflected.

] Displays the original image.

ss] Adjusts the brightness of the preview image 
in the range from –5 to 5.

t] Adjusts the contrast of the preview image in 
the range from –5 to 5.

 Defaults] Resets all the current settings to their default 
values.
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Grayscale Settings

Clicking [Grayscale Settings] in the [Quality] tab sheet opens the 
[Grayscale Settings] dialog box. This dialog box enables you to 
control the brightness and contrast of images. This function is 
enabled only when [Manual Grayscale Settings] is selected in 
the [Quality] tab sheet. (See “Quality Tab,” on p. 2-41.) Two tab 
sheets are provided in this dialog box.

Grays[Enable Image 
Correction]

Select [Enable Image Correction] to smooth 
out the streaking and coarse features that 
tend to occur when printing enlarged image 
files and photographs using a software 
application.

[Toner Save] Modifies print data to print lighter and 
conserve toner.
Printer Default:
Prints using the settings in the operation 
panel of the printer.
Off:
Prints using normal density.
On:
Prints text lighter in printouts for 
proofreading and checking.

[Preview

[Original

[Brightne

[Contras

[Restore
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g Method] Specifies the matching method by assigning 
highest priority when the [Driver Matching 
Mode] is selected in the [Matching Mode] 
box.
Perceptual [Monitor Color Matched]:
Gives priority to matching the hue of the 
color on the monitor with the color of the 
printed output.
Colorimetric:
Gives priority to reducing the color difference 
between the original document on the 
screen (a logo, for example) and the printed 
output.
Saturation:
Gives priority to vividness in matching.

NOTE

 option can be selected only when [Driver Matching Mode] is 
cted for [Matching Mode].

Profile] Specifies the setting suitable for your monitor 
when the [Driver Matching Mode] is selected 
in the [Matching Mode] box.

NOTE

his option can be selected only when [Driver Matching Mode] 
 selected for [Matching Mode].
 the case where several gamma values are provided for one 
tion, select the higher gamma value to obtain better results if 
e printed image is lighter than that of the monitor.
the monitor is set to a custom setting, it is difficult to produce 
inted output similar to the color of the monitor when 
rforming matching.
1
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Matching Tab

[Matching Mode] Specifies the procedure for color correction.
Driver Matching Mode:
Processes color in the printer driver. The 
settings specified in [Matching Method] and 
[Monitor Profile] will be enabled.
Gamma Adjustment:
Performs gamma adjustment with the 
gamma correction value specified in the 
[Gamma] box.

[Matchin

This
sele

[Monitor 
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is
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s

red combination of settings for the [Page Setup], 
], and [Quality] tab sheets is referred to as a profile. 

le function commonly provided in each of these tab 
nables you to add, edit, and select a profile, which 
 your print jobs.

Stores various printer driver settings, each 
suitable for certain print jobs, as user-
defined Profiles. Selecting Profiles from the 
drop-down list enables the printer to perform 
a variety of print jobs. A frequently 
performed print job can also be saved as a 
Profile.
1
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4
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oting

Profile

A registe
[Finishing
The profi
sheets e
facilitates

[Gamma] Specifies the gamma correction value when 
the [Gamma Adjustment] is selected in the 
[Matching Mode] box.
The brightness of the document printout can 
be adjusted without losing the brightest and 
darkest portion of the document.
This option is useful when the printout result 
is brighter than the original image (for 
example, a photograph before scanning or 
graphics displayed on the monitor), or when 
you want to intentionally change the 
brightness of the output.
Four gamma correction values are provided. 
The larger the value, the darker the printout 
is.
1.0
1.4
1.8
2.2

[Restore Defaults] Resets all the current settings to their default 
values.

[Profile]
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ethod] Switches the job mode between [Print] and 
[Edit and Preview].

Print:
Executes a normal print job. 

Edit and Preview:
Saves the data in the [Canon 
PageComposer] dialog box. If you open 
[Canon MF3200 Series Printing 
Preferences] from the [Printers and Faxes] 
(Windows 2000: [Printers]) folder and select 
the [Edit and Preview] mode,  (Lock) 
button appears on the right side. When you 
click this button, the [Edit and Preview] mode 
is locked.

NOTE

ending on the application you are using,  (Lock) button also 
ears from the [Document Properties] dialog box (software 
lications). (Only for Windows 2000)
1

2

3

4

5

6
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Preview image Displays the image with the currently 
selected settings reflected.
Changes the setting for [Page Layout] every 
time you click anywhere inside the image of 
the page. The setting changes in the 
following order; [1 Page per Sheet] → [2 
Pages per Sheet] → [4 Pages per Sheet] → 
[1 Page per Sheet].
Right clicking the mouse button on the 
preview image displays the pop-up menu, 
from which you can also change the setting 
for [Page Layout].
Clicking the edges of the preview image of 
the page changes the binding location.

NOTE

Settings made on the [Quality] tab are not reflected in the preview 
image.

[Output M

Dep
app
app
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rofile

 (Add Profile) opens the [Add Profile] dialog box. 
g box enables you to register a new profile with the 

ettings. You can add up to 50 new profiles.

Specifies the name of the profile to be 
registered.

Selects an icon to represent the profile to be 
registered.

nt] Adds comments on the profile to be 
registered.

ttings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-51.)
1
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Add P

Clicking 
This dialo
current s

 (Add Profile) Click this button to display the [Add Profile] 
dialog box to add a new Profile to the list. 
(See “Add Profile,” on p. 2-48.)

 (Edit Profile) Click this button to display the [Edit Profile] 
dialog box to edit the name, icon, or 
comment of a stored Profile. (See “Edit 
Profile,” on p. 2-49.)

[View Settings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-51.)

[Name]

[Icon] 

[Comme

[View Se
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ttings] Click this button to display the [View 
Settings] dialog box. This dialog box allows 
you to view and confirm all of the current 
page settings in a listed form. (See “View 
Settings,” on p. 2-51.)

e Up) Moves the profile selected in the [Profile List] 
one position up.

e Down) Moves the profile selected in the [Profile List] 
one position down.

Removes the selected profile from [Profile 
List].

NOTE

 cannot delete the pre-defined profiles and the profile that is 
ently selected in [Profile] of the [Page Setup] tab.

Displays and allows you to change the name 
of the currently selected profile. 

NOTE

 cannot change the names for the pre-defined profiles.
1

2

3

4

5

6
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Edit Profile

Clicking  (Edit Profile) opens the [Edit Profile] dialog box. 
This dialog box enables you to edit the profile selected in [Profile 
List].

[Profile List] Displays the list of registered profiles.

[View Se

 (Mov

 (Mov

[Delete]

You
curr

[Name]

You
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Enables you to import profile information 
from a file.

Enables you to export the selected profile 
information to a file.

NOTE

n one of the pre-defined profiles is selected, this button is 
bled.

ettings 
lication]

Applies the selected profile only to the 
settings other than [Page Size], 
[Orientation], and [Copies].
1

2

3

4

5

6
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[Icon] Displays and allows you to change the icon 
representing the currently selected profile.

NOTE

You cannot change the icons for the pre-defined profiles.

[Comment] Displays and allows you to change the 
comment on the currently selected profile.

NOTE

You cannot change the comments for the pre-defined profiles.

[Import]

[Export]

Whe
disa

[Apply S
from App
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View Settings

Clicking [View Settings] opens the [View Settings] dialog box. 
This dialog box displays the current settings in the [Page Setup], 
[Finishing], and [Quality] tab sheets.

[Copy] Copies the contents of the current settings to 
the clipboard.
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ork

ws 2000/XP Server Settings

wing is the procedure to make your machine available 
etwork users, under Windows 2000/XP.

g Server Service (Windows XP)

ck [start] on the Windows task bar → 
ect [Control Panel].
 [Control Panel] folder appears.

lect [Network and Internet Connections] → 
k [Network Connections].

 [Network Connections] folder appears.

ht click the [Local Area Connection] icon 
select [Properties] from the pop-up menu.
 [Local Area Connection Properties] dialog box appears.
1
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3

4

5

6
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Using the Machine on Your Netw
This section provides instructions for using the machine on 
your network as a shared printer.
By setting your machine as a shared printer on your 
network, the network users can share the machine for 
printing. The print server and clients do not need to use the 
same operating system, and it is possible to print from a 
Windows 98/Me client to a Windows 2000/XP print server, or 
vice versa.
You can start printing simply by starting the server, even if 
the server was not running when the client was started.
If the server is running on Windows 2000/XP, you can print 
even if no one is logged into the server.

■ Setting the Machine as a Shared Printer
If you plan to share your machine on a network, install the print 
server locally, then make the following settings. For more 
information, see your print server system documentation.

Windo

The follo
to your n

● Addin

1. Cli
sel
The

2. Se
clic
The

3. Rig
→ 
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ht click the [Local Area Connection] icon 
select [Properties] from the pop-up menu.
 [Local Area Connection Properties] dialog box appears.

lect [File and Printer Sharing for Microsoft 
tworks] → click [OK].

 server service is added.
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4. Select [File and Printer Sharing for Microsoft 
Networks] → click [OK].

The server service is added.

● Adding Server Service (Windows 2000)

1. Click [Start] on the Windows task bar → 
select [Settings] → [Network and Dial-up 
Connections].
The [Network and Dial-up Connections] folder appears.

2. Rig
→ 
The

3. Se
Ne

The
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ter a share name in the edit box as needed.

NOTE

not enter a space or special character in the [Share name] 
 box.

ck [OK].
 printer driver icon changes to indicate sharing.

ws 98/Me Server Settings

wing is the procedure to make your machine available 
etwork users, under Windows 98/Me.
en shots shown are from Windows 98.

g Server Service

ck [Start] on the Windows task bar → 
ect [Settings] → [Control Panel].
 [Control Panel] folder appears.

uble-click the [Network] icon.
 [Network] dialog box appears.
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● Setting Printer Sharing

1. Open the printer properties dialog box → 
select [Share this printer] (Windows 2000: 
[Shared as]) in the [Sharing] tab sheet.

NOTE

On how to open the printer properties dialog box, see “Changing 
Print Settings,” on p. 2-3.

2. En

Do 
edit

3. Cli
The

Windo

The follo
to your n
The scre

● Addin

1. Cli
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2. Do
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lect [File and printer sharing for Microsoft 
tworks] → click [OK].
1

2

3

4

5

6

ntents

n

a 

oting

3. Click [Add] in the [Configuration] tab sheet.

The [Select Network Component Type] dialog box appears.
If [File and printer sharing for Microsoft Networks] is already 
added, go to step 6.

4. Select [Service] → click [Add].

The [Select Network Service] dialog box appears.

5. Se
Ne
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lect the [Access Control] tab → [Share-
el access control] or [User-level access 
ntrol].

ck [OK].
 server service is added.
e confirmation message dialog box appears, click [Yes] to 
art your computer.
1

2

3
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6. Click [File and Print Sharing].

The [File and Print Sharing] dialog box appears.

7. Make sure that [I want to be able to allow 
others to print to my printer(s).] is selected → 
click [OK].

8. Se
lev
co

9. Cli
The
If th
rest
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uble-click the machine icon, or drag the 
chine icon to your [Printers and Faxes] 
indows 98/Me/2000: [Printers]) folder.
 [Add Printer Wizard] dialog box appears.

llow the instructions on the screen to 
mplete the installation.

rinter Wizard (Windows 2000/XP)

wing is the procedure to connect to the shared printer 
etwork using Windows 2000/XP.

n in Windows 2000/XP needs to be done by a user with 
tor privileges.

en the [Printers and Faxes] (Windows 
0: [Printers]) folder.

k [start] on the Windows task bar, then select [Printers and 
es] (Windows 2000: [Start] → [Settings] → [Printers]).

en the [Add Printer Wizard] dialog box.
k [Add a printer] in [Printer Tasks] (Windows 2000: double-
 the [Add Printer] icon).
1
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■ Using the Shared Printer on Your 
Network

When the machine is already on your network and set as a 
shared printer, you can use it via network. The easiest way to 
make the machine available for your computer is using network 
download. If your operating system is Windows 2000/XP, you 
cannot download the driver from Windows 98/Me servers. In 
that case, use [Add Printer Wizard].

Network Download

The following is the procedure to connect to the shared printer 
on your network using network download.

NOTE

Windows 2000/XP clients cannot download the driver from Windows 
98/Me servers.

1. Open Windows Explorer → browse the 
network until you see the icon of the shared 
printer.

2. Do
ma
(W
The

3. Fo
co

Add P

The follo
on your n

NOTE

Installatio
administra

1. Op
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Fax
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rinter Wizard (Windows 98/Me)

wing is the procedure to connect to the shared printer 
etwork using Windows 98/Me [Add Printer Wizard].
en shots shown are from Windows 98.

ck [Start] on the Windows task bar → 
ect [Settings] → [Printers].
 [Printers] folder appears.

uble-click the [Add Printer] icon.
 [Add Printer Wizard] dialog box appears.

ck [Next].

lect [Network printer] → click [Next].
1
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3. Click [Next].

4. Select [A network printer, or a printer 
attached to another computer] (Windows 
2000: [Network printer]), then click [Next].
The [Specify a Printer] (Windows 2000: [Locate Your Printer]) 
dialog box appears.

5. Select [Connect to this printer (or to browse 
for a printer, select this option and click 
[Next])] (Windows 2000: [Type the printer 
name, or click Next to browse for a printer]) 
→ enter the name of the printer you want to 
connect to → click [Next].
If you do not know the name of the printer, click [Next] without 
entering the name to proceed to the [Browse for Printer] dialog 
box. In this dialog box, select the printer → click [Next].

NOTE

– If the printer name is invalid, it means the client cannot connect 
the shared printer.

– If a suitable driver is not found, it probably means the server is 
a Windows 98/Me computer.

6. Follow the instructions on the screen to 
complete the installation.

Add P

The follo
on your n
The scre
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2. Do
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lect the location containing the printer 
ver.

pecify in the default location:
to step 9.
hange the location:
k [Browse].
ct the location containing the printer driver → click [OK].

 can also enter the path name directly in the edit box.

ck [OK].

ter the name of the printer you want to use 
click [Next].
u accept the default name, leave the edit box as it is → click 

xt].

NOTE

e connection fails, you will be able to install the printer but you 
not be able to use the printer until it comes back online.

llow the instructions on the screen to 
mplete the installation.
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5. Enter the network path or print queue that 
you want to connect to, or select the location 
of the shared printer.
To enter the location directly:
Enter the path name or print queue in the edit box.
To select the location:
Click [Browse].
Select the location of the printer → click [OK].
Depending on your network environment, the installation of the 
driver may be carried out automatically. In this case you need not 
perform steps 7 through 10.

6. Click [Next].

7. Click [Have Disk].

The [Install From Disk] dialog box appears.

8. Se
dri

To s
Go 
To c
Clic
Sele
You

9. Cli

10.En
→ 
If yo
[Ne
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will 

11.Fo
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................................................. 3-3

t] ............................................. 3-4

o Operate in a Different Way 
............................................3-4

 the [Settings] Dialog Box ........ 3-5

 the [Scanners and Cameras] 
................................................. 3-5

................................................. 3-7

................................................. 3-9

................................................. 3-9

e to ....................................... 3-11

ail Program)......................... 3-12

Scanned Image and 
m the Scanned Image) ......... 3-13
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3 Scanning a Document

Scanning with [Start] on the Machine ..

Setting the Scanning Function for [Star

Setting Up [Start] t
from [Save] ..........

Setting Up [Start] in

Setting Up [Start] in
Folder ....................

Scanning with the MF Toolbox ..............

MF Toolbox Settings...............................

Scanner Settings ...

Save Scanned Imag

External Program (M

Confirmation of the 
Exif Settings (Confir
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............................................. 3-15

e Pages ................................ 3-16

 ScanGear MF ...................... 3-18

Simple Mode and Advanced 
............................................. 3-18

.............................................. 3-18

de ......................................... 3-21

 Specifying the Parameters 
....................................... 3-23

ttings...................................... 3-24

tion ........................................ 3-39

 XP Only)............................. 3-41

Scanner and Camera Wizard] 
............................................... 3-41

pplication............................... 3-44
1

2

3

4

5

6

ntents

n

a 

oting

Scanning an Image from an Application

Creating One PDF File from Two or Mor

Setting Preferences and Scanning with

Switching between 
Mode .....................

Using Simple Mode

Using Advanced Mo

Advanced Mode –
of a Scan ............

Advanced Mode Se

Determining Resolu

Scanning with the WIA Driver (Windows

Scanning from the [
Dialog Box .............

Scanning from an A
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Scanning with [Start] on the Ma
You can scan documents and transmit the scanned data to 
your computer using the operation panel of the machine.

NOTE

Your machine must be connected via USB and the USB printer driver 
must be loaded to scan. This machine does not support network 
scanning.

1. Set documents.

2. Press [SCAN] on the machine.

3. Press [Start] on the machine.
If you are asked to select a program to launch, select “MF 
Toolbox Ver4.9.” The scanned document will be processed 
according to your settings.

When you use [Start] for the first time, a folder with the scanning 
date will be created in the [My Pictures] folder in the [My 
Documents] folder, and your document will be saved in this folder.



TOP

Back Previous Next

3-4

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

or [Start]
g the  mark over the button you want to 
ect.

  mark will be displayed above the button you select.
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Setting the Scanning Function f
When you scan for the first time using [Start] on the 
machine, scanning will occur in the same way as when you 
click [Save] in the MF Toolbox. You can change the 
scanning function set for [Start] on the machine.

■ Setting Up [Start] to Operate in a 
Different Way from [Save]

1. On the Windows desktop, double-click the 
[Canon MF Toolbox 4.9] icon to open the MF 
Toolbox.
You can also open the MF Toolbox by clicking [start] on the 
Windows task bar → [(All) Programs] → [Canon] → [MF Toolbox 
4.9] → [Toolbox 4.9].

2. Dra
sel

The
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ting Up [Start] in the [Scanners and 
eras] Folder

en the [Scanners and Cameras] folder 
indows 98/2000: the [Scanners and 
meras Properties] dialog box).
k [start] on the Windows task bar → select [Control Panel] → 
nters and Other Hardware] → [Scanners and Cameras] 
ndows 98/Me/2000: [Start] → [Settings] → [Control Panel] → 
ble-click [Scanners and Cameras]).

ck the corresponding scanner driver icon.
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■ Setting Up [Start] in the [Settings] 
Dialog Box

In the MF Toolbox, click [Settings] to open the [Settings] dialog 
box. From the [Start] drop-down list, select the scanning function 
you want to link [Start] to, then click [OK].

■ Set
Cam

1. Op
(W
Ca
Clic
[Pri
(Wi
dou

2. Cli
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ecify an action for [Start].
ct the [Events] tab → select the option corresponding to your 
hine from [Select an event] → select the operation for [Start] 
ctions] → click [OK] (Windows 98/Me/2000: Select the 
nts] tab → select the option corresponding to your machine 
 [Scanner events] → select the operation for [Start] in [Send 
is application] → click [OK]).

ngs you specified in the scanner property dialog box do not 
ediately, disconnect and reconnect the USB cable, or restart 
uter.
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3. Select [Properties] from the [File] menu 
(Windows 98/2000: Click [Properties]).

4. Sp
Sele
mac
in [A
[Eve
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to th

NOTE

If the setti
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ialog box appears for each of the buttons.

mple: [Mail] dialog box
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Scanning with the MF Toolbox
You can scan a document using the buttons on the MF 
Toolbox.

1. Set documents.

2. On the Windows desktop, double-click the 
[Canon MF Toolbox 4.9] icon to open the MF 
Toolbox.
You can also open the MF Toolbox by clicking [start] on the 
Windows task bar → [(All) Programs] → [Canon] → [MF Toolbox 
4.9] → [Toolbox 4.9].

3. Click one of the scanning buttons.
[Mail]: The document will be scanned and attached to an e-mail 
message in your e-mail application.

[OCR]: The text will be scanned and read by the OCR software.

[Save]: The document will be scanned and saved.

[PDF]: The text will be scanned and saved as a PDF file.

[Scan-1], [Scan-2]: The text will be scanned and appear in the 
registered application. You can change the button name by 
directly entering a new name (up to 8 characters long) over the 
button name.

A d

Exa
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ecify the required settings.
details, see “Setting Preferences and Scanning with 
nGear MF,” on p. 3-18.

ck [Scan].
u do not make any change on the items under Save Scanned 
ge to in step 4, a folder with the scanning date will be created 
e [My Pictures] folder in the [My Documents] folder, and your 
ument will be saved in this folder.

u have applications registered to the [Mail], [OCR], [PDF], 
n-1], or [Scan-2] buttons, the scanned image will be 
layed in the application or attached to an e-mail message 
r scanning. For details, see “External Program (Mail 
gram),” on p. 3-12.

 CD-ROM provided with the machine contains some 
lications which can be used with the MF Toolbox. When the 
lications in the CD-ROM are installed, they will be registered 
e MF Toolbox buttons.

R]: OmniPage SE

F]: Presto! PageManager
1

2

3

4

5

6

ntents

n

a 

oting

4. Specify the required settings.
For details, see “MF Toolbox Settings,” on p. 3-9.
Select the [Display the Scanner Driver] check box, to display the 
[ScanGear MF] dialog box on step 5. This check box is not 
available when scanning with the [OCR] button. 
If you want to keep the same settings for future scans, click 
[Apply] before clicking [Start].

5. Click [Start].

When the [Display the Scanner Driver] check box is not selected 
in step 4, the scanning will start.

6. Sp
For 
Sca

7. Cli
If yo
Ima
in th
doc

If yo
[Sca
disp
afte
Pro

The
app
app
in th

[OC

[PD
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nner Settings
specify the scanning mode, resolution, document size, 
ize of the scanned image.

ource] Selects where the document is placed.

NOTE

 can select [Platen Glass] only.

ize] Selects the size and orientation of the 
document to be scanned. Selecting 
[Custom] opens the [Paper Size Settings] 
dialog box which enables you to set the 
custom paper size.
1

2

3

4

5

6
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MF Toolbox Settings

Example: [Mail] dialog box

■ Sca
You can 
and file s

[Select S

You

[Paper S
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imit of 
 File]

Selects an approximate upper size limit 
(after compression) for the image you will 
send. For an ordinary mail message, 
[150 KB] is recommended.
You cannot select this item when [PDF], 
[PDF (Multiple Pages)] or [PDF (Add Page)] 
is selected in [Save as Type].

uality] Selects the scan resolution up to 600 dpi. 
When scanning using the [OCR] button, or 
[PDF], [PDF (Multiple Pages)], or [PDF (Add 
Page)] is selected in [Save as Type], you can 
only select up to 400 dpi.
When scanning using the [Mail] button, the 
resolution you can select depends on the 
setting in [Upper Limit of Attached File].

the 
 Driver]

If you select this check box, all items in the 
[Scanner Settings] become invalid, and 
when [Start] is clicked the [ScanGear MF] 
dialog box appears and enables you to make 
advanced settings for scanning.
This check box is not available when 
scanning with the [OCR] button.
1

2

3

4

5

6
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[Scan Mode] Selects the scan mode. The scan modes 
you can select differ depending on the MF 
Toolbox button you press.

[Black and White]:
Scans document as a black and white 
image.

[Black and White (OCR)]:
Scans document as a black and white image 
for OCR software.

[Grayscale]:
Scans document as a grayscale image 
(similar to a monochrome picture).

[Color]:
Scans document as a color image.

[Color (Magazine)]:
Scans document as a color image with the 
Descreen function, which enables you to 
reduce the moiré when scanning printed 
photographs and pictures.

[Upper L
Attached

[Image Q

[Display 
Scanner
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NOTE

he type of file which can be saved with each button is shown 
elow.

[PDF (Multiple Pages)]:
Creates one PDF file from two or more 
scanned pages. (See “Creating One PDF 
File from Two or More Pages,” on p. 3-16.)

[PDF (Add Page)]:
Adds the scanned image to the last page of 
an existing PDF file that was created with 
the MF Toolbox.

BMP
JPEG/

Exif
TIFF PDF

PDF 
(Multiple 
Pages)

PDF 
(Add 
Page)

ail] – ● – ● ● ●

CR] ● ● ● – – –

ve] ● ● ● ● ● ●

F] – – – ● ● ●

an-1], 
an-2]

● ● ● – – –

hen [PDF], [PDF (Multiple Pages)], or [PDF (Add Page)] is 
lected and if an error message appears indicating that the 
age size is too large, reduce the data size of the scanned 
age. For details, see “Output Settings,” on p. 3-26.
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■ Save Scanned Image to
You can specify the file name, file format, and location to save 
the scanned image. If you select PDF as a file format, you can 
also specify the detailed settings for the PDF file.

 

– T
b

[File Name] Enter a file name for the scanned image.
If you save another file with the same name, 
four digits starting from 0001 will be attached 
after the file name.

[Save as Type] Specifies the file type to save the scanned 
image.

[BMP]:
Bitmap format.

[JPEG/Exif]:
JPEG/Exif format. This option is available 
when [Grayscale], [Color] or [Color 
(Magazine)] is selected in [Scan Mode].

[TIFF]:
TIFF format.

[PDF]:
PDF format.

[M

[O

[Sa

[PD

[Sc
[Sc

– W
se
im
im
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ernal Program (Mail Program)
anning using the [OCR], [PDF], [Scan-1], or [Scan-2] 
you can specify an application to be used to display the 
 image. Click [Set] → select the application to use → 
en]. You can also specify an application by dragging 
ping the application icon onto the dialog box.

 the link to the application, click [Delete]

anning using the [Mail] button, you can specify an 
ftware to which you want to attach the scanned image. 
oolbox is compatible with e-mail software such as 
xpress, Microsoft Outlook, EUDORA and Netscape 

er. Click [Set] → select the application to use → click 
1

2

3

4

5

6
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■ Ext
When sc
buttons, 
scanned
click [Op
and drop

To delete

When sc
e-mail so
The MF T
Outlook E
Messeng
[OK].

[PDF Settings] Opens the [PDF Settings] dialog box which 
enables you to make advanced settings of 
the PDF file. (See “Creating One PDF File 
from Two or More Pages,” on p. 3-16.) This 
button appears when [PDF], [PDF (Multiple 
Pages)] or [PDF (Add Page)] is selected in 
[Save as Type].

[Save Scanned 
Image to]

Shows the location to save the scanned 
images when an option other than [PDF 
(Add Page)] is selected in [Save as Type]. To 
change the location, click [Browse] → select 
a folder → click [OK].
When you scan for the first time, a folder with 
the scanning date will be created in the [My 
Pictures] folder in the [My Documents] 
folder, and your document will be saved in 
this folder.

[Add Scanned 
Image to]

This item appears instead of [Save Scanned 
Image to] when [PDF (Add Page)] is 
selected in [Save as Type]. You can select 
the PDF file to which you want to add the 
scanned image.

[Save Pictures to 
a Subfolder with 
Current Date]

Select this check box to create a folder with 
current date (e.g. 2005-12-31) in the 
specified location and save the scanned 
images in this folder.
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ttings] Opens the [PDF Settings] dialog box which 
enables you to make advanced settings of 
the PDF file. (See “Creating One PDF File 
from Two or More Pages,” on p. 3-16.) This 
button appears when [PDF], [PDF (Multiple 
Pages)] or [PDF (Add Page)] is selected in 
[Save as Type].

anned 
]

Specifies the location to save the scanned 
image.

nned 
]

This item appears instead of [Save Scanned 
Image to] when [PDF (Add page)] is 
selected in [Save as Type]. You can select 
the PDF file to which you want to add the 
scanned image.

ctures to 
er with 
ate]

Select this check box to create a folder with 
current date inside the specified location and 
save the scanned images in this folder. This 
check box appears when the file type other 
than [PDF (Add Page)] is selected in [Save 
as Type].
1

2

3

4

5
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■ Confirmation of the Scanned Image and 
Exif Settings (Confirm the Scanned 
Image)

You can preview the scanned images as thumbnail images, and 
specify the file type and location to save them.

NOTE

You cannot use this function when scanning with the [OCR] button.

Select [Confirmation of the Scanned Image and Exif Settings] 
(for the [PDF] button, [Confirm the Scanned Image]) → click 
[Start]. When the scanning is complete, the thumbnail of the 
scanned image is displayed.
Confirm the thumbnail image → specify the file type and location 
→ press [Save] or [Forward].

[Save as Type] Specifies the file type to save the scanned 
image. The available file types are the same 
as those listed in “Save Scanned Image to,” 
on p. 3-11.

[Exif Settings] Opens the [Exif Settings] dialog box which 
enables you to set the Exif information when 
[JPEG/Exif] is selected in [Save as Type]. 
(See “Exif Settings,” on p. 3-14.)

[PDF Se

[Save Sc
Image to

[Add Sca
Image to

[Save Pi
a Subfold
Current D
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ettings

attach extra information in the EXIF format, such as the 
n of the image, the date when the image was 

, etc., to the JPEG files. Select a scanned image from 
down list to view and add information for the image.

ion]
Displays the information automatically 
acquired by scanning.

d 
ion] 

Displays the extra information you enter.

e Same 
f 
s 

ically]

Select this check box to use the same values 
you have specified in the previous scanning 
operation.
1
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Exif S

You can 
descriptio
scanned
the drop-

[Forward] Press to forward the scanned images to the 
application you specified in the [Mail 
Program] or the [External Program] setting.

[Save] Press to save the scanned images in the 
specified location. This button appears 
instead of [Forward].

[Cancel] Cancels the operation and returns to the 
previous window. Deletes all the images 
scanned in the operation.

[Basic 
Informat

[Advance
Informat

[Apply th
Setting o
Input Item
Automat
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lication
1
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Scanning an Image from an App
You can scan an image from a TWAIN- or WIA- (Windows 
XP only) compliant application and use the image in that 
application. The following is an example of the procedure.

1. Set documents.

2. Open the application you want to use.

3. Select the command to scan.

4. Select the scanner driver to be used.
With Windows XP, you can use the ScanGear MF or the WIA 
driver as the scanner driver.

NOTE

You may not select the TWAIN driver on the ‘Paint’ tool that is 
attached to Windows XP.

5. Specify the scanner settings → click [Scan].
For details, see “Setting Preferences and Scanning with 
ScanGear MF,” on p. 3-18, or “Scanning with the WIA Driver 
(Windows XP Only),” on p. 3-41.
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 or More Pages
ecify the required settings → click [OK].

ate Searchable PDF]: Converts the characters in the 
ument to text data and makes the PDF document searchable 
 keywords.

t Language]: Select the language of the text to be scanned. 
 characters may be recognized more accurately if you select 
glish] from this drop-down list and set [Image Quality] to [300 
 or higher in the [Scanner Settings]. (See “Scanner Settings,” 
. 3-9.)

F Compression]: Select [High] for color images such as 
tos or illustrations to be further compressed, reducing the file 
. For the other type of images, select [Standard].
1
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Creating One PDF File from Two
You can scan two or more pages and make them into one 
PDF file.

1. Set documents.

2. Double-click the [Canon MF Toolbox 4.9] icon 
on the Windows desktop to open the MF 
Toolbox.
You can also open the MF Toolbox by clicking [start] on the 
Windows task bar → [(All) Programs] → [Canon] → [MF Toolbox 
4.9] → [Toolbox 4.9].

3. Click [PDF].

4. Select [PDF (Multiple Pages)] in [Save as 
Type].

5. Specify other required settings.
Select the [Display the Scanner Driver] check box, to display the 
[ScanGear MF] dialog box on step 8.

6. Click [PDF Settings].
The [PDF Settings] dialog box appears.

7. Sp

[Cre
doc
with

[Tex
The
[En
dpi]
on p

[PD
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size
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ecify the required settings → click [Scan].
settings, see “Setting Preferences and Scanning with 
nGear MF,” on p. 3-18.

 continue to scan, place the next page and 
k [Next]. When scanning is completed, 
k [Finish].

en [Confirm the Scanned Image] check box is selected, the 
bnail of the scanned image is displayed. (See “Confirmation 
e Scanned Image and Exif Settings (Confirm the Scanned 
ge),” on p. 3-13.)
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8. Click [Start].
The [ScanGear MF] dialog box appears if the [Display the 
Scanner Driver] check box is selected in step 5.

When the [Display the Scanner Driver] check box is not selected 
in step 5, go to step 10.

9. Sp
For 
Sca

10.To
clic
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Wh
thum
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Ima
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ng with 

ng Simple Mode

t documents.
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Setting Preferences and Scanni
ScanGear MF

The ScanGear MF enables you to preview the image to be 
scanned and make detailed adjustments for the image. To 
use the ScanGear MF, select [Display the Scanner Driver] in 
the MF Toolbox, or scan from the application supported by 
TWAIN.

■ Switching between Simple Mode and 
Advanced Mode

The ScanGear MF has two modes: [Simple Mode] and 
[Advanced Mode]. With [Advanced Mode] you can perform 
detailed settings such as resolution and contrast.

To switch between two modes, click the corresponding tab.

■ Usi

1. Se
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lect the output size of the scanned image 
[Output Size].
 options you can select vary depending on what you selected 
tep 4.
k  to switch the orientation of the output size (landscape 
ortrait).

just the cropping frame and select the 
ding Correction] check box as needed.
djust the cropping frame, click  (Auto Crop) or drag the 
er or edge of the frame.

NOTE

 [Fading Correction] check box can be selected only when the 
r preview image is displayed.

ck [Scan].
1
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2. Select the document type in [Select Source].
[Photo (Color)]: To scan color photos.

[Magazine (Color)]: To scan color magazines (with the Descreen 
function).

[Newspaper (B&W)]: To scan text and line drawings (black and 
white).

[Document (Grayscale)]: To scan color image or text in 
monochrome. Appropriate for scanning high-resolution 
monochrome image.

NOTE

On how to turn off the automatic color correction for the 
document type other than [Newspaper (B&W)], see “[Color 
Settings] Tab,” on p. 3-37.

3. Click [Preview].
A preview of the scanned image appears in the preview window.

4. Select the use for the scanned image in 
[Select Purpose].
You can select from [Print (300dpi)], [Image display (150dpi)], or 
[OCR (300dpi)], depending on the document type you selected in 
step 2. For details, see “Determining Resolution,” on p. 3-39.

5. Se
in 
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t delete the output size that is currently selected in [Output 
e [Simple Mode] tab.

e Mode Toolbar

o Crop) Crops the image border automatically. You 
can gradually crop the image by clicking this 
button.

ove 
ping 
e)

Removes the selected cropping frames.

 Rotate) Rotates the scanned image 90 degrees left.

ht Rotate) Rotates the scanned image 90 degrees 
right.

rmation) Lists the scanning information.
1
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Add/Delete the Output Size

Selecting [Add/Delete] for [Output Size] opens the [Add/Delete 
the Output Size] dialog box. This dialog box enables you to add 
and delete the custom output size.

NOTE

You canno
Size] of th

Simpl

[Output Size 
Name]

Specifies the output size name you want to 
register.

[Width] Specifies the width of the output size.

[Height] Specifies the height of the output size.

[Unit] Selects the unit of measurement for the 
output size.

[Add] Adds the output size to the [Output Size 
List].

[Delete] Deletes the selected output size from the 
[Output Size List].

[Save] Apply the settings specified in the [Add/
Delete the Output Size] dialog box.

 (Aut

 (Rem
Crop
Fram

 (Left

 (Rig

 (Info
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lect settings for [Favorite Settings], [Input 
ttings], [Output Settings] and [Image 
ttings], and adjust the color settings.
details on the settings, see “Advanced Mode Settings,” on 
-24.

ck [Preview].

NOTE

electing the range in the preview window and clicking [Zoom] 
loads the selected image to be enlarged.
 delete the displayed preview image, click .

ou want to scan only part of the 
cument, specify the parameters.
details, see “Advanced Mode – Specifying the Parameters 
Scan,” on p. 3-23.

ck [Scan].
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■ Using Advanced Mode

1. Set documents.

2. Se
Se
Se
For 
p. 3
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5. Cli



TOP

Back Previous Next

3-22

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

rmation) Lists the scanning information.

o Crop) Crops the image border automatically.

ove 
ping 
e)

Removes the selected cropping frames.

ll Crops] When this button is used, all the cropping 
frames reflect the settings made on the 
[Advanced Mode] tab sheet.

Click this button to rescan the focal cropping 
area of the preview image at a higher level of 
magnification.
Once clicked, this button changes into 
[Undo]. The image returns to its original size 
by clicking [Undo].
1
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Advanced Mode Toolbar

(Clear) Deletes the preview image from the Preview 
Area. It also resets the toolbar settings and 
color settings.

(Crop) Specifies the parameter of a scan.

(Move) Moves the enlarged image on the screen.

(Zoom) Enlarges or reduces the preview image. 
Click on the image to zoom in, and right click 
on the image to zoom out.

(Left Rotate) Rotates the image 90 degrees left.

(Right Rotate) Rotates the image 90 degrees right.

(Info

(Aut

(Rem
Crop
Fram

[Select A

[Zoom]
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ng Multiple Cropping Frames 

create another cropping frame even if there is already 
e Preview Area. Click and drag the mouse cursor 
he existing cropping frame to create a new cropping 
that area.

reate up to 10 cropping areas. By clicking [Scan] once, 
opped areas will be scanned. (Scanning will continue 
elected areas have been scanned.)

t recently created cropping frame will become the focal 
 make adjustments to previously created cropping 
elect the frame or frames by clicking on them.
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■ Advanced Mode – Specifying the 
Parameters of a Scan

You can create scan areas (cropping areas) for images shown in 
the Preview Area. When you click [Scan], only the cropped area 
will be scanned.

Selecting the Cropping Area Automatically

After previewing, click  (Auto Crop) on the toolbar. Clicking 
this button enables you to gradually crop the image outside the 
borders detected in the preview image.

Creating a Cropping Frame

Click  (Crop) on the toolbar, click on the preview image and 
drag over the area you wish to select. To make further 
adjustments, drag the corner or edge of the selected frame or 
enter the desired parameter values for  (Width) and  
(Height) in [Input Settings]. To move the cropping frame you 
have selected, click inside the cropping frame and drag.

NOTE

To maintain the current width and height proportion of the image, click 
 in [Input Settings].

Creati

You can 
one in th
outside t
frame in 

You can c
all the cr
until all s

The mos
point. To
frames, s
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anced Mode Settings
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Deleting Cropping Frames

If you want to remove cropping frames, select the frame or 
frames and do one of the following:
– Click [DELETE] on the keyboard.
– Click  (Remove Cropping Frame) on the toolbar.
– Right click on the cropped area and select [Delete].
– Hold down [CTRL] on the keyboard, right click outside the cropped 

area, and select [Delete].

■ Adv
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Settings

 Input Selects where the document is placed.

NOTE

 can select [Platen Glass] only.

 Size] Selects the size and orientation of the 
original document.

NOTE

u change this setting after previewing, the preview image will 
eleted.

e You can specify the parameters of the scan 
by entering a value in  (Width) and  
(Height). Click  to maintain the current 
width and height proportions of the image.

NOTE

ome applications have a limit to the amount of image data 
ey can receive. If the parameters of a scan contain more than 
,000 x 30,000 pixels, the image will not be received.
hen [Output Resolution] is set to [600] dpi, minimum 
rameters of an image are 96 x 96 pixels.
1
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Favorite Settings

Favorite Settings enables you to save a set of settings (Input 
Settings, Output Settings, Image Settings and Color Settings) 
made for the focal cropping frame. If there are no cropping 
frames, settings for the whole preview area are saved.
You can also recall the saved settings and apply them to the 
selected frames or the whole preview area.

NOTE

The following items cannot be saved in Favorite Settings:
– Values of  (Width) and  (Height) in [Input Settings] and in 

[Output Settings]
– Activation of  button (maintaining the proportion of width and 

height) in [Input Settings]
– Value of [%] (Scale) in [Output Settings]

Input 

[User Defined] When this option is selected, specify a value 
for each setting.

[Default] Restores the default settings. The preview 
image will be cleared.

[Add/Delete] Opens the [Add/Delete Favorite Settings] 
dialog box. This dialog box enables you to 
name and register a set of settings for the 
current preview image. The registered name 
is listed in this dialog box.

NOTE

[Add/Delete] appears when the preview image is displayed.

[Original
Method]

You

[Original

If yo
be d

Input Siz

– S
th
21

– W
pa
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t Settings

n]
Selects the resolution for the scan. Enter a 
resolution from 25 to 9,600 dpi. For details, 
see “Determining Resolution,” on p. 3-39.

ize] Selects the output size of the scanned 
image. If you select [Add/Delete], the [Add/
Delete the Output Size] dialog box will 
appear and you can add and delete the 
custom output size. (See “Add/Delete the 
Output Size,” on p. 3-20.)
If [Flexible] is selected, enter values in  
(Width),  (Height) or [%] (Scale). The 
resolution when you actually scan will 
change in accordance with the value of [%].
The ratio of  (Width) and  (Height) is 
linked to  (Width) and  (Height) of the 
Original Size. You can enter the value for [%] 
from 25 to 38,400, but the upper limit varies 
depending on the value of [Output 
Resolution].
Click  to switch the orientation of the 
output size (landscape or portrait). This 
button is invalid when [Flexible] is selected.

e] Shows the data size of the scanned image 
according to your settings.
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Outpu[Color Mode] Selects the type of document and the way in 
which it is scanned.

[Black and White]:
To output documents to a monochrome 
printer. The contrast in the image is divided 
at certain levels (threshold values) into black 
and white and is displayed in two colors. For 
the threshold setting, see “Color Settings,” 
on p. 3-30.

[Grayscale]:
To scan black and white photos or 
monochrome images. The image is 
expressed in a 0-255 scale of black and 
white.

[Color]:
To scan color photos. The image is 
expressed in 256 levels (8 bit) of R(ed), 
G(reen) and B(lue).

[Color (Documents)]:
To scan color documents that include texts 
or charts in addition to color photos. The 
image is expressed in 256 levels (8 bit) of 
R(ed), G(reen) and B(lue).

[Text Enhanced]:
To scan texts crisply, particularly to process 
it with OCR software. The image is displayed 
in black and white.

[Output 
Resolutio

[Output S

[Data Siz
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] Select the purpose of using output ([Print] or 
[Image Display]).

ize Specifies the output size name you want to 
register.

Specifies the width of the output size

Specifies the height of the output size.

Selects the unit of measurement for the 
output size.

Adds the output size to the [Output Size 
List].

Deletes the selected output size from the 
[Output Size List].

NOTE

 cannot delete the output size that is currently selected in 
tput Size] of the [Advanced Mode] tab.

Apply the settings specified in the [Add/
Delete the Output Size] dialog box.
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● Add/Delete the Output Size

Selecting [Add/Delete] for [Output Size] opens the [Add/Delete 
the Output Size] dialog box. This dialog box enables you to add 
and delete the custom output size.

[Purpose

[Output S
Name]

[Width]

[Height]

[Unit]

[Add]

[Delete]

You
[Ou

[Save]
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n] Set to [ON] to reduce the distorted pattern 
(moiré) when scanning printed photographs 
and pictures.

NOTE

his setting is available when [Color], [Color (Documents)], or 
rayscale] is selected in [Color Mode].

ven if [Descreen] is set to [ON], some moiré effect may remain 
[Unsharp Mask] is also set to [ON]. In this case, disable 
nsharp Mask].
u cannot set [Descreen] to [ON] when scanning from an 
plication which does not display the [ScanGear MF] dialog 
x. 

 change in this setting is reflected in the next scan process.

 Dust 
tches]

Reduces the dust and scratches on photos.

[None]:
No reduction of dust and scratches will be 
made.

[Low]:
Reduces only small dust and scratch marks.

[Medium]:
Normally this setting is recommended.

[High]:
Reduces large dust and scratch marks.
This may remove delicate parts of the 
image.

NOTE

 setting is available when [Color], [Color (Documents)] or 
yscale] is selected in [Color Mode].
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Image Settings

[Auto Tone] Set to [ON] to automatically adjust the tone 
of the image. You can apply this setting 
when the preview image is displayed.

NOTE

– This setting is available when [Color], [Color (Documents)] or 
[Grayscale] is selected in [Color Mode].

– This setting is not available when [Color Correction] is set to 
[None] in the [Preferences] dialog box. (See “[Color Settings] 
Tab,” on p. 3-37.)

[Unsharp Mask] Set to [ON] to emphasize the outline of an 
image and make it sharper. It is effective for 
scanning photos etc., which have a soft 
focus.

NOTE
 

This setting is available when [Color], [Color (Documents)] or 
[Grayscale] is selected in [Color Mode].

[Descree

 

– T
[G

– E
if 
[U

– Yo
ap
bo

– A

[Reduce
and Scra

 

This
[Gra
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orrection] Smooths out the film grain of the image 
recorded on fast film. The result is smoother 
tones and higher overall quality.

[None]:
No grain correction will be made.

[Low]:
Select this setting when the grain in the 
picture is not so notable.

[Medium]:
Normally this setting is recommended.

[High]:
Smooths out even very notable grain in the 
picture. This may lower the image sharpness 
and tonal quality.

NOTE

his setting is available when [Color], [Color (Documents)], or 
rayscale] is selected in [Color Mode].

his setting is not reflected in the preview image.
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[Fading 
Correction]

Rebuilds the color quality that has faded 
over time. It also increases saturation of dull-
colored originals to reproduce a vivid image.
You can apply this setting when the preview 
image is displayed.

[None]:
No fading correction will be made.

[Low]:
Corrects slightly faded images.

[Medium]:
Normally this setting is recommended.

[High]:
Corrects highly faded images. This may 
change the tone of the image.

NOTE

This setting is available when [Color] or [Color (Documents)] is 
selected in [Color Mode], and [Color Correction] is set to 
[Recommended] in the [Preferences] dialog box. (See “[Color 
Settings] Tab,” on p. 3-37.)

[Grain C

 

– T
[G

– T
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ness/Contrast 

g box enables you to adjust the levels of brightness 
rast of the image.
 to adjust the brightness and contrast 
atically.
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Color Settings

Using Color Settings buttons, you can adjust the brightness and 
contrast of the whole image, specify highlights and shadows, 
and adjust the contrast and balance in an image.

The Color Settings buttons are displayed when [Color], [Color 
(Documents)], or [Grayscale] is selected in [Color Mode]. When 
[Black and White] is selected, the Threshold button is displayed 
instead of the Color Settings buttons.

When [Color], [Color (Documents)], or [Grayscale] is selected in 
[Color Mode]:

When [Black and White] is selected in [Color Mode]:

By selecting [Add/Delete] from the drop-down list, you can name 
and save a set of color or threshold settings. For details, see 
“Tone Curve/Threshold Drop-Down List,” on p. 3-35.

Clicking a button opens the dialog box for each color setting.
If [Reset] is clicked, all color adjustment settings will be reset to 
the default values.

● Bright

This dialo
and cont
Click 
diagramm
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gram 

g box enables you to see the data concentration at 
htness level in an image. You can specify the darkest 
test levels within an image, cut the levels and expand 

le of the tonal range of the image.
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●  Histo

This dialo
each brig
and brigh
the midd

[Channel] Select a color to adjust either [Red], [Green], 
or [Blue], or select [Master] to adjust three 
colors together when [Color] or [Color 
(Documents)] is selected in [Color Mode].
Adjust the elements of grayscale when 
[Grayscale] is selected in [Color Mode].

[Brightness] Adjust the brightness of the image by 
moving the slider  or entering values 
(–127 to 127).

[Contrast] Adjust the contrast of the image by moving 
the slider  or entering values (–127 to 
127).

[Reset] Resets all the current settings to their default 
values.



TOP

Back Previous Next

3-32

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

te-point 
opper 

Click this button, then click a point inside the 
focal crop in the preview image to specify the 
highlighted point. You can also enter a value 
(10 to 255) or move the slider  to an 
appropriate level.

 Balance 
opper 

When adjusting a color image, click this 
button, then click a point in the preview 
image (or inside the focal crop) to specify the 
point to execute gray balance adjustment.
The gray elements within a scanned image 
will appear as a neutral gray, and other 
elements within the image will also have true 
color reproduction.

Resets all the current settings to their default 
values.
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[Channel] Select a color to adjust either [Red], [Green], 
or [Blue], or select [Master] to adjust the 
three colors together when [Color] or [Color 
(Documents)] is selected in [Color Mode].
Adjust the elements of grayscale when 
[Grayscale] is selected in [Color Mode].

 (Black-point 
eyedropper 
tool)

Click this button, then click a point inside the 
focal crop in the preview image to specify the 
darkest point. You can also enter a value (0 
to 245) or move the slider  to an 
appropriate level.

 (Mid-point 
eyedropper 
tool)

Click this button, then click a point inside the 
focal crop in the preview image to specify the 
midtone point. You can also enter a value (5 
to 250) or move the slider  to an 
appropriate level.

 (Whi
eyedr
tool)

 (Gray
eyedr
tool)

[Reset]
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l] Select a color to adjust either [Red], [Green], 
or [Blue], or select [Master] to adjust three 
colors together when [Color] or [Color 
(Documents)] is selected in [Color Mode].
Adjust the elements of grayscale when 
[Grayscale] is selected in [Color Mode].

one Select the tone curve from [No Correction], 
[Over Exposure], [Under Exposure], [High 
Contrast], or [Invert the Negative/Positive 
Image].

Resets all the current settings to their default 
values.
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● Tone Curve Settings 

This dialog box enables you to adjust the brightness of a specific 
area of an image by selecting the type of the tone curve. The 
tone curve is a graph showing the balance of tone input and 
output.

[Channe

[Select T
Curve]

[Reset]
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old 

g box enables you to adjust the threshold. By adjusting 
hold, you can sharpen characters in a text document 
ce back-printing such as in newspapers.

ld Level] Adjust the threshold by moving the slider  
or entering a value (0 to 255).
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● Final Review 

This dialog box enables you to confirm the color settings.

● Thresh

This dialo
the thres
and redu

[Thresho
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rences] Dialog Box

Preferences] on the [Advanced Mode] tab sheet opens 
erences] dialog box. This dialog box enables you to 
ttings for scanning and previewing.

ew] Tab
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● Tone Curve/Threshold Drop-Down List

This drop-down list enables you to save a set of Color Settings 
made for the focal cropping frame. If there are no cropping 
frames, settings for the whole preview area are saved.
You can also recall the saved settings and apply them to the 
selected frames or the whole preview area.

[Prefe

Clicking [
the [Pref
adjust se

● [Previ

[Reset] Resets the current setting to the default 
value.

NOTE
 

The brightness of color and grayscale images are expressed as a 
value from 0 to 255, but the brightness of black and white images 
is expressed in terms of either black or white, including the parts 
of an image which are a color between the two. The boundary at 
which black and white is divided is called “threshold”.

[Custom] When this option is selected, specify a value 
for each Color Settings item. Even after the 
registered settings are applied, [Custom] 
resumes automatically if you change any 
setting or make adjustments to the selected 
cropping frame.

[Add/Delete] Opens the [Add/Delete Tone Curve Settings] 
dialog box ([Add/Delete Threshold Settings] 
dialog box, when [Black and White] is 
selected in [Color Mode]). This dialog box 
enables you to name and register a set of 
Color Settings.
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 Tab

thout 
anGear’s 

Enables you to scan in a specific color mode 
when using an application that will not 
display the [ScanGear MF] dialog box (such 
as OCR software), overriding the application 
settings.

[Color Mode (Text and Table)]:
The document is scanned in [Color 
(Documents)] mode regardless of the 
application settings.

[Text Enhanced]:
The document is scanned in [Text 
Enhanced] mode regardless of the 
application settings.
1
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● [Scan]
[Preview at the
Start of ScanGear]

Selects the preview operation when you 
open the ScanGear MF.

[Automatically Execute Preview]:
The preview scan starts automatically when 
you open the ScanGear MF.

[Display Saved Preview Image]:
Displays the image last previewed.

[None]:
Nothing is displayed.

[Cropping Frame 
on Previewed 
Images]

Sets how the cropping frame is displayed 
when you preview images.

[Execute Auto Cropping on Previewed 
Images]:
The image will be automatically cropped to 
match the document size.

[Display the Last Frame on Previewed 
Images]:
Displays the last frame.

[None]:
No frame will be displayed.

[Scan wi
Using Sc
Window]
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 Settings] Tab

orrection] Selects the type of color correction.

[Recommended]:
Vividly reproduces the tone of a document 
on the screen.
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● [Color
[Automatically 
Quit ScanGear 
after Scanning]

If selected, the [ScanGear MF] dialog box 
quits automatically after the image is 
scanned. Some applications will 
automatically quit ScanGear MF after 
scanning irrespective of this setting.

[Color C
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er] Tab

older 
emporary 
 Saved]

Click [Browse] and specify the folder in 
which the temporary files are saved.
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● [Scann
[Color Matching]:
Select to automatically match the scanner, 
monitor and color printer colors. If selected, 
the Color Settings buttons are invalid in the 
[Advanced Mode] tab sheet. This setting is 
available when [Color] or [Color 
(Documents)] is selected in [Color Mode].

[None]:
No color matching is made. This setting is 
available when [Color], [Color (Documents)], 
or [Grayscale] is selected in [Color Mode].

[Always Execute 
the Auto Tone]

If selected, the image color will always be 
automatically corrected. This setting is 
available when [Color], [Color (Documents)], 
or [Grayscale] is selected in [Color Mode].

[Monitor Gamma] Enables you to perform gamma correction. 
Specify the gamma value (0.10 to 10.00) of 
the monitor for viewing the scanned image.

NOTE

[Monitor Gamma] value will be fixed to 1.80 when [Color 
Matching] is selected in [Color Correction].

[Select F
Where T
Files are
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ermining Resolution
 in the image you scan is a collection of dots carrying 
on about brightness and color. The density of these 
lled “resolution,” and “dpi” (dots per inch) refers to the 
f dots in one inch.

specify a resolution in [Image Quality] in the MF 
ettings dialog box, or in [Output Resolution] in the 
r MF.

s for Display on a Monitor

or display on a monitor in general should be scanned at 
ion of 75 dpi.

s for Printing

o be printed should be scanned at a resolution which 
nds to the resolution of the printer.
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■ Det
The data
informati
dots is ca
number o
You can 
Toolbox s
ScanGea

● Image

Images f
a resolut

● Image

Images t
correspo

[Sound Settings] Sets the scanner to play music during 
scanning or play a sound when scanning is 
completed.

[Play Music During Scanning]:
If selected, the scanner plays music during 
scanning. Click [Browse], then specify a 
sound file.

[Play Sound When Scanning is Completed]:
If selected, the scanner plays sound when 
scanning is completed. Click [Browse], then 
specify a sound file.

You can specify the following files: MIDI files 
(∗.mid, ∗.rmi, ∗.midi), Audio files (∗.wav, ∗.aiff, 
∗.aif), MP3 file (∗.mp3).

[Test Scanner] Click this button, then click [Start] to check if 
the power cord is plugged in, or the USB 
cable is connected between the machine 
and your computer.
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● Printing Scale

For example, if you want to print a document which is twice the 
original size both vertically and horizontally, the resolution of 
your document will be reduced by half. In such a case, scan the 
original document at double the resolution so that you can print 
the document with sufficient quality, even if you double the size 
of the document. Conversely, if you want to print a document at 
a reduced size, it should be sufficient to scan at half the 
resolution.

● Resolution and Data Size

If you double the resolution, the image data will be four times 
greater. If the data is too large, processing speed will slow down 
significantly, and you may experience malfunctions such as lack 
of memory. Make sure the resolution corresponds to the 
purpose of use of the image and set at the lowest level possible.
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indows XP Only)

lect a picture type.

 can select from [Color picture], [Grayscale picture], [Black 
 white picture or text], and [Custom].
1

2

3

4

5

6

ntents

n

a 

oting

Scanning with the WIA Driver (W

■ Scanning from the [Scanner and 
Camera Wizard] Dialog Box

1. Open the [Scanners and Cameras] folder.
Click [start] on the Windows task bar → select [Control Panel] → 
[Printers and Other Hardware] → [Scanners and Cameras].

2. Double-click the corresponding WIA driver 
icon.

3. Click [Next >].

4. Se

You
and
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ecify a name, a file format, and the location 
 saving the group of pictures.

NOTE

hen you save more than one picture in the same location, 
quential numbers are automatically added at the ends of file 

ames.
u can select a file format from [BMP (Bitmap Image)], [JPG 
PEG Image)], [TIF (TIF Image)], and [PNG (PNG Image)].
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When selecting [Custom], click [Custom settings] to make 
detailed settings in the [Properties] dialog box.
For details on the settings, see “Advanced Properties,” on 
p. 3-45.

5. Specify the scanned area.
Click [Preview] → drag  to specify the scanned area.

6. Click [Next >].

7. Sp
for

– W
se
n

– Yo
(J
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ck [Next >].

u want to publish these pictures to a Web site or order 
touts online, select the corresponding option.

ck [Finish].
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8. Click [Next >] to start scanning. 9. Cli

If yo
prin

10.Cli
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ecessary, click [Adjust the quality of the 
nned picture].

 [Advanced Properties] dialog box appears.

just the quality of the image → click [OK].
details on the settings, see “Advanced Properties,” on 
-45.

ecify the scanned area.
k [Preview] → drag  to specify the scanned area.

ck [Scan].
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■ Scanning from an Application
With the WIA driver dialog box open, follow the procedure 
below. On how to display the WIA driver, see “Scanning an 
Image from an Application,” on p. 3-15.

1. Select the picture type.
You can select from [Color picture], [Grayscale picture], [Black 
and white picture or text], and [Custom Settings].

2. If n
sca
The

3. Ad
For 
p. 3

4. Sp
Clic

5. Cli
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g items and default values in the [Advanced Properties] tab 
nding on the type of picture you select.

nce Shows the preview of sample image.

ss] Specifies the brightness (–127 to 127).

t] Specifies the contrast (–127 to 127) (only for 
color or grayscale scanning).

ion (DPI)] Selects the scanning resolution in dot per 
inch (50 to 600).

type] Selects the scanning color type ([Color 
picture], [Grayscale picture], or [Black and 
white picture or text]).

Resets all the current settings to their default 
values.
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Advanced Properties

NOTE

The settin
vary depe

Appeara

[Brightne

[Contras

[Resolut

[Picture 

[Reset]
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................................................. 4-3

bols for Fax Numbers............. 4-4

s.............................................. 4-4

............................................... 4-14

plication ................................ 4-14

nd Faxes] 
00: [Printers]) Folder ............. 4-15

............................................... 4-16

AX Printing Preferences .... 4-27

............................................... 4-27

nces ..................................... 4-31
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4 PC Faxing (MF3240 Only)

Sending a Fax .........................................

Characters and Sym

Fax Sending Setting

Changing Fax Settings...........................

From a Windows Ap

From the [Printers a
(Windows 98/Me/20

Windows 98/Me Fax Properties .............

Windows 2000/XP FAX Properties and F

FAX Properties ......

FAX Printing Prefere
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............................................... 4-41

talling Cover Sheet Editor...... 4-42

d Closing a File .................... 4-45

l Cover Sheet......................... 4-47

eet ......................................... 4-68

al Cover Sheet as a Template ... 4-68
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Canon Cover Sheet Editor .....................

Installing and Unins

Opening, Saving, an

Creating an Origina

Printing a Cover Sh

Registering an Origin
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the [Fax Sending Settings] dialog box, 
ter the [Recipient Name] and [Fax 
mber], or select them from the Address 
ok → click [Add to Recipient List] or [Add 
List].
details on how to use the [Fax Sending Settings] dialog box, 
 “Fax Sending Settings,” on p. 4-4.
details on the characters and symbols you can use for fax 
bers, see “Characters and Symbols for Fax Numbers,” on 

-4.
details on how to select a recipient from the Address Book, 
 “Select Recipient from Address Book,” on p. 4-6.

NOTE

u cannot send a fax without entering the [Recipient Name].
p to 85 characters can be entered in the [Recipient Name] 
dit box.
p to 45 characters (up to 38 characters excluding hyphens “-”) 
n be entered in the [Fax Number] edit box.
 select the [Recipient Name] and [Fax Number] from the 

ddress Book, you must register them in the Address Book 
st. For details, see “Edit Address Book Tab,” on p. 4-32.
u can register the recipient and his/her fax number in the 

ddress Book so that you can use it in the future. Click [Add to 
ddress Book] after entering the recipient name and fax 
mber in the [Fax Sending Settings] dialog box. You can enter 

dditional information, such as the company name and 
epartment, etc., in the [Edit Address Book] tab. (See “Edit 
ddress Book Tab,” on p. 4-32.)

ck [OK].
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Sending a Fax

You can send a fax to multiple recipients in one operation. 

NOTE

– You cannot send a fax when an error occurs in the machine.
– A very large document may not be sent.
– You can send up to 256 pages per fax (Based on ITU-T No. 1 Chart, 

Standard Mode.). A document of 257 pages or more needs to be 
sent in separate faxes.

– Your machine must be connected via USB and the USB printer driver 
loaded to fax from your computer. This machine does not support 
network faxing.

1. Open the document you want to fax in an 
application → select the command to print.
In most cases, click [Print] from the [File] menu.
The [Print] dialog box appears.

2. From the [Select Printer] list box or the 
[Name] drop-down list in the [Print] dialog 
box, select [Canon MF3200 Series (FAX)].

3. Click [Print] or [OK].
The [Fax Sending Settings] dialog box appears.

4. In 
en
Nu
Bo
to 
For 
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 Sending Settings
lect the command to print from an application, the [Fax 
Settings] dialog box appears. The [Fax Sending 
 dialog box has three tab sheets.

e information about the following features, see the online help 
nline Help,” on p. 1-2.)
een shots shown are from Windows XP.
1

2
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■ Characters and Symbols for Fax 
Numbers

You can use the following characters and symbols in the fax 
numbers you send from your computer or for a recipient you 
register in the Address Book.

■ Fax
If you se
Sending 
Settings]

NOTE

– For mor
(See “O

– The scr
Character/symbol Explanation

0-9 * # For use in telephone and fax numbers.

P/p To place a pause in numbers.

R PSTN/PBX switchover function.

+ - (), To make the number easier to read.
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ber] Specifies the fax/telephone number of the 
recipient.
For details on the characters and symbols 
you can use for fax numbers, see “Characters 
and Symbols for Fax Numbers,” on p. 4-4.

 Book]
Adds the recipient name and the fax number 
you entered in [Recipient Name] and [Fax 
Number] to the Address Book.

t List]
Adds the recipient name and the fax number 
you entered in [Recipient Name] and [Fax 
Number] to the [Recipient List].

t List] Shows the list of the recipient names and fax 
numbers of the destinations you are going to 
send a fax.

 Book] Opens the [Select Recipient from Address 
Book] dialog box. (See “Select Recipient from 
Address Book,” on p. 4-6.)

Deletes destination(s) from the [Recipient 
List]. Select the destination(s) you want to 
delete from the list and click [Delete].

 of 
ts]

Display the number of recipients added to the 
[Recipients List].
1

2

3

4
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Sending Settings Tab

Specifies the recipient name and fax number of the destination 
to which you send a fax. You can specify multiple destinations in 
one operation.

[Recipient Name] Specifies the recipient’s name.

[Fax Num

[Add to 
Address

[Add to 
Recipien

[Recipien

[Address

[Delete]

[Number
Recipien
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 List] Displays the list of the destinations registered 
in the Address Book. The entries can be 
sorted by their information ([Recipient Name], 
[Company], [Dept./Div.], [Fax Number], and 
[Description]).

by 
t]

Searches the destination by the recipient 
name.

Displays the information about the selected 
destination in the [Address List].

ist] Adds the recipient names and fax numbers 
you selected in the [Address List].

t List] Shows the list of the recipient names and fax 
numbers of the destinations you are going to 
send a fax.

 of 
ts]

Display the number of recipients added to the 
[Recipient List].

 from Deletes destination(s) from the [Recipient 
List]. Select the destination(s) you want to 
delete from the list and click [Remove from 
List].
1

2

3

4

5

6
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Select Recipient from Address Book

[Address Books] Shows the available address books.

NOTE

Address books might not be shown in the cases below.
– There are no address book files.
– The address book file is a read-only file.
– The user is not authorized to write in the address book.

[Address

[Search 
Recipien

[Details]

[Add to L

[Recipien

[Number
Recipien

[Remove
List]



TOP

Back Previous Next

4-7

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

 Sheet Tab

 the cover sheet to be attached to the document you 

reate your original cover sheets using the Canon Cover Sheet 
r details, see “Canon Cover Sheet Editor,” on p. 4-41.
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3
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Edit Address Book Tab

Allows you to edit the Address Book. For details, see “Edit 
Address Book Tab,” on p. 4-32.

Cover

Specifies
fax.

NOTE

You can c
Editor. Fo
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ettings

 Settings] dialog box allows you to set the details of the 
be included in the cover sheets. The [Item Settings] 
x has the following five tab sheets.

r Tab

der] tab sheet enables you to edit the sender 
on to be included in the cover sheets.
1

2

3

4
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Item S

The [Item
items to 
dialog bo

● Sende

The [Sen
informati

[Cover Sheet
Attachment]

Specifies if the cover sheet is attached 
or not ([None], [Different Sheet to 
Each Recipient], or [Same Sheet to All 
Recipients]).

[Style] Selects the style of the cover sheet 
from the list of the cover sheet 
templates supplied with the fax driver, 
or the cover sheets you registered in 
the [Register Cover Sheet] dialog box 
(See “Register Cover Sheet Tab,” on 
p. 4-23 for Windows 98/Me and on 
p. 4-37 for Windows 2000/XP).

[Items to Include] Displays the items to be included in 
the cover sheet.

[Settings] Opens the [Item Settings] dialog box. 
(See “Item Settings,” on p. 4-8.)

[Insert Attention Note] Prints the attention label specified in 
the [Attention Note] drop-down list, to 
the cover sheet ([Urgent], [Very 
Urgent], [FYI], or [Confidential]).

[Comment to Include] Allows you to enter the comment to be 
included in the cover sheet.

[Preview] Displays the preview image of the 
cover sheet.
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ent Tab

 to include the display of Recipient information 
 in the Address Book on the cover sheet.
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3
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● Recipi

Specifies
specified

[Include Sender 
Name]

Enables you to enter the sender name 
in [Sender Name] text box up to 85 
characters.

[Include Company] Enables you to enter the company 
name in the [Company] text box up to 
40 characters.

[Include Dept./Div.] Enables you to enter the department or 
division name of the sender in the 
[Dept./Div.] text box up to 40 
characters. 

[Include Fax Number] Enables you to enter the fax number in 
the [Fax Number] text box up to 45 
characters (up to 38 characters 
excluding hyphens “-”).

[Import Sender] Imports sender information from a 
CSV file.

[Save Sender] Saves sender information in a CSV file.
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ab

o] tab sheet enables you to select whether the logo is 
 to the cover sheet, and sets how the logo is attached.
1

2

3

4
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6
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● Logo T

The [Log
attached

[Include Recipient 
Name]

Enters the recipient name.

[Include Company] Enters the recipient’s company name.

[Include Dept./Div.] Enters the recipient’s department or 
division name.

[Include Fax Number] Enters the recipient’s fax number. For 
details on the characters and symbols 
you can use for fax numbers, see 
“Characters and Symbols for Fax 
Numbers,” on p. 4-4.
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ure Tab

ature] tab sheet enables you to select whether the 
 is attached to the cover sheet, and sets how the 
 is attached.
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● Signat

The [Sign
signature
signature

[Print with Logo] Attaches the logo to the cover sheet.

[File Name] Selects the data file of the logo to be 
attached to the cover sheet. You can 
select a bitmap data only.

[Browse] Allows you to search for the logo file in 
your computer.

[Manual Scaling] Enables you to specify the size of the 
logo in [Scaling] from 50% to 200%.

[Position] Specifies the vertical and horizontal 
position where the logo is printed. You 
can enter the values in the [X] and [Y] edit 
boxes (in a range from –50 to 50), or use 
the X and Y slide bars to move the 
position.

[Move to Center] Relocates the logo to the center of the 
page.
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 to Send Tab

ets to Send] tab sheet enables you to select whether 
er of sheets to send is included in the cover sheet, and 
umber of sheets to be included in the cover sheet.
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● Sheets

The [She
the numb
edit the n

[Print with Signature] Attaches the signature to the cover sheet.

[File Name] Selects the data file of the signature to be 
attached to the cover sheet. You can 
select a bitmap data only.

[Browse] Allows you to search for the signature file 
in your computer.

[Manual Scaling] Enables you to specify the size of the 
signature in [Scaling] from 50% to 200%.

[Position] Specifies the vertical and horizontal 
position where the signature is printed. 
You can enter the values in the [X] and [Y] 
edit boxes (in a range from –50 to 50), or 
use the X and Y slide bars to move the 
position.

[Move to Center] Relocates the signature to the center of 
the page.
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[Include Number of 
Sheets to Send]

Enables you to specify the number of 
sheets in the [Number of Sheets to Send] 
text box up to maximum of 9999.

NOTE

Number of sheet to send is not counted automatically. The 
number you entered will be printed on the cover page.
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m a Windows Application

g the Canon MF3200 Series (FAX) Printing Preferences 
n MF3200 Series (FAX) Properties Dialog Box

en the application from which you will fax 
 document.

lect the command to print.
ost cases, click [Print] from the [File] menu.
 [Print] dialog box appears.

m the [Select Printer] list box or the 
me] drop-down list in the [Print] dialog 

x, select the fax to be used.

ck [Preferences] or [Properties].
 [Canon MF3200 Series (FAX) Printing Preferences] or 
non MF3200 Series (FAX) Properties] dialog box appears.

NOTE

ending on the application you are using, select the printer to 
sed in the [General] tab sheet in the [Print] dialog box, then 

cify the print settings in the corresponding tab sheet. (Only for 
dows 2000.)
1
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Changing Fax Settings
If you want to view or change the fax options, access the 
fax properties or fax printing preferences dialog box of the 
fax driver. 
You can access the fax properties dialog box either from 
the application’s [Print] dialog box or the [Printers and 
Faxes] (Windows 98/Me/2000: [Printers]) folder.
You can also access the fax printing preferences dialog box 
(only for Windows 2000/XP)  either from the application’s 
[Print] dialog box or the [Printers and Faxes] (Windows 
2000: [Printers]) folder.
To access the dialog box, follow this procedure below.

NOTE

– If you open the fax properties dialog box from the [Printers and 
Faxes] (Windows 98/Me/2000: [Printers]) folder, you can set up the 
fax configuration and configure the fax settings for all Windows 
applications. The fax printing preferences dialog box enables you to 
specify the default settings for the faxing options available when you 
fax with the Canon MF3200 Series (only for Windows 2000/XP).

– The number of tabs displayed in the properties dialog box will vary, 
depending on the type of operating system you are using and the 
method you use to access the dialog box.

– The method you use to access the dialog boxes determines how long 
the faxing options remain in effect:
If you access the dialog box from an application’s [Print] dialog box, 
your selected faxing options apply to the fax jobs sent from the 
application. They will not be stored when you close the application.
If you access the dialog box from the [Printers and Faxes] (Windows 
98/Me/2000: [Printers]) folder, selected faxing options apply to all 
Windows applications and remain in effect until you change those 
settings.

■ Fro

Openin
or Cano

1. Op
the

2. Se
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ng the Canon MF3200 Series (FAX) Printing 
ences Dialog Box (Windows 2000/XP Only)

en the [Printers and Faxes] (Windows 
0: [Printers]) folder.

k [start] on the Windows task bar → select [Printers and 
es] (Windows 2000: [Start] → [Settings] → [Printers]).

ck the corresponding printer driver icon.

m the [File] menu, click [Printing 
ferences].

 can also open the [Canon MF3200 Series (FAX) Printing 
ferences] dialog box by right clicking the corresponding 
ter driver icon and selecting [Printing Preferences] from the 
-up menu.
 [Canon MF3200 Series (FAX) Printing Preferences] dialog 
 appears.
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■ From the [Printers and Faxes] 
(Windows 98/Me/2000: [Printers]) Folder

Opening the Canon MF3200 Series (FAX) 
Properties Dialog Box

1. Open the [Printers and Faxes] (Windows 98/
Me/2000: [Printers]) folder.
Click [start] on the Windows task bar → select [Printers and 
Faxes] (Windows 98/Me/2000: [Start] → [Settings] → [Printers]).

2. Click the corresponding printer driver icon.

3. From the [File] menu, click [Properties].
You can also open the [Canon MF3200 Series (FAX) Properties] 
dialog box by right clicking the corresponding printer driver icon 
and selecting [Properties] from the pop-up menu. 
The [Canon MF3200 Series (FAX) Properties] dialog box 
appears. 

Openi
Prefer

1. Op
200
Clic
Fax

2. Cli

3. Fro
Pre
You
Pre
prin
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The
box
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s Tab

 the printer port and timeout settings. Refer to your 
 operating system documentation for more information.
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Windows 98/Me Fax Properties

General Tab

Lets you print a test page or define separator pages. Refer to 
your Windows operating system documentation for more 
information.

Detail

Specifies
Windows
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g Tab

 the printer sharing settings. This tab sheet is available 
n the printer sharing is enabled. (See “Using the 
 on Your Network,” on p. 2-52.) Refer to your Windows 
 system documentation for more information.
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Spool Settings

The installer sets the following defaults.

Sharin

Specifies
only whe
Machine
operating
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son] Opens the [Add Person] dialog box. (See 
“Add Person,” on p. 4-19.)

up] Opens the [Add Group] dialog box. (See 
“Add Group,” on p. 4-20.)

Edits the selected entry in the Address Book 
list. If you select a person, the [Edit Person] 
dialog box appears (See “Edit Person,” on 
p. 4-21.). If you select a group, the [Edit 
Group] dialog box appears (See “Edit 
Group,” on p. 4-22.).

Deletes the selected entry from the Address 
Book.

Displays the information about the selected 
destination in the [Address Book].

a Folder] Opens the [Browse for Folder] dialog box. 
Enables you to make changes to the 
Address book folder.

Enables you to import address book data 
from files. Importable file types are: some 
CSV files (with file extension “*.csv”) and 
some Canon Data Files (with file extension 
“*.abk”).

Exports the address book data to an outside 
file. You can select the exported file type 
from a CSV file (with file extension “*.csv”) or 
a Canon Data File (with file extension 
“*.abk”).
1
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3
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Edit Address Book Tab

Lets you edit the address book.

[Show] Selects the category of the list displayed in 
[Address Book] from the drop-down list 
([Person], [Group], or [All]).

[Address Book] Displays the list of the destinations 
registered in the Address Book. The entries 
can be sorted by their information ([Recipient 
Name], [Company], [Dept./Div.], [Fax 
Number], and [Description]).

[Add Per

[Add Gro

[Edit]

[Delete]

[Details]

[Specify 

[Import]

[Export]
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register the following information:

Enters the prefix to the recipient’s name, or 
selects the prefix from the drop-down list 
([Dr.], [Mr.], [Mrs.], or [Ms.]).

Enters the recipient’s first name.

Enters the recipient’s last name.

Enters the suffix to the recipient’s name, or 
selects the suffix from the drop-down list 
([Jr.], [MD], or [Sr.]).

t Name] Enters the recipient name.

y] Enters the recipient’s company name.

iv.] Enters the recipient’s department or division 
name.

ber] Enters the recipient’s fax number. You can 
enter two numbers and descriptions.

Enters the additional information about the 
recipient.

NOTE

When you press [OK] without entering the recipient name in 
the [Recipient Name], the [Prefix], [First], [Last], and [Suffix] 
are automatically applied to the [Recipient Name] and 
displayed on the cover sheet.
If names in the [Recipient Name] and the [Prefix], [First], 
[Last], and [Suffix] are different, the name in the [Recipient 
Name] is displayed on the cover sheet.
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Add Person

The [Add Person] dialog box enables you to register a person 
and his/her information in the Address Book.

You can 

[Prefix]

[First]

[Last]

[Suffix]

[Recipien

[Compan

[Dept./D

[Fax Num

[Notes]
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register the following information:

ame] Enters the group name.

Selects the category of the list displayed in 
[Available Recipients] from the drop-down 
list ([Person], [Group], or [All]).

e 
ts]

Displays the list of recipients already 
registered in the Address Books.

Adds a person/group to the group.

Deletes a person/group from the group.

Group 
s]

Displays the members currently registered in 
the group.

Enters the additional information about the 
group.
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Add Group

The [Add Group] dialog box enables you to register a group and 
its information in the Address Book.

You can 

[Group N

[Show]

[Availabl
Recipien

[Add]

[Delete]

[Current 
Member

[Notes]
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edit the following information:

Enters the prefix to the recipient’s name, or 
selects the prefix from the drop-down list 
([Dr.], [Mr.], [Mrs.], or [Ms.]).

Enters the recipient’s first name.

Enters the recipient’s last name.

Enters the suffix to the recipient’s name, or 
selects the suffix from the drop-down list 
([Jr.], [MD], or [Sr.]).

t Name] Enters the recipient name.

y] Enters the recipient’s company name.

iv.] Enters the recipient’s department or division 
name.

ber] Enters the recipient’s fax number. You can 
enter two numbers and descriptions.

Enters the additional information about the 
recipient.

NOTE

When you press [OK] without entering the recipient name in 
the [Recipient Name], the [Prefix], [First], [Last], and [Suffix] 
are automatically applied to the [Recipient Name] and 
displayed on the cover sheet.
If names in the [Recipient Name] and the [Prefix], [First], 
[Last], and [Suffix] are different, the name in the [Recipient 
Name] is displayed on the cover sheet. 
1
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Edit Person

The [Edit Person] dialog box enables you to edit a person and 
his/her information in the Address Book.

You can 

[Prefix]

[First]

[Last]

[Suffix]

[Recipien

[Compan

[Dept./D

[Fax Num

[Notes]
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edit the following information:

ame] Enters the group name.

Selects the category of the list displayed in 
[Available Recipients] from the drop-down 
list ([Person], [Group], or [All]).

e 
ts]

Displays the list of recipients already 
registered in the Address Books.

Adds a person/group to the group.

Deletes a person/group from the group.

Group 
s]

Displays the members currently registered in 
the group.

Enters the additional information about the 
group.
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Edit Group

The [Edit Group] dialog box enables you to edit a group and its 
information in the Address Book.

You can 

[Group N

[Show]

[Availabl
Recipien

[Add]

[Delete]

[Current 
Member

[Notes]
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image Displays the image with the currently 
selected settings reflected.

Displays the list of the registered cover 
sheets.

] Displays the preview image of the selected 
cover sheet.

r] Registers the cover sheet template.

Deletes the registered cover sheet template. 
Select a cover sheet template from [Style], 
then press [Delete].

NOTE

You cannot delete a pre-defined cover sheet template.
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Register Cover Sheet Tab

Registers/deletes the cover sheets to be attached to the 
document you fax.

NOTE

You can create your original cover sheets using the Canon Cover Sheet 
Editor. For details, see “Canon Cover Sheet Editor,” on p. 4-41.

Preview 

[Style]

[Preview

[Registe

[Delete]
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image Displays the image with the currently 
selected settings reflected.

ze] Selects the original page size to work with in 
an application ([Letter], [Legal], [A4], or [A5]).

ion] Selects the direction of printing relative to the 
paper ([Portrait] or [Landscape]).

Outside 
refix]

Enables you to enter the prefix number in 
[Outside Dialing Prefix] up to 5 digits.

 Books] Opens the [Address Books] dialog box. (See 
“Address Books,” on p. 4-25.)

 Defaults] Resets all the current settings to their default 
values.
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Special Tab

Specifies the page settings including the paper size and 
orientation.
You can also specify the outside dialing prefix if you dial through 
a switchboard.

Preview 

[Page Si

[Orientat

[Specify 
Dialing P

[Address

[Restore
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ter Address Book

g box enables you to register the Address Books to be 
n you send a fax.

e Address Displays the list of the available Address 
Books.
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Address Books

Clicking [Address Books] in the [Special] tab sheet opens the 
[Address Books] dialog box. This dialog box enables you to 
specify an Address Book to be referred to when sending a fax.

Regis

This dialo
used whe

[Address Book 
List]

Displays the list of the registered Address 
Books.

[Register] Opens the [Register Address Book] dialog 
box (See “Register Address Book,” on 
p. 4-25.)

[Edit] Opens the [Add/Edit Canon Fax Driver 
Address Book] dialog box (See “Add/Edit 
Canon Fax Driver Address Book,” on 
p. 4-26.)

[Delete] Deletes the selected Address Book from the 
[Address Book List].

NOTE

You cannot delete the [Canon Fax Driver Address Book] .

[Availabl
Books]
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uration Tab

Displays the version information on the 
driver. 
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2

3

4

5

6

ntents

n

a 

oting

Add/Edit Canon Fax Driver Address Book

This dialog box enables you to edit the properties of the Address 
Books to be used when you send a fax.

Config

[Name] Changes the name of the Address Book. You 
can enter up to 64 characters.

[About]
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s and FAX 

 Properties
on MF3200 Series (FAX) Properties] dialog box 
several tab sheets that enable you to set up the fax 
tion and configure the fax settings.

ber of tabs displayed in the properties dialog box depends 
you have your system set up. 
e information about the following features, see the online 
ee “Online Help,” on p. 1-2.)
een shots shown are from Windows XP. 
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Windows 2000/XP FAX Propertie
Printing Preferences

The FAX driver for Windows 2000/XP has the following two 
main dialog boxes:

The FAX Properties Dialog Box

This dialog box enables you to set up the fax configuration and 
configure the fax settings for all Windows applications.

The FAX Printing Preferences Dialog Box

This dialog box enables you to edit the address book, register 
the cover sheets, and set up the page settings.

■ FAX
The [Can
contains 
configura

NOTE

– The num
on how 

– For mor
help. (S

– The scr
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g Tab

 the printer sharing settings. Refer to your Windows 
 system documentation for more information.
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General Tab

Lets you print a test page and define faxing preferences. Refer 
to your Windows operating system documentation for more 
information.

Sharin

Specifies
operating
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ced Tab

 the settings for print spooling. Refer to your Windows 
 system documentation for more information.

nt documents so program finishes printing faster] and [Start 
mediately] are set automatically when you install the printer 
1

2

3

4

5

6

ntents

n
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oting

Ports Tab

Specifies the port to which the printer is attached. Refer to your 
Windows operating system documentation for more information.

Advan

Specifies
operating

NOTE

[Spool pri
printing im
driver.
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ity Tab

 security settings. Refer to your operating system 
tation for more information.
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Color Management Tab

Associates color profiles with your color printer. Refer to your 
Windows operating system documentation for more information.

Secur

Specifies
documen
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 Printing Preferences
on MF3200 Series (FAX) Printing Preferences] dialog 

ains three tab sheets that enable you to edit the 
book, register the cover sheets, and set up the page 

ccess the equivalent dialog box from an application's [Print] 
ox, your selected faxing options apply only to the current fax 

e information about the following features, see the online 
ee “Online Help,” on p. 1-2.)
een shots shown are from Windows XP.
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2

3

4

5
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Configuration Tab ■ FAX
The [Can
box cont
address 
settings.

NOTE

– If you a
dialog b
job.

– For mor
help. (S

– The scr

[About] Displays the version information on the 
driver.
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Selects the category of the list displayed in 
[Address Book] from the drop-down list 
([Person], [Group], or [All]).

 Book] Displays the list of the destinations 
registered in the Address Book. The entries 
can be sorted by their information 
([Recipient Name], [Company], [Dept./Div.], 
[Fax Number], and [Description]).

son] Opens the [Add Person] dialog box. (See 
“Add Person,” on p. 4-33.)

up] Opens the [Add Group] dialog box. (See 
“Add Group,” on p. 4-34.)

Edits the selected entry in the Address Book 
list. If you select a person, the [Edit Person] 
dialog box appears (See “Edit Person,” on 
p. 4-35). If you select a group, the [Edit 
Group] dialog box appears (See “Edit 
Group,” on p. 4-36.).

Deletes the selected entry from the Address 
Book.

Displays the information about the selected 
destination in the [Address Book].
1
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3

4

5

6

ntents
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Edit Address Book Tab

Lets you edit the address book.

[Show]

[Address

[Add Per

[Add Gro

[Edit]

[Delete]

[Details]
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erson

 Person] dialog box enables you to register a person 
er information in the Address Book.
1
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Add P

The [Add
and his/h

[Specify a Folder] Opens the [Browse for Folder] dialog box. 
Enables you to make changes to the 
Address book folder.

[Import] Enables you to import address book data 
from files. Importable file types are: some 
CSV files (with file extension “*.csv”) and 
some Canon Data Files (with file extension 
“*.abk”).

[Export] Exports the address book data to an outside 
file. You can select the exported file type 
from a CSV file (with file extension “*.csv”) or 
a Canon Data File (with file extension 
“*.abk”).

[About] Opens a dialog box containing the copyright 
and version information about this fax driver 
software.
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roup

 Group] dialog box enables you to register a group and 
ation in the Address Book.
1

2

3

4
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6
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You can register the following information: Add G

The [Add
its inform

[Prefix] Enters the prefix to the recipient’s name, or 
selects the prefix from the drop-down list 
([Dr.], [Mr.], [Mrs.], or [Ms.]).

[First] Enters the recipient’s first name.

[Last] Enters the recipient’s last name.

[Suffix] Enters the suffix to the recipient’s name, or 
selects the suffix from the drop-down list 
([Jr.], [MD], or [Sr.]).

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division 
name.

[Fax Number] Enters the recipient’s fax number. You can 
enter two numbers and descriptions.

[Notes] Enters the additional information about the 
recipient.

NOTE

When you press [OK] without entering the recipient name in 
the [Recipient Name], the [Prefix], [First], [Last], and [Suffix] 
are automatically applied to the [Recipient Name] and 
displayed on the cover sheet.
If names in the [Recipient Name] and the [Prefix], [First], 
[Last], and [Suffix] are different, the name in the [Recipient 
Name] is displayed on the cover sheet.



TOP

Back Previous Next

4-35

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

erson

 Person] dialog box enables you to edit a person and 
formation selected in the Address Book.
1
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3

4

5

6
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You can register the following information: Edit P

The [Edit
his/her in

[Group Name] Enters the group name.

[Show] Selects the category of the list displayed in 
[Available Recipients] from the drop-down 
list ([Person], [Group], or [All]).

[Available 
Recipients]

Displays the list of recipients already 
registered in the Address Books.

[Add] Adds a person/group to the group.

[Delete] Deletes a person/group from the group.

[Current Group 
Members]

Displays the members currently registered in 
the group.

[Notes] Enters the additional information about the 
group.
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roup

 Group] dialog box enables you to edit a group and its 
on in the Address Book.
1
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You can edit the following information: Edit G

The [Edit
informati

[Prefix] Enters the prefix to the recipient’s name, or 
selects the prefix from the drop-down list 
([Dr.], [Mr.], [Mrs.], or [Ms.]).

[First] Enters the recipient’s first name.

[Last] Enters the recipient’s last name.

[Suffix] Enters the suffix to the recipient’s name, or 
selects the suffix from the drop-down list 
([Jr.], [MD], or [Sr.]).

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division 
name.

[Fax Number] Enters the recipient’s fax number. You can 
enter two numbers and descriptions.

[Notes] Enters the additional information about the 
recipient.

NOTE

When you press [OK] without entering the recipient name in 
the [Recipient Name], the [Prefix], [First], [Last], and [Suffix] 
are automatically applied to the [Recipient Name] and 
displayed on the cover sheet.
If names in the [Recipient Name] and the [Prefix], [First], 
[Last], and [Suffix] are different, the name in the [Recipient 
Name] is displayed on the cover sheet.
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ter Cover Sheet Tab

/deletes the cover sheets to be attached to the 
t you fax.

reate your original cover sheets using the Canon Cover Sheet 
r details, see “Canon Cover Sheet Editor,” on p. 4-41.
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You can edit the following information: Regis

Registers
documen

NOTE

You can c
Editor. Fo

[Group Name] Enters the group name.

[Show] Selects the category of the list displayed in 
[Available Recipients] from the drop-down 
list ([Person], [Group], or [All]).

[Available 
Recipients]

Displays the list of recipients already 
registered in the Address Books.

[Add] Adds a person/group to the group.

[Delete] Deletes a person/group from the group.

[Current Group 
Members]

Displays the members currently registered in 
the group.

[Notes] Enters the additional information about the 
group.
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al Tab

 the page settings including the paper size and 
n.

also specify the outside dialing prefix if you dial through 
oard.
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Speci

Specifies
orientatio
You can 
a switchb

Preview image Displays the image with the currently 
selected settings reflected.

[Style] Selects the style of the cover sheet.
A bitmap image of the selected cover sheet 
style is displayed in the preview area to the 
left of [Style].

[Preview] Displays the preview image of the selected 
cover sheet.

[Register] Registers the cover sheet template.

NOTE

In addition to the default templates, you can add up to 30 
templates to the fax driver.

[Delete] Deletes the registered cover sheet template. 
Select a cover sheet template from [Style], 
then press [Delete].

NOTE

You cannot delete a pre-defined cover sheet template.
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ss Books

[Address Books] in the [Special] tab sheet opens the 
 Books] dialog box. This dialog box enables you to 
n Address Book to be referred to when sending a fax.

 Book Displays the list of the registered Address 
Books.

r] Opens the [Register Address Book] dialog 
box. (See “Register Address Book,” on 
p. 4-40.)

Opens the [Add/Edit Canon Fax Driver 
Address Book] dialog box. (See “Add/Edit 
Canon Fax Driver Address Book,” on 
p. 4-40.)

Deletes the selected Address Book from the 
[Address Book List].

NOTE

You cannot delete the [Canon Fax Driver Address Book] .
1
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3
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6
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Addre

Clicking 
[Address
specify a

Preview image Displays the image with the currently 
selected settings reflected.

[Page Size] Selects the original page size to work with in 
an application ([Letter], [Legal], [A4], or [A5]).

[Orientation] Selects the direction of printing relative to the 
paper ([Portrait] or [Landscape]).

[Specify Outside 
Dialing Prefix]

Enables you to enter the prefix number in 
[Outside Dialing Prefix] up to 5 digits.

[Address Books] Opens the [Address Books] dialog box. (See 
“Address Books,” on p. 4-39.)

[Restore Defaults] Resets all the current settings to their default 
values.

[Address
List]

[Registe

[Edit]

[Delete]
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dit Canon Fax Driver Address Book

g box enables you to edit the properties of the Address 
 be used when you send a fax.

Changes the name of the Address Book. You 
can enter up to 64 characters.
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Register Address Book

This dialog box enables you to register the Address Books to be 
used when you send a fax.

Add/E

This dialo
Books to

[Available Address 
Books]

Displays the list of the available Address 
Books.

[Name]
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 Canon Cover Sheet Editor, you can do the 
:

text using different fonts, font styles, and font sizes into 
r sheet.

a variety of objects, such as drawings and images, into 
r sheet.

e field feature for creating cover sheets for sending 
o multiple recipients.

lds for specifying remarks and comments in addition to 
der and recipient information fields.

edit the display order and position of objects, and group 
t objects.

bjects on a grid while you work with them.
1
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6
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Canon Cover Sheet Editor
This section describes instructions for installing Canon 
Cover Sheet Editor, launching the editor, and creating and 
registering original cover sheets.
The Canon Cover Sheet Editor is software for creating 
original fax cover sheet templates for use with a Canon fax 
driver.
After registering the cover sheets created with this 
software in your fax driver, you can use them with any fax. If 
you specify fields instead of manually entering data for 
sender or recipient information, the actual sender or 
recipient information that you select in the fax driver is 
automatically entered in the cover sheet when the fax is 
sent.

With the
following

– Insert 
a cove

– Insert 
a cove

– Use th
faxes t

– Add fie
the sen

– Easily 
differen

– Align o
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ck [Next >] → follow the instructions on 
 screen to continue the installation.

 [License Agreement] dialog box is displayed.

ad the CANON SOFTWARE LICENSE 
REEMENT carefully. If you agree to the 
ms, select [I accept the terms in the 
nse agreement] → click [Next >] → follow 
 instructions on the screen to continue 
 installation.
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■ Installing and Uninstalling Cover Sheet 
Editor

NOTE

The screen shots shown are from Windows XP. 

Installation

1. Insert User Software CD into your CD-ROM 
drive.
The MF3200 Seiries CD-ROM Setup screen is displayed.
If the MF3200 Series CD-ROM Setup screen is not displayed, on 
the Windows desktop, click [Start]  -> [My Computer] (Windows 
98/Me/2000: double-click [My Computer]). Open the CD-ROM 
icon, then double-click [MInst] ([MInst.exe]).

2. Click [Additional Software Programs] → click  
[Install].

3. Cli
the

The

4. Re
AG
ter
lice
the
the
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ck [Install] to start copying the files.

ck [Finish].
1

2

3

4

5

6

ntents

n

a 

oting

5. In the dialog box for selecting a setup type, 
select [Complete] or [Custom] → click 
[Next >].

NOTE

If you select [Custom] in the dialog box for selecting [Setup Type], 
you can specify the directory into which Canon Cover Sheet 
Editor is to be installed.

6. Cli

7. Cli
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talling

mes necessary to uninstall the Canon Cover Sheet 
llow the procedure below.

en the [Add or Remove Programs] dialog 
x.
k [start] on the Windows task bar → select [Control Panel] → 
k [Add or Remove Programs] (Windows 98/Me/2000: [Start] 
Settings] → [Control Panel] → double-click [Add/Remove 
grams]).

lect [Canon Cover Sheet Editor] → click 
ange] or [Remove].

en the [InstallShield Wizard] dialog box 
pears, follow the instructions on the 
een.
 Canon Cover Sheet Editor is uninstalled.
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Launching

To start the Cover Sheet Editor, follow the procedure below.

1. Click [start] on the Windows task bar → [(All) 
Programs] → [Canon] → [CSE] → [Cover 
Sheet Editor].
The Canon Cover Sheet Editor will open.

Unins

If it beco
Editor, fo

1. Op
bo
Clic
Clic
→ [
Pro

2. Se
[Ch

3. Wh
ap
scr
The
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ng a Saved Cover Sheet

open a saved cover sheet by specifying its file name.
a saved cover sheet, follow the procedure below.

ck [ ] (Open) on the toolbar.
rnatively, select [Open] from the [File] menu.
 [Open] dialog box appears.

ecify the file name of the cover sheet that 
u want to open.

NOTE

king [Preview] displays an image of the selected cover sheet.

ck [Open].
 selected cover sheet appears.
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■ Opening, Saving, and Closing a File

Opening a File

● Creating a New File

To create a new cover sheet, follow the procedure below.

1. Click [ ] (New) on the toolbar.
Alternatively, select [New] from the [File] menu.
The [New] dialog box appears.

2. Select a paper size for the new cover sheet → 
click [OK].

The New Cover Sheet screen appears.

● Openi

You can 
To open 

1. Cli
Alte
The

2. Sp
yo

Clic

3. Cli
The
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 an Existing File

e procedure below to save an existing cover sheet after 

ck [ ] (Save) on the toolbar.
rnatively, select [Save] from the [File] menu.

NOTE

 preserve the opened file as it was before editing, select 
ave as] from the [File] menu and specify a different name or 
cation for saving the edited file. Selecting [Save] will overwrite 
e existing file.
electing the [Save as] command is necessary only to specify 
 different file name or a different location to save the cover 
eet.
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Saving and Closing a File

● Saving a New File

If you save a cover sheet, you can register it later in the fax 
driver for use as an original cover sheet.

1. Click [ ] (Save) on the toolbar.
Alternatively, select [Save] or [Save as] from the [File] menu.
The [Save as] dialog box appears.

2. Enter a name for the file in [File name] → 
specify the location where you want to save 
the file → click [Save].
The file extension is automatically set to “cse.”

● Saving

Follow th
editing it.

1. Cli
Alte

– To
[S
lo
th

– S
a
sh
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ating an Original Cover Sheet
ion explains how to insert text, adjust text properties, 
elds, create objects, adjust objects, and specify grid 
 order to create an original cover sheet.

ing Text

insert text and numbers into the cover page. The 
s of any text or the text box itself can also be changed. 
e text, change to the edit mode by clicking anywhere 
a text box, and then place the cursor on the text that 
 to edit.

ck [ ] (Text Box) on the toolbar.
rnatively, select [Text Box] from the [Insert] menu.

g the pointer on the area of the cover 
eet to insert text.
uare or rectangular text box appears.

ck inside the text box.
 cursor for editing text appears.

ter the desired text.
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● Closing a File

Follow the procedure below to close a currently open cover 
sheet without exiting the Canon Cover Sheet Editor.

1. Click the lower [ ] (Close) at the top-right 
corner of the Canon Cover Sheet Editor main 
window.

Alternatively, select [Close] from the [File] menu.

NOTE

If you close a cover sheet that has not been saved after editing, a 
message appears asking whether you want to save the changes. 
Click [Yes] to save the changes, or [No] if you do not want to save 
changes. Click [Cancel] if you do not want to close the cover 
sheet.

■ Cre
This sect
specify fi
options in

Insert

You can 
propertie
To edit th
inside of 
you want

1. Cli
Alte

2. Dra
sh
A sq

3. Cli
The

4. En
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olor

ck inside the text box.
 text box is now ready for editing.

lect the desired font color from the Font 
lor drop-down list on the toolbar.
ormatting

ck inside the text box.
 text box is now ready for editing.

ck [ ] (Bold) on the toolbar.
ndo the bold formatting, click [ ] (Bold) again.

ormatting

ck inside the text box.
 text box is now ready for editing.

ck [ ] (Italic) on the toolbar.
ndo the italic formatting, click [ ] (Italic) again.
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Adjusting Text Properties

You can change text properties whenever you want. When you 
change text properties, all text inside the selected text box is 
affected.

Text properties for field settings inside a text box are also 
changed according to the text properties you specified. For 
details on field features, see “Specifying Fields,” on p. 4-52.

● Font

1. Click inside the text box.
The text box is now ready for editing.

2. Select the desired font from the Font drop-
down list on the toolbar.

● Font Size

1. Click inside the text box.
The text box is now ready for editing.

2. Select the desired font size from the Font 
Size drop-down list on the toolbar.
You can also specify the font size by directly entering it into Font
Size and pressing [ENTER] on the keyboard.

● Font C

1. Cli
The

2. Se
Co

● Bold F

1. Cli
The

2. Cli
To u

● Italic F

1. Cli
The

2. Cli
To u
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ying Text Properties

specify all of the properties for text inside a text box 
ously.

] inside the [Text Properties] dialog box displays a 
f how the text would appear with the currently selected 
Use it as a guide if you are specifying settings.

ck inside the text box.
 text box is now ready for editing.

ck [ ] (Properties) on the toolbar.
rnatively, select [Properties] from the [Edit] menu.
rnatively, right click inside the text box → click [Properties].
 [Text Properties] dialog box appears.
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● Underlining

1. Click inside the text box.
The text box is now ready for editing.

2. Click [ ] (Underline) on the toolbar.
To undo the underlining, click [ ] (Underline) again.

● Aligning Text

1. Click inside the text box.
The text box is now ready for editing.

2. Click [ ] (Align Left), [ ] (Align Center), or 
[ ] (Align Right) on the toolbar.

● Specif

You can 
simultane
[Preview
preview o
settings. 

1. Cli
The

2. Cli
Alte
Alte
The
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lect [Strikethrough] or [Underline] to draw 
ne through or to underline text.

lect the desired text color from [Color].

ecify [Alignment] for the text.

ck [OK].
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3. Select [Font], [Font Style], and [Size] from the 
respective list boxes.

Alternatively, enter the desired font size directly into [Size].

4. Se
a li

5. Se

6. Sp

7. Cli
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ecify the [Width] setting to set the 
ckness of the border (0.1 to 50.0).

NOTE

he [Width] setting is available only if [Line Style] is set to 
olid].
u can change measure for the width in the [Unit Setting] 

ialog box displayed by selecting [Unit] from the [View] menu.

lect the desired color of the border from 
lor].

lect the desired background color for the 
t box from [Fill in].

ck [OK].
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● Specifying Text Box Properties

Follow the procedure below to specify the type of border, border 
color, and background color of the selected text box.

1. Click anywhere on the border of the text box.
The border of the text box is selected.

2. Click [ ] (Properties) on the toolbar.
You can also select [Properties] from the [Edit] menu.
You can also display the [Text Box Properties] dialog box by 
double-clicking anywhere on the border of the text box.
The [Text Box Properties] dialog box appears.

3. Select the desired border type from [Line 
Style].

4. Sp
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nt information field that contains multiple values is 
repeating field.” This feature is convenient for using the 
ver sheet to send faxes to multiple recipients.
ating field is used to insert data for every recipient 
 in the fax driver.

n to the [Sender Information] and [Recipient 
on] fields, you can also insert [Sheets to Send], 
], and [Comment] fields on the cover sheet. When the 
t, the number of sheets to send as a fax specified in 

river is inserted in the [Sheets to Send] field, 
on specified in the fax driver such as [Urgent] or 
tial] is inserted in the [Remark] field, and comments 

 in the fax driver are entered in the [Comment] field.

FAX

ompany] XXX Company

Dept. A

Dr. Curtis

Dept. B

Mr. Alter

Dept. C

Mr. Green

Dept. D

Ms. Harrison

Substituted
for each
recipient when
the fax is sent.eat]

ept./Div.]

ame]

t]
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Specifying Fields

You can show sender or fax recipient information, such as the 
name, fax number, company name, and department/division 
name on the cover sheet using a feature called a “field.”
Fields are objects in the cover sheet that you can replace with 
data when sending a fax. Actual sender and recipient 
information as specified in the fax driver is automatically 
inserted in the corresponding fields on the cover sheet during 
transmission.

Available fields:

– Sender information: Name, Fax Number, Company, Dept./Div.

– Recipient information: Name, Fax Number, Company, Dept./
Div.

– Sheets to send

– Other information: Remark, Comment

A recipie
called a “
same co
The repe
specified

In additio
Informati
[Remark
fax is sen
the fax d
informati
[Confiden
specified

FAX

From
[Sender Name]

To
[Recipient Name]

Substituted
when the fax
is sent.

[Remark]

FAX

From
George Smith

To
Mr. David Walters

[Confidential]

FAX

[Recipient C

[Begin Rep

[Recipient D

[Recipient N

[End Repea
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ng Sender and Recipient Information Fields When 
iting Text

ck the [Insert] menu → [Sender 
ormation] or [Recipient Information] → 
ect the field (such as [Name], [Fax 
mber], [Company], and [Dept./Div.]) to 
ert.

g the pointer on the area of the cover 
eet to where you want to insert the field.
uare or rectangular text box containing the selected field 

ears.
u select [Insert All], all of the available fields for sender or 
pient information are inserted simultaneously. The fields are 
rted in this order: [Name], [Fax Number], [Company], and 

pt./Div.]. You can change the position of the fields as needed.
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● Inserting Sender and Recipient Information Fields When 
Editing Text

1. Inside the text box, place the cursor to where 
you want to insert the field.

2. Click the [Insert] menu → [Sender 
Information] or [Recipient Information] → 
select the field (such as [Name], [Fax 
Number], [Company], and [Dept./Div.]) to 
insert.
The selected field is inserted.

NOTE

If you select [Insert All], all of the available fields for sender or 
recipient information are inserted simultaneously. The fields are 
inserted in this order: [Name], [Fax Number], [Company], and 
[Dept./Div.]. You can change the position of the fields as needed.

● Inserti
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ck the [Insert] menu → [Recipient 
ormation] → [End Repeat].
 [End Repeat] field is inserted.
 field between the [Begin Repeat] and [End Repeat] fields is 
aced with multiple recipients' information when sending a fax.

NOTE

 text box may not be able to accommodate all of the actual 
 for a repeating field if a large number of recipients are 

cified for sending a fax. In this case, a new page is 
matically created and data that does not fit into the text box 
lays from the top of the new page.

ng Borders Between Repeating Fields

u specify a repeating field for recipient information, you 
select to insert borders between the values for easier 

ck the [Insert] menu → [Recipient 
ormation] → [Borders].
 [Border Settings] dialog box appears.
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● Inserting Repeating Fields

Follow the procedure below to show information for multiple 
recipients on the cover sheet when sending a fax.

1. Insert the desired recipient information field, 
such as [Name], [Fax Number], [Company], 
and [Dept./Div.].

2. Inside the text box, place the cursor to the 
left of the field to begin repeating.

3. Click the [Insert] menu → [Recipient 
Information] → [Begin Repeat].
The [Begin Repeat] field is inserted.

4. Inside the text box, place the cursor to the 
right of the field to end repeating.

5. Cli
Inf
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ng Sheets to Send Field When Editing Text

ide the text box, place the cursor where 
u want to insert the field.

m the [Insert] menu, select [Sheets to 
nd].
 [Sheets to Send] field is inserted.

ng Sheets to Send Field When Not Editing Text

m the [Insert] menu, select [Sheets to 
nd].

g the pointer on the area of the cover 
eet to insert the field.
uare or rectangular text box containing the selected field 

ears.
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2. Select [Insert a Border Between Repeats] to 
insert borders between multiple values in a 
repeating recipient information field.

If you do not want to insert borders between the values, deselect 
this check box → click [OK]. 

3. Select the type of line to use as the border 
from [Line Style].

4. Specify the [Width] setting to set the 
thickness of the borders (0.1 to 10.0).

NOTE

– The [Width] setting is available only if [Line Style] is set to 
[Solid].

– You can change measure for the width in the [Unit Setting] 
dialog box displayed by selecting [Unit] from the [View] menu.

5. Select the desired color of the borders from 
[Color].

6. Click [OK].

● Inserti
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ng Objects

draw lines, rectangles, rounded rectangles, or ovals on 
 sheet. You can also change their properties once they 
n.

ck [ ] (Line) on the toolbar.
 can also select [Line] from the [Drawing] menu.

g the pointer on the area of the cover 
eet to draw the line.
raw horizontal or vertical lines, or to draw lines angled at 45 
rees and 45/2 degrees, hold down [SHIFT] on the keyboard 
le dragging.

gles

ck [ ] (Rectangle) on the toolbar.
 can also select [Rectangle] from the [Drawing] menu.

g the pointer on the area of the cover 
eet to draw the rectangle.
raw a square, hold down [SHIFT] on the keyboard while 
ging.
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● Inserting Remark and Comment Fields When Editing Text

1. Inside the text box, place the cursor to where 
you want to insert the field.

2. From the [Insert] menu, select either 
[Remark] or [Comment].
The [Remark] field or the [Comment] field is inserted depending 
on your selection.

● Inserting Remark and Comment Fields When Not Editing 
Text

1. From the [Insert] menu, select either 
[Remark] or [Comment].

2. Drag the pointer on the area of the cover 
sheet to insert the field.
A square or rectangular text box containing the selected field 
appears.

Creati
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● Lines
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ng Images

ck [ ] (Image) on the toolbar.
 can also select [Image] from the [Insert] menu.
 [Open] dialog box appears.

ecify the file name of the bitmap file that 
u want to insert.

NOTE

king [Preview] opens the [Preview] dialog box, where an 
ge of the highlighted bitmap file is displayed.

ck [Open].
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● Rounded Rectangles

1. Click [ ] (Rounded Rectangle) on the 
toolbar.
You can also select [Rounded Rectangle] from the [Drawing] 
menu.

2. Drag the pointer on the area of the cover 
sheet to draw the rounded rectangle.
To draw a rounded square, hold down [SHIFT] on the keyboard 
while dragging.
You can adjust the degree of the curve or the roundness of the 
corners of the rounded rectangle. To do so, click anywhere 
outside the newly created rounded rectangle → click the rounded 
rectangle again → click and drag the inner handle in its upper 
right corner to change the degree of the curve.

● Ovals

1. Click [ ] (Oval) on the toolbar.
You can also select [Oval] from the [Drawing] menu.

2. Drag the pointer on the area of the cover 
sheet to draw the oval.
To draw a circle, hold down [SHIFT] on the keyboard while 
dragging.

● Inserti
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g an Object within the Same Cover Sheet

lect the object to move.
 can select multiple objects and move them at the same time.

g the selected object to the desired 
ation.
rnatively, use any of the four arrow keys [ ], [ ], [ ], or 
] to move the object in the desired direction in 0.1 mm 

ements.

NOTE

old down [SHIFT] on the keyboard while dragging to move the 
bject horizontally or vertically only.
old down [CTRL] on the keyboard while dragging to copy the 
lected object and drag the copy to the desired location.

 [Snap to Grid] is specified, holding down [SHIFT] on the 
yboard while pressing an arrow key moves the object in the 

irection of the arrow in half-grid space increments. If [Snap to 
rid] is not specified, holding down [SHIFT] on the keyboard 
hile pressing an arrow key moves the object in the direction of 
e arrow in 2.0 mm increments.
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Editing Objects

You can copy, move, and delete objects such as lines, 
rectangles, rounded rectangles, ovals, images, and text boxes 
on the cover sheet.

● Selecting an Object

1. Click the object to select.
You can also drag the pointer completely over the object.
The object is selected.

NOTE

You can also select multiple objects by holding down [SHIFT] on 
the keyboard and clicking each object that you want to select, or 
by dragging the pointer completely over the objects. If you want to 
deselect any of the objects you selected, hold down [SHIFT] on 
the keyboard → click the objects that you want to deselect.

● Movin
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ng an Object

lect the object whose size you want to 
ange.

NOTE

 can select multiple objects and change all of their sizes at the 
e time.

g any handle on the selected object to 
ange its size.

NOTE

he shape of the pointer changes depending on which handle 
u place it over.

ragging the handles on the top and bottom sides of the object 
anges its height.

ragging the handles on the left and right sides of the object 
anges its width.

ragging the handles on the corners of the object changes 
oth its height and width.
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● Moving an Object to a Different Cover Sheet

1. Select the object to move.

NOTE

You can select multiple objects and move them at the same time.

2. Click [ ] (Cut) on the toolbar.
Alternatively, select [Cut] from the [Edit] menu.

3. Display the second cover sheet.

NOTE

If the second cover sheet is open, you can select it from the 
[Window] menu.

4. Click [ ] (Paste) on the toolbar.
Alternatively, select [Paste] from the [Edit] menu.
The selected object is moved to the active cover sheet.

● Resizi
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ng an Object by Using Button or Menu Commands

use button and menu commands to copy an object 
 line, rectangle, rounded rectangle, oval, image, or text 
e same cover sheet or to another cover sheet.

lect the object to copy.

NOTE

 can select multiple objects and copy them at the same time.

ck [ ] (Copy) on the toolbar.
 can also select [Copy] from the [Edit] menu.

ou want to copy the object to a different 
ver sheet, display the second cover sheet.

NOTE

e second cover sheet is open, you can select it from the 
dow] menu.
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● Copying an Object by Dragging

1. Select the object to copy.

NOTE

You can select multiple objects and copy them at the same time.

2. Hold down [CTRL] on the keyboard → drag 
the selected (copied) object to the desired 
location.

NOTE

Dragging the selected object without holding down [CTRL] on the 
keyboard moves the object to the new location instead of copying 
it.

● Copyi
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ating an Object

ng enables you to copy and paste an object in one 
.

lect the object to duplicate.

NOTE

 can select multiple objects and duplicate them at the same 
.

ck [ ] (Duplicate) on the toolbar.
rnatively, select [Duplicate] from the [Edit] menu.
 selected object is duplicated.

g an Object

lect the object to delete.

NOTE

 can select multiple objects and delete them at the same time.

ck [ ] (Delete) on the toolbar.
rnatively, select [Delete] from the [Edit] menu, or press 
LETE] on the keyboard.
 selected object is deleted.
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4. Click [ ] (Paste) on the toolbar.
Alternatively, select [Paste] from the [Edit] menu.
The selected object is copied.

NOTE

– You cannot copy an object to a different cover sheet by 
dragging.

– To copy text, drag the pointer over the text to select it → click 
[ ] (Copy) or select the [Copy] command to copy it → click 
inside the text box you want to copy into → click [ ] (Paste) 
or select the [Paste] command. If you want to copy text within 
the same text box, hold down [CTRL] on the keyboard while 
dragging the selected text.

● Duplic
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fying Object Properties

e procedure below to change the line style, line color, 
ground color of objects such as lines, rectangles, 
rectangles, ovals, and images.

lect the object whose properties you want 
change.

NOTE

 can select multiple objects and change their properties at the 
e time.

ck [ ] (Properties) on the toolbar.
rnatively, select [Properties] from the [Edit] menu, or display 
[Object Properties] dialog box by double-clicking the selected 
ct.
 [Object Properties] dialog box appears.

lect the desired line type for the object 
m [Line Style].
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● Grouping Objects

You can edit or handle multiple objects that are grouped 
together as a single object. You can move, copy, or change the 
size of grouped objects in a single operation. You can also 
simultaneously modify the properties of all objects in the group.

1. While holding down [SHIFT] on the keyboard, 
you can individually select multiple objects 
by clicking on them with the mouse, or you 
can select all of the objects by dragging the 
mouse over them.

2. Click [ ] (Group) on the toolbar.
Alternatively, select [Group] from the [Layout] menu.
You can ungroup objects by selecting the group of objects that 
you want to ungroup and clicking [ ] (Ungroup) on the toolbar 
or selecting [Ungroup] from the [Layout] menu.
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ging Objects

rearrange the order and appearance of objects such as 
tangles, rounded rectangles, ovals, images, and text 
 the cover sheet.

ing the Order of Display

 objects overlap, you can specify the order in which 
lap. Use the following four commands to change the 
isplay of overlapping objects.

to Front]: Moves the selected object to the front.

to Back]: Moves the selected object to the back.

Forward]: Moves the selected object one level higher.

Backward]: Moves the selected object one level lower.
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4. Specify the [Width] setting to set the 
thickness of the line.

NOTE

The [Width] setting is available only if [Line Style] is set to [Solid].

5. Select the desired line color for the object 
from [Color].

6. Select the desired background color for the 
object from [Fill in].

NOTE

[Fill in] cannot be specified if the selected object is either a line or 
an image.

7. Click [OK].
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ng Multiple Objects

align multiple selected objects according to their left 
ht edge, top edge, bottom edge, or center in one 
. The position of the last selected object becomes the 
eference of alignment.
ollowing commands to change the alignment of the 
objects.

Left]: Aligns the left edge of all objects along the left 
f the last selected object.

Center]: Aligns the left-right center axis of all objects 
he left-right center axis of the last selected object.

Right]: Aligns the right edge of all objects along the 
dge of the last selected object.

Top]: Aligns the top edge of all objects along the top 
f the last selected object.

Middle]: Aligns the top-bottom center axis of all objects 
he top-bottom center axis of the last selected object.

ottom]: Aligns the bottom edge of all objects along the 
 edge of the last selected object.
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1. Select the object whose display order you 
want to change.

NOTE

– You can select multiple objects and change the order of display 
for all of them at the same time.

– If the object you want to select lies behind other objects and 
thus is hidden from view, press [TAB] on the keyboard 
repeatedly until the object you want is selected. You can also 
select in reverse order by holding down [SHIFT] on the 
keyboard while pressing [TAB] on the keyboard.

2. Click [ ] (Bring to Front), [ ] (Send to 
Back), [ ] (Bring Forward), or [ ] (Send 
Backward) on the toolbar.

NOTE

Alternatively, select [Bring to Front], [Send to Back], [Bring 
Forward], or [Send Backward] from the [Layout] menu.

● Aligni
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fying Grid Options

function is useful for arranging created objects.

ng Grids

display the grid on the cover sheet to help you create 
ge objects.

 the toolbar, click [ ] (Show Grids) to 
ivate the grid.
rnatively, activate the command by clicking [Show Grids] from 
[View] menu.
e the grid by clicking the activated [ ] (Show Grids) to 
ctivate it or by clicking [Show Grids] from the [View] menu.
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1. While holding down [SHIFT] on the keyboard, 
you can individually select multiple objects 
by left clicking on them with the mouse, or 
you can select all of the objects by dragging 
the mouse over them.
Select the object to be used as the point of reference at the last.

NOTE

If you drag the pointer to select multiple objects, the last created 
object is used as the point of reference. If any of the selected 
objects are overlapped, the object positioned in the front is used 
as the point of reference.

2. Click [ ] (Align Left), [ ] (Align Center), 
[ ] (Align Right), [ ] (Align Top), [ ] 
(Align Middle), or [ ] (Align Bottom) on the 
toolbar.
Alternatively, click the [Layout] menu → point to [Distribute 
Horizontally] or [Distribute Vertically] → select the type of 
alignment you want.
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ying Grid Properties

e procedure below to specify the properties for the grid 
ver sheet, such as type, color, and spacing. You can 
ify whether to display the grid and whether to snap 
 the grid.

lect [Grid Properties] from the [View] 
nu.
 [Grid Properties] dialog box appears.

lect [Show Grids].

elect the check box if you do not want to display the grid.

NOTE

electing this check box disables the [Type] and [Color] 
ings.
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● Snapping Objects to Grid

If you activate the [Snap to Grid] setting for the cover sheet, 
objects are aligned along the grid when they are moved or 
resized on the cover sheet.

1. On the toolbar, click [ ] (Snap to Grid) to 
activate the grid.
Alternatively, activate the command by clicking [Snap to Grid] 
from the [View] menu.
Deactivate the [Snap to Grid] setting by clicking the activated 
[ ] (Snap to Grid) or by clicking [Snap to Grid] from the [View] 
menu.

NOTE

[Snap to Grid] is available only after this setting is specified. It 
does not affect objects that are modified before this setting is 
specified.

● Specif
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 align objects along the grid, select [Snap 
Grid].
eactivate [Snap to Grid], deselect the check box.

ck [OK].

NOTE

king [Restore Defaults] in the [Grid Properties] dialog box 
ores all [Grid Properties] settings for the cover sheet to their 
ult values.
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3. Select [Dotted] or [Dashed].

4. Click the button to the right of [Color].
The [Color Setting] dialog box appears.

5. Select a color to use as the grid's basic color 
from [Basic colors].
You can create your own color by clicking on a color that is the 
closest to the color you want → [Define Custom Colors >>] → 
adjusting the color → clicking [Add to Custom Colors].

6. Click [OK] in the [Color Setting] dialog box.

7. Specify the [Horizontal] and [Vertical] 
spacing for the grid.
You can enter the values in the [Horizontal] and [Vertical] edit 
boxes (in a range from 1.0 to 50.0).

NOTE

You can change the unit of measure for the spacing in the [Unit 
Setting] dialog box displayed by selecting [Unit] from the [View] 
menu.
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istering an Original Cover Sheet as 
mplate

register the cover sheet created with the Canon Cover 
itor with the fax driver for use as a template.

en the [Printers and Faxes] (Windows 98/
/2000: [Printers]) folder.
k [start] on the Windows task bar → select [Printers and 
es] (Windows 98/Me/2000: [Start] → [Settings] → 
nters]).

the [Printers] folder, right click the printer 
n for your fax → click [Printing 
ferences] (Windows 98/Me: [Properties]).
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■ Printing a Cover Sheet
Follow the procedure below to print the cover sheet.

1. Click [ ] (Print) on the toolbar.
Alternatively, select [Print] from the [File] menu.
The [Print] dialog box appears.

2. Select the printer.
If necessary, click [Properties] to specify detailed print settings.

3. Specify the number of copies to print.

NOTE

[All] is the only active selection for the [Print range] setting 
because the cover sheet consists of only one page.

4. Click [OK].

■ Reg
a Te

You can 
Sheet Ed

1. Op
Me
Clic
Fax
[Pri

2. In 
ico
Pre



TOP

Back Previous Next

4-69

Table of Co

Index

Introductio

Printing

Scanning 
Document

PC Faxing

Troublesho

Appendix

lect the cover sheet template file → click 
en].

 selected template is added to [Style] in the [Register Cover 
et] sheet.

NOTE

ddition to the default templates, you can add up to 30 
plates to the fax driver. 
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3. Click the [Register Cover Sheet] tab.

4. Click [Register].
The [Register Cover Sheet] dialog box appears.

5. Se
[Op
The
She

In a
tem
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Is your computer working properly?

Make sure your computer is turned on. If so, see 
your computer’s documentation for 
troubleshooting.

upplied.

Is the power cord plugged in?

Make sure the power cord is securely plugged into 
both the machine and the AC outlet.

Is the AC outlet supplying power?

Make sure the AC outlet is supplying power; try 
another outlet if necessary.

Does the AC voltage match the printer?

Make sure the voltage of the AC outlet matches the 
ratings on the machine.
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Printer Problems

Printer does not print.

Q Is there some paper in the machine?

A Make sure paper is loaded.

Q Does the copy job stop due to out of paper?

A Load paper. The print job will start automatically 
when the copy job is completed.

Q Is the toner cartridge installed correctly?

A Make sure the toner cartridge is installed correctly. 
(See “Install Toner Cartridge” in the Starter Guide.)

Q Does your BIOS port setting need to be 
modified?

A See your computer’s documentation concerning 
available ports.

Q

A

No power is s

Q

A

Q

A

Q

A
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ong.

Is there a communication problem between the 
printer and your computer?

Make sure your cable connections are secure.

Make sure your USB cable is less than 3m long.

Make sure you are not using a USB hub.

Make sure you have selected the correct printer 
driver in Windows.

Is a wrong printer driver selected in the 
[Printers and Faxes] (Windows 98/Me/2000: 
[Printers]) folder?

Make sure the corresponding printer driver is 
selected in the [Printers and Faxes] (Windows 98/
Me/2000: [Printers]) folder.
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Printer stops printing.

Q Is the interface cable loose?

A Check your computer and the USB cable.

Q Are you working on an application in the 
foreground?

A Printer performance improves if you give priority to 
your print job.

Printout is wr

Q

A

A

A

A

Q

A
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icates a device time-out.

Is the machine off, offline, or not connected to 
the computer?

Make sure the machine’s interface cable is 
securely connected to both the machine and the 
computer.

Make sure paper is properly loaded in the machine.

Restart the machine and the computer.

Try the print operation again.

Try a different cable.
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Printer locks up system.

Q Does your system setup have a problem?

A Make sure that you have a high-quality USB cable.

A The problem might be in your BIOS. Verify that 
your BIOS setup is correct. (See your computer’s 
documentation for details.)

A Verify that your physical memory is working 
correctly.

A If you have a Toshiba laptop, change the following 
line in your CONFIG.SYS. file:
c:\winutils\mxtime.exe
to:
REM c:\winutils\mxtime.exe

Computer ind

Q

A

A

A

A

A
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ll the MF3200 Series printer driver using the USB 

Is the USB driver installed properly?

Perform the following steps.
1. Make sure the machine is connected to your 

computer using a USB cable and the machine is 
turned on.

2. Click [Performance and Maintenance] in the 
[Control Panel] folder → [See basic information 
about your computer] in the [Performance and 
Maintenance] folder (Windows 98/Me/2000: 
double-click [System] in the [Control Panel] 
folder). The [System Properties] dialog box 
appears.

3. Select the [Hardware] tab → click [Device 
Manager] → double-click [Universal Serial Bus 
controllers] (Windows 98/Me: select the [Device 
Manager] tab → double-click [Universal Serial 
Bus controllers]).
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Driver Problems

Driver is not working properly.

Q Is the printer driver selected as the default 
printer driver?

A Specify the corresponding printer driver as the 
default printer driver for the MF3200 Series.

Cannot print some fonts in a document correctly.

Q Does the document contain Adobe Type 
Manager (ATM) fonts?

A ATM is not supported. Replace ATM fonts to other 
appropriate fonts.

Cannot print with a printer driver other than the MF3200 Series 
printer.

Q Is the printer driver connected to the same port 
as the MF3200 Series printer driver?

A Connect the printer driver to a port different from 
the MF3200 Series printer driver.

Cannot insta
port.

Q

A
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rbled characters are printed.

Is the driver installed properly?

Check if the corresponding printer driver icon is 
displayed in the [Printers and Faxes] (Windows 98/
Me/2000: [Printers]) folder. If not, install the driver. 
If the corresponding printer driver icon is displayed, 
right click the corresponding printer driver icon → 
check if [Set as Default Printer] (Windows 98/Me: 
[Set as Default]) is selected in the pop-up menu. 
For more information, see “Checking Installation,” 
on p. 1-4.
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4. Select the USB class driver under [Universal 
Serial Bus controllers]. Delete ONLY the USB 
class driver specified for your operating system. 
(If the USB class driver is displayed under [Other 
device], delete ONLY one of the following, 
depending on your operating system: [USB 
Printing Support], [Canon MF3200 Series], or 
[Unknown].)
Select [USB Printing Support] → select 
[Uninstall] from the [Action] menu (Windows 98/
Me: select [Canon MF3200 Series] → click 
[Remove]).

5. Close the [Control Panel] folder → unplug the 
USB cable.

6. Restart your computer.
7. For instructions on installing the printer driver, 

see “Installing Software,” in the Starter Guide.

Strings of ga

Q

A
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Is your computer working properly?

Restart your computer.

Is a USB hub or repeater working properly?

When using a USB hub or repeater, try connecting 
a USB cable directly to the computer to check if it 
works properly. If you can scan the document 
successfully after connecting a USB cable directly 
to the computer, check your USB hub or repeater if 
it is working properly.
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Scanning Problems

Cannot scan a document.

Q Is there anything displayed in the LCD?

A If nothing is displayed in the LCD, see Chapter 5, 
“Troubleshooting,” in the Advanced Guide.

Q Is the Error indicator blinking?

A If the Error indicator is blinking, see Chapter 5, 
“Troubleshooting,” in the Advanced Guide.

Q Is the document placed correctly?

A Remove the document and place it on the platen 
glass correctly. (See Chapter 2, “Document 
Handling,” in the Basic Guide.)

Q

A

Q

A
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If you connect the machine to a USB 2.0-equipped 
computer, you may not be able to scan. If your PC 
is equipped with two or more USB ports, try 
connecting the machine to another USB ports. If 
the problem persists, follow the procedure below to 
modify the INI file. It is recommended to make a 
backup copy of the file before making any changes 
to it.
1. Open the following file in Notepad or another text 

editor application.
Windows 98/Me:

windows\system\CNCMFP21.ini
Windows 2000:

winnt\system32\CNCMFP21.ini
Windows XP:

windows\system32\CNCMFP21.ini
2. In the [ScanSize] section, change 

“Read512Bytes=0” to “Read512Bytes=1,” then 
save the file. Take care not to modify any other 
parts.
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Q Are you using a USB 2.0-compatible USB hub?

A If you connect the machine to a USB 2.0-equipped 
computer using a USB 2.0-compatible USB hub, 
you may not be able to scan. In this case, connect 
a USB cable directly to the computer.

A
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reate a multipage PDF, but were not able to scan 
ments.

Is the [Automatically Quit ScanGear after 
Scanning] check box in [Preferences] selected?

If you scan with the [Automatically Quit ScanGear 
after Scanning] setting selected, only the 
documents placed at one time on the platen glass 
will be scanned.
Click a button on the MF Toolbox and, in the 
settings dialog box, select [Display the Scanner 
Driver] to open the ScanGear MF. In the 
[Preferences] dialog box of Advanced Mode, clear 
the [Automatically Quit ScanGear after Scanning] 
check box before scanning.
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Q After installing the software, did you install a 
TWAIN-compatible application?

A The TWAIN system file is replaced with something 
inappropriate and you will be unable to scan 
images. If this happens, remove the software (see 
“Uninstalling and Reinstalling the Software,” on 
p. 1-5), then reinstall it (see “Installing Software,” in 
the Starter Guide).

Q Is the machine recognized in [Scanners and 
Cameras] of the [Control Panel] folder?

A Make sure the corresponding scanner driver icon is 
displayed in [Scanners and Cameras] of the 
[Control Panel] folder.
1. Click [start] on the Windows task bar → select 

[Control Panel] → [Printers and Other Hardware] 
→ [Scanners and Cameras] (Windows 98/Me/
2000: Click [Start] on the Windows task bar → 
select [Settings] → [Control Panel] → double-
click [Scanners and Cameras]).

2. If the corresponding scanner driver icon is 
displayed in the [Scanners and Cameras], the 
machine is recognized. If not, remove the 
software (see “Uninstalling and Reinstalling the 
Software,” on p. 1-5), then reinstall it (see 
“Installing Software,” in the Starter Guide).

You tried to c
several docu

Q

A
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Is the driver installed properly?

Remove the software (see “Uninstalling and 
Reinstalling the Software,” on p. 1-5), then reinstall 
it (see “Installing Software,” in the Starter Guide).

 the applications in the CD-ROM supplied with the 
they are not registered in the MF Toolbox.

Have you installed the applications with the MF 
Toolbox open?

If you install the applications with the MF Toolbox 
open, the applications will not be registered in the 
MF Toolbox. Click a button on the MF Toolbox 
dialog box and click [Set] to register the application 
manually. (See “External Program (Mail Program),” 
on p. 3-12.)
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Computer has hung up or frozen.

Q Is enough memory loaded in your computer?

A Quit other opened applications and try again.

Q Is enough space available in the hard disk?

A Check that the hard disk has enough available 
space, in particular when scanning large 
documents at a high resolution. For example, a 
A4-size document scanned at 600 dpi, full color 
requires a minimum of 300 MB of disk space.

Q Does an error occur when scanning an image in 
Photoshop?

A Change the allocated memory. From the [Edit] 
menu, select [Preferences] → click [Memory & 
Image Cache]. Change the [Physical Memory 
Usage] or [Memory Usage] in a range of 
approximately 10% to 20%.

Q

A

You installed
machine but 

Q

A
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ges look dirty.

Is the platen glass or the platen glass cover 
clean?

Clean the platen glass or the platen glass cover.

Is the image size too small?

Some applications do not display an image 
properly at small sizes. Try displaying the image at 
100% magnification.

Does the monitor display color set at below 16 
bits?

In Windows Display Properties, set the display 
colors to 16-bit color, 24-bit color or higher.
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When you click a button on the MF Toolbox, another application 
opens.

Q Is the application selected correctly for that 
button?

A Click a button on the MF Toolbox dialog box and 
click [Set] to register the application you want to 
open for that button. (See “External Program (Mail 
Program),” on p. 3-12.)

Changed settings in a dialog box are not activated (Windows 
2000).

Q Did you restart your computer after changing 
the settings?

A If you open [Scanners and Cameras] in the [Control 
Panel] folder and change the settings in the 
[Events] tab, the settings will not be activated 
unless you restart your computer. Once you have 
changed your settings, restart your computer.

Scanned ima

Q

A

Q

A

Q

A
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ge is displayed at a larger (smaller) size on the 
een.

Is the resolution setting correct?

Do one of the following:

– Enlarge or reduce the image display in the 
application. If you open the image in Paint or 
Imaging, it may display at a large size and you 
will not be able to reduce it.

– Change the resolution and scan again.
The image will be large if the resolution is high. It 
will be small if the resolution is low. (See 
“Determining Resolution,” on p. 3-39.)
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White lines appear on one edge of the image you scan.

Q Is the document placed on the platen glass 
correctly?

A Place the document at approximately 3 mm from 
the front edge of the platen glass.

Cannot scan highlighted marks.

Q Is [Color Correction] set to [Color Matching] ?

A In [Advanced Mode] in ScanGear MF, set [Color 
Correction] to [Color Matching]. (See “[Color 
Settings] Tab,” on p. 3-37.)

Scanned ima
computer scr

Q

A
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lems

e software was completed, but [Canon] remains.

Did you remove the MF drivers before removing 
the MF Toolbox?

You have to remove the MF Toolbox first, then the 
MF driver.
Perform the following steps to remove the folder.
Right click the [start] menu to open the Windows 
Explorer → select [Start Menu] in [All Users] → 
[Programs] → delete the [Canon] folder
(Windows 2000: open [Settings] from the [Start] 
menu → click [Taskbar & Start Menu] → 
[Advanced] → [Advanced] → select [Start Menu] in 
[All Users] → [Programs] → delete the [Canon] 
folder) (Windows 98/Me: open [Settings] from the 
[Start] menu → click [Taskbar & Start Menu] → 
[Start Menu Programs] or [Advanced] → [Remove] 
→ select the [Canon] folder → click [Remove]).
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Installing and Uninstalling Prob

Cannot install the software.

Q Have you followed the instructions to install the 
software?

A Try reinstalling the software. If an error occurred 
and installation was not complete, restart your 
computer and try reinstalling the software.

Q Are any other applications open?

A Quit all of these and try reinstalling the software.

Removal of the drivers takes too long (Windows XP).

Q Is any application such as an anti-virus open 
when removing the software?

A Quit any applications (including anti-virus) before 
removing the software.

Removal of th

Q

A
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nager], green mark “?” is displayed (Windows Me).

Is green mark “?” displayed on [USB 
Composite Device] in [USB (Universal Serial 
Bus) Controller] in [Device Manager] in 
Windows Me?

As this is not a problem, you can continue to use it 
as is.
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The message <Version conflict> appears on your computer 
(Windows 98).

Q Is Photoshop installed on your computer?

A If the message <Version conflict> or <Windows 98 
file language or...> appears during installation, click 
[Yes] or [No]. Whichever you click, installation 
thereafter will continue trouble-free.

Cannot use the software after upgrading to Windows XP.

Q Have you upgraded Windows 98/Me/2000 to 
Windows XP without removing the software?

A Remove the software (see “Uninstalling and 
Reinstalling the Software,” on p. 1-5), then reinstall 
it (see “Installing Software,” in the Starter Guide).

In [Device Ma

Q

A
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nner Specifications

NOTE

cifications are subject to change without notice.

Color scanner

Scanning Size 215.9 mm x 297.0 mm

ning Resolution 600 dpi x 1200 dpi (optical)
9600 dpi x 9600 dpi (interpolated)

ning Speed 1.5 msec/line (600 dpi)

 Interface USB 1.1, USB 2.0

ce Driver TWAIN and WIA (Windows XP 
only) compliant
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Specifications

■ Printer Specifications
● Hardware

● Software

■ Sca

Spe

Host Interface USB 1.1, USB 2.0

Printing Software CARPS version 2.40

Paper Sizes A4, B5, A5, Letter, Legal, Executive, 
Envelope COM10, Envelope C5, Envelope 
DL, Envelope Monarch

Valid Printing 
Area

Max. 5 mm margin at each edge

For Envelope Monarch, Envelope 
COM10, Envelope DL, and Envelope 
C5:
Max. 5 mm margin at each edge

NOTE

Specifications are subject to change without notice.

Type

Max 

Scan

Scan

Host

Devi
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ss
 relative proportion of light and dark areas. Decreasing 
htness darkens the overall image; increasing brightness 
ens it.

mputer that is connected to the printer over a network. A 
t does not control the printer directly. It interacts with the 

ter through a server. See also Server.

rint multiple copies of a multi-page document in sequential 
e order.

tching
me cases, the range of colors captured by a scanner 
eds the range that can be displayed by a particular monitor. 

ddition, the colors displayed for an image on the monitor may 
lightly different from those output by a printer. Color Matching 
e process used to make the colors captured by a scanner 
istent with those shown on a display or printed on a printer.

d
nstruction that tells the machine to perform a certain function. 
mands are sent from the computer to the machine via the 
face cable when the machine is ready.
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Glossary

A

AC
Alternating Current. The type of electrical current typically 
available from household wall outlets.

Application
Abbreviation of the phrase “application software.” Software 
designed for a specific purpose such as word processing 
software, spreadsheet software, database software, or a 
combination of these.

B

Bit
An indication of the volume of data used to describe points in an 
image. A 1-bit image assigns image data black or white color 
values depending on whether the brightness value is above or 
below a particular threshold value. The result is a two-color 
image. An 8-bit grayscale image expresses an image in 256 
shades of gray ranging from white to black. A 24-bit color image 
assigns 8 bits to each RGB color channel, expressing each pixel 
in approximately 16.8 million colors.

Bold
A characteristic of a printed character with wider, and darker 
representation. Also referred to as emphasized or double-strike 
printing.

Brightne
The
brig
light

C

Client
A co
clien
prin

Collate
To p
pag

Color Ma
In so
exce
In a
be s
is th
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Comman
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Com
inter
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ges are reproduced as rows and columns of dots. When an 
 is scanned with a scanner, the resolution, or dot density, of 
scanned image is measured as the number of dots per inch 
).

 per inch. A unit of measurement for indicating a machine’s 
lution.

ogram that controls how the computer and an external device 
act. For example, the printer driver supplies Windows with 
mation such as descriptions of the fonts and features of the 
lled printer.

 Exchangeable Image File (Exif) format is a Japan Electronic 
stry Development Association (JEIDA) standard used by 
t digital cameras to store images. The Exif compressed files 
the baseline JPEG format, so they can be read by any 
lication supporting “JPEG.” Exif supports the storage of extra 
mation, such as the date & time the image was taken, 
sure information, etc., within the header of each JPEG file.
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Contrast
The degree of difference between the lightest and darkest areas 
of an image. Decreasing contrast lightens the dark areas and 
darkens the light areas; increasing it darkens the dark areas and 
lightens the light areas.

Control Panel
The set of Windows programs you can use to change system, 
hardware, software, and Windows settings.

Crop
The action of selecting only part of an image for use. Using the 
Crop button on the ScanGear MF toolbar, a portion of the preview 
image can be selected and only that portion is then re-previewed 
or included in the final scan.

D

Default setting
A setting that is automatically used if no other setting is specified.

Descreen
A function that reduces the occurrence of moiré in the scan of a 
printed item. Moiré is the patterns or stripes that are visible in a 
low-resolution scan of a picture or photo in a book or magazine 
due to the interference patterns between the dots that comprise 
the image.

Desktop
The entire Windows screen that represents your work area in 
Windows. Icons, windows, and the taskbar are displayed on the 
Windows desktop.

Dot
Ima
item
the 
(dpi

dpi
Dots
reso

Driver
A pr
inter
infor
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E

Exif
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Indu
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app
infor
expo
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s
 process of converting a grayscale image to black dots and 
e (unprinted) dots that simulate the gray shades in the 
inal image.

ring in information created in another application.

opy software to a designated location on a computer’s hard 
 so that it can be used at any time.

 connection between two devices through which they 
municate with each other. The machine features a USB 
face, which makes it compatible with IBM and similar 
onal computers.

nt style distinguished by slanted characters (the upright 
kes of the characters are at an angle to the vertical axis).
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F

Folder
A container in which documents, program files, and other folders 
are stored on your disks. Formerly referred to as a directory.

Font
A complete set of characters of the same size and style. For 
example, 12-point Courier bold.

Form
A custom paper size, with width and height defined by the user.

G

Gamma Correction
Method for changing the brightness of an image. With gamma 
correction, the brightness of parts of an image in the middle of the 
tonal on range is changed without changing the lightest or darkest 
areas of the image, which means you can change the brightness 
of an image while maintaining contrast.

Grayscale image
A bitmap image that stores data for each dot as a shade of gray, 
rather than as black or white.
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e PDF
eral scanned documents saved as one PDF. Each document 
become one page of the PDF.

puter
 Windows program that you can use to browse through your 
puter’s filing system, and to open drives, folders, and files. 
can also use [My Computer] to manage your files and your 
 system, by moving, copying, renaming, and deleting items.

oup of computers connected by cables or other means and 
g software that enables them to share equipment (such as 
ters) and exchange information.

tical Character Reader)
ice for reading characters optically. System for extracting 
mation in a text format from information in the form of a 
hic such as hand-written or printed characters which have 

n scanned with a scanner. You cannot edit text scanned with a 
ner because it is in a graphic format, but with OCR software 
can convert to a text file and then edit the text with word 
essing software.

ion
 printing of text either along the width (portrait) or height 
dscape) of the page.
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J

Jam
A situation created when paper becomes caught along the paper 
path. You must remove jammed paper before you can continue 
printing.

K

Kilobyte (KB)
A unit of measurement, representing the binary number 1024, 
used to describe machine or computer memory size in thousand 
byte units.

L

Landscape
A horizontal print orientation. Text and graphics are printed 
across the longer axis of the page.

M

Megabyte (MB)
A unit of measurement, representing one million bytes, used to 
describe machine or computer memory size.
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rt for picture element, a pixel is the smallest unit used to 
sure a display image.

 document scanning unit.

rtical print orientation. Text and graphics are printed across 
shorter axis of the page.

isional scanning and display of the document you are about 
an before you actually scan it. If the preview scan looks 
rent from what you want, you can change the settings, display 
preview again and confirm before scanning.

 Area
 area at the left of the ScanGear MF main window. When the 
iew button is clicked, the item(s) on the platen glass of the 
ner are scanned, and the results are displayed as the 
iew image in this area. At this stage, the scanned image is 
passed on to the host application program.

cument that a Windows application has processed and sent 
e Spooler to be added to the print queue or directly to the 
hine.
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Paper feed
The act of guiding a sheet of paper into the machine’s paper path.

Paper jam
A situation created when paper becomes caught along the paper 
path. You must remove jammed paper before you can continue 
printing.

Paper path
The route that paper travels through the machine.

Paper source
Source of paper feed. The machine has a paper cassette and a 
multi-purpose feeder.

Paper type
All kinds of paper (plain paper, heavy paper, transparencies, and 
envelopes) are grouped under several paper types.

PDF
Stands for Portable Document Format. A widely used format for 
transmitting and viewing documents on computers. PDF 
documents can be read or printed out with Adobe’s Acrobat 
Reader program.

Physical RAM
Random Access Memory (RAM) that is physically present in the 
computer in the form of memory chips, as opposed to virtual 
memory. See also Virtual Memory.
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 Access Memory (RAM)
 working memory of the computer in which programs and data 
temporarily stored while you use them. Resetting or shutting 
he computer clears all information from RAM. Printing very 
plicated documents might require closing other running 
rams or adding more RAM to the computer. See also 

sical RAM, Virtual memory.

l
emove installed software and install again.

on
 density of dots for any given output device, expressed in 
s of dots per inch (dpi). Low resolution causes font 
acters and graphics to have a jagged appearance, but prints 
r than higher resolutions. Higher resolution provides 
other curves and angles as well as a better match to 
itional typeface designs, but prints more slowly. Resolution 
es are represented by horizontal data and vertical data, for 

ple, 600 x 600 dpi.

 fonts
lable fonts allow characters to be printed in various sizes and 
tion angles. This is different from bitmap fonts, which are 
ted in fixed sizes and angles.
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Print queue
A list of files that are either waiting to be printed or are currently 
printing. Once a file has been printed, it is removed from the print 
queue.

Printer driver
A program that controls how the computer and printer interact. 
The printer driver supplies Windows with information such as 
descriptions of fonts and features of the installed printer.

Printers and Faxes folder (Printers folder)
The container in which your printer and fax information is stored.

Properties dialog box
The dialog box that contains information about a particular 
device, such as a printer.

Q

Queue
A list of files that are either waiting to be printed or are currently 
printing. Once a file has been printed, it is removed from the print 
queue.
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 horizontal bar that contains the title of a window or dialog 
 On many windows, the title bar contains the [Control] menu 
and Maximize and Minimize buttons.

ack, resin-coated powder contained in the toner cartridge. 
 machine applies the toner to the surface of the 
tosensitive drum inside the machine via an 
trophotographic mechanism. 

Technology Without Any Interested Name)
stry-standard protocol for transferring information from 
ces such as scanners and digital cameras to a computer.

stry-standard protocol for an application programming 
face (API) for input devices such as scanners. If both the 
ce and the application comply with the standard, they will be 
patible regardless of differences in manufacturer or model.

example, with TWAIN-compatible image-processing software, 
can start the scanner’s TWAIN driver from the software’s 
u, scan the document and return the scanned image to its 
inal image-processing software.
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Scaling
Enlarging or reducing the printed image.

Scanner driver
A program that controls how the computer and scanner interact. 
The scanner driver is provided with two drivers: The TWAIN and 
the WIA driver (for use with Windows XP).

Scanners and Cameras folder (Scanners and Cameras 
Properties dialog box)

The folder or dialog box that contains information about your 
imaging devices, such as scanners or cameras.

Separator page
Optional pages printed at the beginning of each document to help 
separate one print job from another.

Server
A network computer that is directly attached to the printer. The 
server controls the printer and handles print jobs sent from the 
clients. See also Client.

Shielded
A type of cable that contains a metallic sheath over the conductor 
material to protect the data passing through the cable from 
electromagnetic interference. You need to use a double-shielded 
interface cable with this machine.

Spooling
A process by which an application sends a document to the 
spooler, rather than directly to the printer, thus freeing the 
computer and application for other tasks. Spooled documents are 
printed in the order they are received.
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s Explorer
 Windows program you can use to browse through, open, and 
age the disk drives, folders, and files on your computer in a 
ork system. You can also use Windows Explorer to view and 

n shared folders on other computers on the network. You can 
Windows Explorer to manage your files by moving, copying, 
ming, and deleting files.
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U

Uninstall
To remove software installed on a computer and return the 
computer to its condition before the software was installed.

Universal Serial Bus (USB) interface
These are new serial interface standards. This bus automatically 
recognizes connections (Plug and Play) to allow plugging and 
unplugging connectors with the power still turned on to the PC or 
peripheral equipment.

V

Virtual Memory
Space on the hard disk that Windows uses for temporary data 
storage as if it were actually random access memory (RAM). 
Windows does this by means of a swap file. This provides 
Windows with more usable memory, but reduces speed of access 
to it when the swap file must be used. See also Physical RAM.

W

Weight
Refers to the thickness of a font: light, medium, or bold. Also 
refers to the thickness of paper.

WIA (Windows Image Acquisition)
Standard for downloading images from scanners or digital 
cameras. The machine includes a TWAIN-compliant driver and a 
WIA-compliant driver. The WIA driver can only be used with 
Windows XP. With either driver, you can scan documents with the 
machine in applications which support the TWAIN interface 
(Photoshop etc.).
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D
Descreen 3-28

Detailed Settings

Windows 2000/XP 2-43
Windows 98/Me 2-16

Details tab

Windows 98/Me 2-5, 4-16

Dialog boxes

printer properties 6-8

dpi 6-4

Driver

problems 5-5
uninstall 1-5

Driver Problems 5-5

E
Edit Address Book tab 4-7

Windows 2000/XP 4-32
Windows 98/Me 4-18

Edit Group dialog box

Windows 2000/XP 4-36
Windows 98/Me 4-22

Edit Person dialog box

Windows 2000/XP 4-21, 4-35

Edit Profile

Windows 2000/XP 2-49
Windows 98/Me 2-22
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A
Add Group dialog box

Windows 2000/XP 4-34
Windows 98/Me 4-20

Add Person dialog box

Windows 2000/XP 4-33
Windows 98/Me 4-19

Add Printer Wizard (Windows 2000/XP) 2-57

Add Printer Wizard (Windows 98/Me) 2-58

Add Profile

Windows 2000/XP 2-48
Windows 98/Me 2-21

Add/Delete the Output Size dialog box 3-20,
 3-27

Add/Edit Canon Fax Driver Address Book 
dialog box

Windows 2000/XP 4-40
Windows 98/Me 4-26

Add/Edit profile 2-29

Address Books dialog box

Windows 2000/XP 4-39
Windows 98/Me 4-25

Advanced Mode

add/delete the output size 3-27
settings 3-24
switching 3-18
toolbar 3-22
using 3-21

Advanced Properties dialog box 3-45

Advanced Settings

Windows 2000/XP 2-41
Windows 98/Me 2-15

Advanced tab

Windows 2000/XP 2-27, 4-29

Application 3-15

Attribution tab

Windows 2000/XP 2-30

Auto Tone 3-28

B
Brightness 3-30

C
Color Management tab

Windows 2000/XP 2-27, 4-30
Windows 98/Me 2-6

Color Matching 3-38

Color Settings 3-30

Color Settings tab 3-37

Configuration tab

Windows 2000/XP 4-31
Windows 98/Me 4-26

Contrast 3-30

Cover Sheet Editor 4-41

installing/uninstalling 4-42

Cover sheet tab 4-7

Crop 3-23, 3-24
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MF Toolbox

External Program 3-12
Save Scanned Image to 3-11
scanner settings 3-9
using 3-7

Multiple PDF 3-16

N
Network

setting shared printer 2-54
using shared printer 2-57
Windows 2000/XP server settings 2-52
Windows 98/Me server settings 2-54

Network Download 2-57

O
OmniPage SE 3-8

Orientation 6-6

Output Settings 3-26

P
Page Options

Windows 2000/XP 2-39
Windows 98/Me 2-13

Page Setup tab

Windows 2000/XP 2-30, 2-32
Windows 98/Me 2-7

Paper Size (custom settings)

Windows 2000/XP 2-37
Windows 98/Me 2-12

Parameters of a scan

specifying 3-23

PDF Setting dialog box 3-16

Portrait 6-7
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Edit Watermark

Windows 2000/XP 2-35
Windows 98/Me 2-10

Exif settings 3-13, 3-14

F
Fading Correction 3-29

Favorite Settings 3-25

Fax

changing 4-14
sending 4-3
settings 4-14

FAX Printing Preferences

Windows 2000/XP 4-31

Fax properties

Windows 2000/XP dialog boxes 4-16, 4-27

Fax Sending

Characters and Symbols for Fax Numbers 
4-4

Fax Sending Settings 4-4

Final Review 3-34

Finishing tab

Windows 2000/XP 2-40
Windows 98/Me 2-14

Font 6-5

Form 6-5

G
Gamma 3-38

General tab

Windows 2000/XP 2-25, 4-28
Windows 98/Me 2-5, 4-16

Grain Correction 3-29

Grayscale Adjustment tab

Windows 2000/XP 2-44
Windows 98/Me 2-18

Grayscale image 6-5

Grayscale Settings

Windows 2000/XP 2-44
Windows 98/Me 2-17

Gutter Settings

Windows 2000/XP 2-41
Windows 98/Me 2-15

H
Histogram 3-31

I
Image Settings 3-28

Import 6-5

Input Settings 3-25

installing and Uninstalling Problems 5-13

Interface 6-5

Item Settings dialog box 4-8

L
Landscape 6-6

Logo tab 4-10

M
Matching tab

Windows 2000/XP 2-45
Windows 98/Me 2-18

Megabyte 6-6
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S
Scan tab 3-36

ScanGear MF

Advanced Mode 3-21
Setting 3-18
Simple Mode 3-18

Scanner and Camera Wizard 3-41

Scanner Specifications 6-2

Scanner tab 3-38

Scanning

from an application 3-15, 3-44
setting 3-5
using MF Toolbox 3-7
with [Start] on the machine 3-3

Security tab

Windows 2000/XP 2-28

Select Recipient from Address book dialog box 
4-6

Sender tab 4-8

Sending a Fax 4-3

Sending Settings tab 4-5

Setting the scanning function for [Start]

in the [Scanners and Cameras] folder 3-5
in the [Settings] dialog box 3-5
on the MF Toolbox main window 3-4

Shared printer 2-54

Sharing tab

Windows 2000/XP 2-26, 4-28
Windows 98/Me 2-7, 4-17

Sheets to send tab 4-12

Signature tab 4-11
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Ports tab

Windows 2000/XP 2-26

Power

not supplied 5-2

Preferences dialog box 3-35

Presto! PageManager 3-8

Preview tab 3-35

Print queue 6-8

Printer

does not print 5-2
driver 6-8
locks up 5-4
problems 5-2
sharing settings 2-7
stops printing 5-3

Printer Problems 5-2

Printer Properties

Windows 2000/XP dialog boxes 2-24
Windows 98/Me dialog boxes 2-5

Printer Specifications 6-2

Printing

Canceling 2-2
Changing Print Settings 2-3
Printing a Document 2-2

Problems

driver 5-5
installing 5-13
printer 5-2

problems during installation 5-13

problems during removal 5-13

Profile Tab

Windows 2000/XP 2-28

Profiles

Windows 2000/XP 2-46
Windows 98/Me 2-20

Q
Quality tab

Windows 2000/XP 2-31, 2-41
Windows 98/Me 2-15

R
Random Access Memory 6-8

Recipient tab 4-9

Reduce Dust and Scratches 3-28

Register Address Book dialog box

Windows 2000/XP 4-40
Windows 98/Me 4-25

Register Cover Sheet tab

Windows 2000/XP 4-37
Windows 98/Me 4-23

Reinstall 1-6

Reinstalling 1-5

Removing (Uninstalling) 1-5

Resolution

determining 3-39
DPI 3-45
output 3-26
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Simple Mode

add/delete the output size 3-20
switching 3-18
toolbar 3-20
using 3-18

Special tab

Windows 2000/XP 4-38
Windows 98/Me 4-24

Spool Settings

Windows 98/Me 2-6, 4-17

System Requirements 1-3

T
Threshold 3-34

Tone Curve 3-33

Tone Curve/Threshold drop-down list 3-35

Troubleshooting 5-1

TWAIN driver 3-15

U
Uninstalling 1-5

Uninstalling/Reinstalling 1-5

Unsharp Mask 3-28

V
Version conflict 5-14

View Settings

Windows 2000/XP 2-51
Windows 98/Me 2-23

W
WIA driver 3-15, 3-41
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CANON INC.
30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan

CANON U.S.A., INC.
One Canon Plaza, Lake Success, NY 11042, U.S.A.

CANON CANADA INC.
6390 Dixie Road Mississauga, Ontario L5T 1P7, Canada

CANON EUROPA N.V.
Bovenkerkerweg 59-61 1185 XB Amstelveen, The Netherlands

CANON FRANCE S.A.S.
17, quai du Président Paul Doumer 92414 Courbevoie Cedex, France

CANON COMMUNICATION & IMAGE FRANCE S.A.S
12, rue de l’ Industrie 92414 Courbevoie Cedex, France

CANON (U.K.) LTD.
Woodhatch, Reigate, Surrey, RH2 8BF, United Kingdom

CANON DEUTSCHLAND GmbH
Europark Fichtenhain A10, 47807 Krefeld, Germany

CANON ITALIA S.p.A.
Via Milano, 8 20097 San Donato Milanese (MI) Italy

CANON ESPAÑA, S.A.
c/ Joaquín Costa 41, 28002 Madrid, Spain

CANON LATIN AMERICA, INC.
703 Waterford Way Suite 400, Miami, Florida 33126 U.S.A.

CANON AUSTRALIA PTY. LTD
1 Thomas Holt Drive, North Ryde, Sydney, N.S.W. 2113, Australia

CANON CHINA CO., LTD
15F, North Tower, Beijing Kerry Centre, 1 Guang Hua Road, Chao Yang District, 100020, Beijing, China

CANON SINGAPORE PTE. LTD.
1 HarbourFront Avenue #04-01 Keppel Bay Tower, Singapore 098632

FA7-8917   (000) © CANON INC. 2006
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